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Copyrights and Trademark Notices
Copyright 2015, Telestream, LLC. All rights reserved worldwide. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without the written permission of Telestream. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream.

Telestream. Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, 
Lightspeed, ScreenFlow, Vantage, Wirecast, GraphicsFactory, MetaFlip, and Split-and-
Stitch are registered trademarks and Pipeline, MacCaption, e-Captioning, and Switch 
are trademarks of Telestream, LLC. All other trademarks are the property of their 
respective owners.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 of Adobe Systems All 
rights reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights Reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008 
|Server 2012, Windows 7, Windows 8, Media Player, Media Encoder, .Net, Internet 
Explorer, SQL Server 2005|2008|2012|2014, and Windows Media Technologies are 
trademarks of Microsoft Corporation.
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WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
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5

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.
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Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.
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Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream via telephone at (530) 470-1300.

Part number: 156812.
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Preface
To obtain product information, technical support, or provide comments on this guide, 
contact us using our Web site, email, or phone number as listed in Table 1.

Table 1. Telestream Contact Information

Resource Contact Information

Vantage Technical 
Support

Web Site: http://www.telestream.net/telestream-
support/vantage/support.htm

Support Email. support@telestream.net

Terms and times of support services vary, per the terms of 
your current service contract with Telestream.

Vantage Information, 
Assistance, FAQs, 
Forums, & Upgrades

Web Site: http://www.telestream.net/telestream-
support/vantage/support.htm

Support Email. support@telestream.net

Enterprise Product Support: (877) 257-6245

Telestream, LLC Web Site: www.telestream.net

Sales and Marketing Email: info@telestream.net

Telestream, LLC
848 Gold Flat Road, Suite 1
Nevada City, CA USA 95959

International 
Distributor Support

Web Site: www.telestream.net

See the Telestream Web site for your regional authorized 
Telestream distributor.

Telestream Technical 
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving 
this document, or other Telestream documents—or if 
you've discovered an error or omission, please email us.

http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
mailto:support@telestream.net
http://www.telestream.net
mailto:info@telestream.net
http://www.telestream.net
mailto:techwriter@telestream.net
mailto:support@telestream.net
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Introduction to
Vantage
This guide is intended for those who use Vantage for transcoding and processing 
digital media. This involves creating, configuring, and executing workflows in Vantage.

The following topics introduce Vantage, and the Vantage programs that you’ll utilize in 
the course of processing your media in Vantage workflows:

 Introduction to Vantage

 Accessing Vantage Guides and Online Help

 Vantage Domain Components

 Vantage Domain Configurations

 Vantage Programs

 Lightspeed Server

 Capturing Live and Tape Feeds

 Topics in this Guide
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Introduction to Vantage
At the simplest level, Vantage is a collection of customizable software programs that 
automate media processing via workflows. A Vantage workflow is a collection of 
actions, designed and configured by you to process media files in a specific manner.

The actions you can utilize in a workflow are controlled by the Vantage licenses you 
own. Table 2 lists some typical media processing objectives and the Vantage licenses 
that support them (these are not the only licenses you can use in Vantage—for a 
complete list, contact your Telestream representative).
Table 2. Vantage Media Processing Objectives

Workflow Objective 
(Vantage License) Description

File-to-file transcoding Transcoding workflows automate the process of 
converting a video file from one media format to another. 
Vantage can open most video files, regardless of the 
encoding and packaging format, and create one or more 
new video files using one or more selections from an 
extensive list of encoder and packaging formats.

Commercial processing—
local, regional, and 
national

TrafficManager streamlines commercial and content 
handling for TV stations and cable facilities. 
TrafficManager provides a complete solution for local/
regional, and nationally syndicated and commercial 
media workflows, from ingest, review & approval, 
transcoding, dub list reconciliation, delivery for ad 
insertion servers or broadcast servers, and automation 
system notification.

Adaptive streaming 
encoding

Transcode Multiscreen includes transcoding software 
specifically designed for adaptive bit rate encoding using 
both GPUs and CPUs. It simultaneously produces multiple 
bit-rate variants of H.264/HEVC (using x264/x265 codecs) 
video and containers for deployment to HTTP adaptive 
streaming players from Adobe, Apple, Microsoft, and 
players compatible with MPEG DASH.

Automated editing and 
composition of 
advertisements

Post Producer automates the repetitive editing of assets 
for distribution, promotion and cross promotion. Post 
producer allows you to automatically re-purpose movies 
and episodic content directly from master format for 
international and domestic distribution.
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With the appropriate licenses, Vantage workflows can incorporate the objectives listed 
in Table 2, as well as other workflow design and management features, which include 
the following:

• Workflow visualization—Vantage offers a highly flexible process design interface, 
with visual components that help you see what the workflow will accomplish.

• Notifications—Vantage can send emails or notify external systems when media is 
available.

• Intelligent branching—Vantage workflows can be configured to evaluate variables, 
metadata, and the results of other workflow tasks, and select the appropriate work-
flow branch for further processing.

• Workflow monitoring and control—Vantage programs allow you to view the status 
of jobs that have been submitted to a workflow, and you can stop, cancel, and 
restart jobs.

• Operator control—Vantage provides tools for enabling operator management. 
Operators can submit files to workflows, view the results, and submit the results to 
yet another workflow. Operators can also view the status of workflow jobs and, if 
granted permission by a Vantage administrator, stop, cancel or restart jobs.

IPTV VOD Transcoding Vantage Transcode IPTV VOD provides IPTV and Cable 
VOD transcoding with the highest possible quality at the 
lowest bit rates, reducing transmission costs. Additionally, 
Vantage provides sophisticated stream control and can 
automate the entire production process, including ingest, 
transcoding, packaging, delivery, and notification. 

Moving media between 
devices (Vantage 
Transcode Pro Connect)

Media transport workflows use Vantage native 
connections to move media between a wide variety of 
broadcast servers, edit systems, and other professional 
video devices. Using these integrations, Vantage can 
automate the process of receiving media into, or moving 
media between, different devices—ensuring the right file 
format at any of many possible destinations.

Media analysis and 
media-dependent 
processing (Vantage 
Analysis)

Media analysis workflows use Vantage features to analyze 
media, compare the results to configured values, and 
make decisions about how media should be routed or 
processed.

Third-party analysis and 
specialized media 
processing (third-party 
connectors)

Some workflows communicate with third-party products 
(including Avid, MediaMate Screen, and Digimetrics 
Aurora) to analyze media. Others can be implemented to 
perform specialized media processing with systems such 
as Dolby and Nielsen.

Table 2. Vantage Media Processing Objectives

Workflow Objective 
(Vantage License) Description
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• Scalability and Redundancy—Vantage scales to thousands of jobs and dozens of 
servers in an enterprise environment, to implement high-volume processing.

Vantage also provides many system management features, allowing you to scale a 
Vantage system to many servers, manage user access, and optimize system 
performance and reliability. The system management features are described in topics 
throughout this guide.

You manage licenses in the Vantage Management Console. You can also add or update 
licenses directly in Workflow Designer. For a full discussion of licensing in Vantage, see 
the Vantage Management Guide.
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Accessing Vantage Guides and Online Help
Vantage documentation consists of various guides, online help in the form of man 
pages, and application notes.

Installation and Domain Management Guide—You can access the domain management 
guide in the Vantage Management Console’s Help menu. 

User’s Guides—in each Windows client and Web application, you can also access a 
User’s Guide from the help menu.

In-program, Context-based Help—In each Windows client and Web application, click the 
? icon to display a context-sensitive topic in the relevant user’s guide, if available. In 
Workflow Designer, when an action inspector is open, click the M icon to display details 
about the panel you’re viewing for detailed help. Also hover over user interface controls 
to display brief tooltips.

Application Notes—Browse the Telestream Web site (at www.telestream.net/
telestream-support/vantage/support.htm) for application notes that may apply to your 
topic of interest.

Vantage Web Library—Click on the Vantage logo at www.telestream.net/telestream-
support/vantage/help.htm to display the entire Vantage documentation suite which 
includes all guides and man pages.

http://www.telestream.net/telestream-support/vantage/help.htm
http://www.telestream.net/telestream-support/vantage/support.htm
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Vantage Domain Components
Each Vantage domain is a collection of Vantage software components. You can install 
and use multiple Vantage domains within a business or other organization. For 
example, you might install a Vantage domain for the sports department and another 
for the news department. Domains do not interact with each other or know of others’ 
existence—each Vantage domain maintains its own database, and automates its own 
workflows, independently of other Vantage domains. 

Figure 1. Simplified View of the Basic Vantage Domain Components

The work that you want Vantage to perform is defined in a workflow, which is created 
using the Vantage Workflow Designer program. Each workflow is made up of individual 
tasks called actions, which specify what task needs to be performed. A typical workflow 
contains actions to perform these general types of tasks:

• Monitor and ingest media that is ready for processing at some storage location.

• Analyze and transcode input media into new media files.

• Process metadata.

• Assemble a media file from an edit decision list.

• Deliver finished media files to an output storage location.

Many other types of actions are provided in Vantage Workflow Designer. 
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Once a workflow has been designed, you can activate it, and it will run continuously to 
process media provided through hot folders, the Vantage SDK, or other submission 
mechanisms. For more information on all of the Vantage actions, see Vantage Actions. 
For more information on working with workflows, see Managing Workflows.

The Vantage domain database is the control center of a Vantage domain. All workflows, 
user information, job history, and most configuration settings for the domain is stored 
in the Vantage domain database, as are statistics and status information about the 
workflows processed by the domain and the services fulfilling them. Vantage domain 
administrators configure Vantage using the Management Console.

Working with the Vantage domain database, Vantage services execute workflow 
actions in a Vantage domain. Each service executes specific action types. For example, 
the Transcode Service executes the Flip action, which transcodes an input media file 
into a new file, based on the encoder and codecs you select. 

Vantage workflow actions which access input files or publish output files must have 
read and write access to the input and output storage locations, as shown in Figure 1. 
These locations can be folders that reside on a network server or workstation, a 
Network-Attached Storage (NAS), or a Storage Area Network (SAN). Or, they may be FTP 
or HTTP servers, or other media platforms.

A Vantage store is a storage location designated for temporary files that are created 
during workflow processing. Temporary files are automatically deleted by Vantage 
when they are no longer needed; you can control how long temporary files are retained 
by setting expiration rules for jobs and catalogs.
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Vantage Domain Configurations
While Vantage supports many different physical configurations, there are only two 
types of domains—a single node All-in-one domain—and a Vantage array, where the 
Vantage services and Vantage domain database are distributed among two or more 
servers.

An all-in-one domain is a Vantage domain in which all of the Vantage components 
shown in Figure 1are installed on a single server. An all-in-one domain is simpler to 
install and manage, but it has performance limitations which are described in Before 
You Install, in the Vantage Domain Management Guide.

A Vantage array (sometimes referred to as a distributed domain) is one in which the 
Vantage components are installed and distributed among multiple servers. For 
example, you might install the Vantage domain database on one server, and install all 
Vantage services on an additional server, and a second Transcode service on the third 
server. This three-server Vantage domain separates database processing from Vantage 
service processing, which increases processing capacity for both the Vantage domain 
database and the Vantage services.

Hosting Vantage services on multiple servers also increases capacity and supports 
load-balancing, which leads to better throughput, and redundancy—which enables 
fail-over protection for the Vantage domain.
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Vantage Programs
Vantage programs allow you to manage and use the Vantage domain in various ways. 
Table 3 lists the Vantage programs according to the function they serve and the type of 
program. 

Note: Some Vantage programs are available only with particular Vantage product 
licenses. To ensure you get the programs you want, contact Telestream sales for the 
latest bundling and licensing information.

From a management point of view, each Vantage program can be classified as a 
workflow management program or a domain management program. Workflow 
management programs allow you to design workflows, evaluate and forward the files 
produced or saved by a job, and track the status of jobs. Domain management 
programs allow you to configure the Vantage domain, view status and statistics for the 
domain, and control domain operation.

Each Vantage program can also be classified by application type, which is either as a 
client program or a Web application. Client programs run on Microsoft Windows 
servers and workstations. Web applications are hosted by a Microsoft Internet 
Information Services server and can be accessed from any computer with a compatible 
browser and a network or Internet connection to the IIS server hosting the Web 
applications.

Figure 2 (following) illustrates the entire suite of programs in a Vantage domain. 

Table 3. Vantage Programs

Functional Area

Program Type

Windows Client Applications Web Applications

Workflow 
Management

Vantage Workflow Designer

Vantage Workflow Portal

Vantage Job Status Views

Vantage Workflow Portal

Vantage Transcode

Transcoding Workflow 
Management

Vantage Workflow Designer Vantage Transcode

TrafficManager Dublist 
Management

Dublist Portal

Domain Management Vantage Management Console Vantage Dashboard

Cloud-base Domain 
Management

Vantage Cloud Manager
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Figure 2. Vantage Domain Showing All Vantage Programs

The following topics introduce each of the Vantage programs:

 Vantage Management Console

 Vantage Workflow Designer

 Vantage Cloud Manager

 Vantage Workflow Portal

 Vantage Workflow Portal Web Application

 Vantage Job Status Views Web Application

 Vantage Dashboard Web Application

 Vantage Transcode Web Application

 Vantage Dublist Portal

 Vantage Web Upload Portal
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Vantage Management Console
The Vantage Management Console enables domain administrators to configure and 
manage a Vantage domain, including specifying what features Vantage users can 
access. 

The following is a list of key features you can control with the Management Console:

• Vantage catalogs and stores

• Vantage users

• Vantage licenses

• Task scheduling rules

• Vantage services

• Import and export Vantage configuration components

• Client Windows and Web application configurations, including Job Status views 
and the Workflow Portal

• Report and work order configurations

• Dublist and fulfillment schemes

• Vantage domain settings, backup/restore, other utilities

The console also allows you to view a variety of status information, including 
information about jobs, service status, and catalog contents.

For information about using the Management Console, see the Vantage Domain 
Management Guide.

Vantage Workflow Designer
Vantage Workflow Designer enables you to design and automate workflows to meet 
your organization's transcoding and workflow automation requirements. With 
Workflow Designer, you can design workflows that do the following:

• Detect media files and related files that are ready for processing.

• Evaluate the contents of media files and set variables that describe their contents.

• Create decision trees that execute different branches based on variable values.

• Generate email and other messages in response to workflow events.

• Incorporate related metadata files or add metadata to the output.

• Generate new media based upon edit decision lists or editorial templates.

• Transcode media files to multi-screen formats, including package formats such as 
Apple HLS and Adobe HDS.

• Transcode media files for use in IPTV/VOD/cable applications.

• Perform comprehensive advertisement and syndicated content processing, from 
catch server to on-air server.
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• Perform file operations—save media output files and delete source files.

• Combine any or all of these features in hundreds of possible workflows.

A typical workflow design session requires that you pick the actions you want to 
execute, configure the sequence and settings of those actions, and then activate the 
workflow. When you activate the workflow, the Vantage domain database and Vantage 
services work together to process all source material that is submitted to the workflow. 
Each time source material is submitted, a Vantage job is started. A job represents a 
single execution of a workflow. For example, if 10 different media files are submitted to 
a workflow, 10 new jobs are started and executed.

Vantage Workflow Designer also includes tools that allow you to monitor the status of 
workflows and jobs in the domain.

For detailed information on designing Vantage workflows, see Managing Workflows.

Vantage Cloud Manager
The Vantage Cloud Manager enables domain administrators to configure and manage 
a cloud-based Vantage domain. The following is a list of key Vantage features that 
administrators can control with Vantage Cloud Manager:

• Cloud service provider accounts

• Domains configuration

• Domain status (starting and stopping)

• Vantage Services

• Domain status.

Vantage Cloud Manager is not included in the Vantage installer; it is a separately-
purchased application. For information about using the Vantage Cloud Manager, see 
the Vantage Cloud User’s Guide.
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Vantage Workflow Portal
The Vantage Workflow Portal allows operators to manually review and update media 
and manually submit jobs. Workflow designers create the workflows, and workflow 
operators use Workflow Portal to do the following:

• Search catalogs and binders to identify media to process

• Preview media and set in and out points for trimming

• Review and edit variable values used in workflows

• Submit media to workflows for processing

• In TrafficManager, search, review, and submit commercials for processing

• Stitch multiple files together.

Workflow Portal is designed to allow administrators to control which features and 
resources each operator can access. The desktop version of Workflow Portal must be 
installed on a Windows workstation and configured using the Vantage Management 
Console. To process media in Workflow Portal, you must also create a workflow to pre-
process the media and register it in a Vantage catalog. 

For information about creating configurations for the Workflow Portal, see Vantage 
Domain Management Guide > Configuring Workflow Portal Operation. For information 
about using the Workflow Portal, refer to Using Workflow Portal.

Vantage Workflow Portal Web Application
The optional Workflow Portal Web App is a Web version of the Workflow Portal 
Windows program. After you install the Vantage Web applications on a server, you can 
access Workflow Portal at http://[server name]/Vantage/Portal/. The Web version of the 
Workflow Portal works with certain configuration types, and allows most of the features 
listed above, except for the submission of media from Windows platforms, and 
stitching of files.

The login requirements are the same as for other clients. For information on using the 
Workflow Portal Web application, see Using Workflow Portal.
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Vantage Job Status Views Web Application
The Job Status Views Web Application provides Vantage operators and managers with 
detailed job status information about all jobs in the domain. Using the Vantage 
Management Console, Vantage administrators can configure custom job status views, 
which define what information an operator sees. When there is a large volume of jobs 
or when security policies dictate, you might want to create custom views for individual 
operators or departments.

After you install the Vantage Web applications on a server, you can access the Job 
Status Views at http://[server name]/Vantage/JobStatusViewer/. The login is the same 
as for other Vantage programs.

For information on using the Vantage Job Status Views, see the Vantage Domain 
Management Guide and Using the Job Status Views Web Application.

Vantage Dashboard Web Application
The Vantage Dashboard application helps domain administrators track the status and 
system health for the entire Vantage domain, as opposed to other tools which enable 
management of domain components.

The Vantage Dashboard application helps you quickly assess the health of the domain 
and progressively dig into deeper detail as needed. For example, the Summary Status 
page allows you to quickly see the workflow completion success rate and the error rate 
on all the servers in the domain. The information on the Summary Status page can help 
you determine if it is more appropriate to look for problems in a workflow or in a 
particular server.

Other Vantage Dashboard pages allow you to view the status of servers, services, and 
jobs. When troubleshooting, it can be very helpful to determine if problems are system 
wide or confined to a server, a service, or a particular workflow. Vantage Dashboard 
provides the Web pages that allow you to quickly assess your domain from any Web 
client that has connectivity to your domain.

For information on using Vantage Dashboard, see Monitoring the Domain with 
Vantage Dashboard in the Vantage Domain Management Guide.
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Vantage Transcode Web Application
The Vantage Transcode Web application is a browser-based Web application that 
allows users to quickly and easily build transcoding workflows in a browser, based on a 
fixed workflow template using these three simple steps: Watch > Transcode > Deliver.

The Vantage Transcode Web application allows users to build workflows that include 
one or more hot folders to watch for incoming media, one or more output formats, and 
can include delivery to one or more destinations. You can also review job status directly 
in the Web application, where jobs can be stopped, restarted and deleted.

Workflows designed in the Web application are automatically displayed in Workflow 
Designer as well. However, when a workflow is edited in Workflow Designer, it no longer 
displays in the Web application. Workflows originally implemented in the Vantage 
Transcode Web application can be extended to include more advanced features such 
as Analysis, email notifications, and more, in Workflow Designer.

After you install Vantage Web applications on a server, you can run the Vantage 
Transcode Web application using this URL: http://[server name]/Vantage/Transcode/ 

The same login requirements applies as for other Vantage programs.

Vantage Dublist Portal
Dublist Portal is a TrafficManager-licensed Windows program which allows users to 
manage dublist processing. It allows you to verify that dublists have been received and 
processed, expire dublists whose processing is complete, test new dublists against 
existing commercial inventory to see what ads are available for processing, and identify 
commercials that have not yet been processed. For more information on using the 
Dublist Portal, see the TrafficManager User’s Guide.

Vantage Web Upload Portal
The Vantage Web Upload Portal is a TrafficManager-licensed Web application that 
allows remote advertisers to upload commercials and associated files to your Vantage 
traffic workflows. Typically the Web Upload Portal is installed on your public Web 
server, and utilized by local/regional ad creators.

Your Vantage administrator sets up the portal for the client and specifies the workflow 
to which the files are uploaded. The application is easy to use, providing a simple, 3-
step process for uploading. For more information, see the Upload Portal Administrator’s 
Guide and the Upload Portal User’s Guide built into the application’s help system.
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Lightspeed Server
The Telestream® Lightspeed Server can be added to a Vantage domain (or used as an 
All-in-one domain) to accelerate video processing and x264 transcoding. Lightspeed 
Server accelerates Vantage video and x264 processing with GPUs and multi-core CPUs 
to provide the best image quality in the least amount of time. Housed in an efficient 1 
RU server, Lightspeed Server reduces rack space, power and cooling requirements 
while meeting increased output capacity needs. 

Lightspeed Server accelerates compute-intensive image processing in Vantage 
workflows, including scaling, deinterlacing, frame rate conversion, motion vector 
calculation, and other tasks that require computation and analysis to modify or create 
new video frames. Faster video preprocessing improves the quality of all video formats.

Your Lightspeed Server comes pre-configured to your order. You can order Lightspeed 
configured as an all-in-one server containing a complete Vantage system and licenses, 
ready to run. You can also order a Lightspeed Server or multiple servers with various 
Vantage components and licenses installed, ready to network together to create a 
Vantage distributed domain—an array.

For more information about utilizing Lightspeed Server in Vantage workflows, see 
Lightspeed Server on the Telestream Web site. For details about configuring Flip 
actions to run on a Lightspeed server, see Configuring an Action’s Fallback Rules.

http://www.telestream.net/vantage/lightspeed-server.htm
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Capturing Live and Tape Feeds
Using a Telestream Pipeline as part of your Vantage system, Vantage can ingest live or 
tape feeds into Vantage workflows. Combining Pipeline’s baseband capture with a 
Vantage system, you can create high-quality real-time or near real-time output in any 
format supported by Vantage. 

For example, you can simultaneously create high-res files for storage while creating a 
low-res proxy, or create any number of additional file formats in real-time or near real-
time. Transcoding occurs simultaneously while ingesting the captured media, ensuring 
the fastest possible turnaround time for media processing. Pipeline also preserves 
important metadata, such as ancillary data, throughout your transcoding workflow. 
Pipeline encoder channels allows for a high degree of scalability and flexibility.

For more information about utilizing Pipeline in Vantage workflow see Using Vantage 
Publish within Pipeline Control on the Telestream Web site. 

http://www.telestream.net/pdfs/app-notes/app_Pipeline_Vantage.pdf
http://www.telestream.net/pdfs/app-notes/app_Pipeline_Vantage.pdf
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Topics in this Guide
The major topics in this guide include:

• Vantage Client Programs Overview provides basic information about Vantage client 
programs and Web applications, including starting and stopping, and logging onto 
Vantage domains. You’ll also learn about Vantage stores, output folders, configur-
ing certain applications, and other skills you’ll need to use Vantage effectively.

• Vantage Workflow Designer Tours provides several tours, which are designed to help 
you understand how to create, configure, and manage workflows in Workflow 
Designer. You’ll also learn how to submit media to workflows for processing. As you 
take these tours, you’ll also become familiar with important Vantage concepts and 
how you can use them to design workflows to meet your processing requirements. 
As you gain hands-on experience creating workflows and processing media in Van-
tage—which leads to a working knowledge of Vantage and its components and 
architecture—you’ll gain proficiency in using Vantage to automate your organiza-
tion’s media processing workflows.

• Managing Workflows discusses how to design, construct, and configure workflows 
to perform specific media tasks in your organization. Workflow Designer is the pri-
mary client program in Vantage and combines a wide range of workflow design 
and media processing capabilities into a single program, enabling you to create 
workflows to solve a broad set of operational media processing problems.

• Vantage Actions describes each of the action groups and their actions.

• Monitoring Workflows and Managing Jobs discusses how to monitor and manage 
jobs in Vantage. For each new media file submitted to Vantage for processing, a job 
is created.

•  Using Workflow Analytics describes how to analyze workflows and job history to 
identify problems and improve overall system performance.

• Using Workflow Portal discusses how to use Workflow Portal for browsing video 
media assets, entering metadata, creating Edit Decision Lists (EDLs), and processing 
media via pre-defined workflows.

• Using the Job Status Views Web Application discusses how to use Job Status Views to 
access ob information and manage jobs in your Vantage domain from anywhere on 
the LAN, or via the Internet when you establish a VPN connection.

• Using Vantage Transcode discusses how to set up and use template-based transcod-
ing workflows. The Transcode and Transcode Pro license allows you to quickly and 
easily build hot-folder transcoding workflows. You can also review job status, and 
jobs can be stopped, restarted and deleted directly in Vantage Transcode.

• The Glossary defines terms used in Vantage product documentation.
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Vantage Client
Programs Overview
The following topics provide general information about using Vantage client programs, 
including starting and stopping, logging onto a Vantage domain, and best practices for 
accessing Windows files in Vantage.

Note: You manage Vantage licenses in the Management Console. For details on 
adding, updating, or activating licenses, see Enabling a Vantage License in the Vantage 
Domain Management Guide. Depending on how you purchase Vantage features, 
Telestream may send you additional license files or an updated license file. Follow the 
instructions accompanying the license file for adding or updating license files.

 Adding Trial Licenses

 Windows Client Program Management

 Web Application Management

 Understanding Paths for Vantage Storage
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Adding Trial Licenses
You should always manage licenses in the Management Console. For convenience, you 
can also import trial license files to your domain, directly from Workflow Designer.

Note: For full details on adding, updating, or activating licenses, see Enabling a 
Vantage License in the Vantage Domain Management Guide. 

When you receive a trial license (an XML file), install it using these steps:

1. Store the trial license file in a location that is accessible to your Vantage domain 
server.

2. Store a second copy of the file in a safe place.

3. In Workflow Designer, select File > Add/Update License to display the Add/Update 
License dialog.

4. Navigate to and select the trial license, and click Open.

5. Restart Workflow Designer and other client programs.
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Windows Client Program Management
Vantage provides the following client Windows programs:

• Management Console

• Workflow Designer

• Workflow Portal

• Dublist Portal

Note: Vantage Cloud Manager is not described in this topic. For details about using 
Vantage Cloud Manager, see the Vantage Cloud User’s Guide.

The following topics describe general Windows client program tasks:

 Starting and Stopping Vantage Client Programs

 Controlling Tips & Warnings

 Displaying a Windows Client Version

 Displaying your Domain’s Database Version

 Configuring Server 2008 to Solve Display Problems for Vantage Programs

 Logging into or Changing Vantage Domains in Windows Client Programs

 Changing Vantage Users in Windows Client Programs

 Changing Passwords in Windows Client Programs

 Selecting A Configuration in Workflow Portal

 Accessing Vantage Documentation from Workflow Designer
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Starting and Stopping Vantage Client Programs
All Vantage Windows programs connect directly to the Vantage domain database, and 
thus—can only be used on a Windows computer which has access to the domain.

You start and stop Vantage Windows programs like most other Windows programs. 
When starting most Vantage programs, you’ll select and log into a Vantage domain so 
you can begin work.

Some Vantage client programs require configuration by the administrator before they 
can function. For example, Workflow Portal and Dublist Portal require application 
configurations, which are created in the Management Console.

 Starting Workflow Designer

 Starting Workflow Portal

 Starting Dublist Portal

 Stopping Vantage Windows Client Programs

Starting Workflow Designer
To start Workflow Designer, use one of these methods:

• Select Start > Programs > Telestream > Vantage > Vantage Workflow Designer

• Double-click the Vantage Workflow Designer shortcut on your desktop.

Figure 3. Vantage Workflow Designer Shortcut

Note: If you are launching Workflow Designer for the first time, you’ll be prompted to 
select and log into a Vantage domain. See Logging into or Changing Vantage Domains 
in Windows Client Programs for details.

Starting Workflow Portal
Workflow Portal is an optional, licensed Vantage client program that allows operators 
to view binders to select media, enter metadata, and submit jobs. When you start 
Workflow Portal, if no license is available, it advises you, and operates in demo mode. 
When operating in demo mode, you cannot submit jobs or edit metadata labels.

You can run multiple instances of Workflow Portal on one computer (and one license), 
so that you can use multiple configurations at the same time. For example, you may be 
reviewing and submitting assets in one, and setting trim points in another. 

User authentication is used to control user access to Workflow Portal configurations. 
Administrators can choose which Vantage users can utilize a specific configuration. 
Administrators can also make certain configurations available to everyone.
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Figure 4. Vantage Workflow Portal Desktop Shortcut

To start Workflow Portal, do one of the following:

• Select start > Programs > Telestream > Vantage > Vantage Workflow Portal

• Double-click the Vantage Workflow Portal shortcut on your desktop.

Note: If you encounter an error when launching the Workflow Portal, please see 
Troubleshooting Workflow Portal for assistance.

If you are launching Workflow Portal for the first time, you’ll be prompted to select and 
log into a Vantage domain and choose a Workflow Portal configuration. See Logging 
into or Changing Vantage Domains in Windows Client Programs for details.

Starting Dublist Portal
Dublist Portal is provided as part of TrafficManager. You can run multiple instances of 
Dublist Portal on one computer, so that you can use multiple configurations at the 
same time.

User authentication is used to control user access to Dublist Portal configurations. 
Administrators can choose which Vantage users can utilize a specific configuration. 
Administrators can also make certain configurations available to everyone.

Figure 5. Vantage Dublist Portal Desktop Shortcut

To start Dublist Portal, do one of the following:

• Select start > Programs > Telestream > Vantage > Vantage Dublist Portal

• Double-click the Vantage Dublist Portal shortcut on your desktop.

If you are launching Dublist Portal for the first time, you’ll be prompted to select and 
log into a Vantage domain. See Logging into or Changing Vantage Domains in Windows 
Client Programs for details.
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Stopping Vantage Windows Client Programs
To stop Workflow Designer, Workflow Portal, or Dublist Portal, select File > Exit 
(Control+Q). 

You typically don’t need to explicitly save work you have performed, because all 
information is stored in the Vantage domain database, and updated automatically as 
you make changes. However, when you are editing data (for example, metadata in the 
Management Console or Workflow Portal), you do need to save it explicitly. If you 
attempt to close a dialog window or the program without saving the data, you’ll be 
warned.
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Controlling Tips & Warnings
Both Workflow Designer and Workflow Portal provide tips and warnings in tooltips and 
dialogs. To hide these tips and warnings, Check the hide checkbox on one of the 
dialogs, or select Options > Hide Tips & Warnings. To reset them to their default 
behavior, select Options > Restore Tips & Warnings.

Displaying a Windows Client Version
To determine an application’s version number, select Help > About.

Displaying your Domain’s Database Version
To determine your domain’s database version number, in Workflow Designer select 
Help > Database Version.

Configuring Server 2008 to Solve Display Problems for 
Vantage Programs

When using Workflow Designer on Windows Server 2008, you may have problems 
minimizing windows you’ve maximized by dragging them to the top of your monitor. 
To disable the Windows AeroSnap feature, open the Control Panel > Ease of Access 
Center > Change how your mouse works and check Prevent windows from being 
automatically arranged when moved to the edge of the monitor.

In addition, for Workflow Designer to display as designed, the Windows theme on 
Server 2008 R2 should be set to Windows 7 Basic. This theme is only available when the 
Desktop Experience feature is installed. If Remote Desktop Connection is used to 
connect to the server, then the Remote Desktop Services > Remote Desktop Session 
Host > Desktop Composition role feature must be installed in order for the Windows 7 
Basic theme to be available.

The Themes service must be started and set to the automatic startup type. If the 
Themes service hasn't been started before, the computer must be restarted for it to 
take effect and for the Windows 7 Basic theme to be made available.
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Logging into or Changing Vantage Domains in Windows 
Client Programs

These tasks are described in the following topics:

 Selecting the Domain

 Logging In

 Creating a Workflows Category in Workflow Designer

 Selecting a Configuration in Workflow Portal or Dublist Portal

Selecting the Domain
You may have multiple Vantage domains in your environment. (For example, domains 
for different departments, shows, projects, or geographic locations.) Each Vantage 
domain is a separate, stand-alone Vantage system, whose Vantage domain database 
and services do not interact with other domains. 

You might need to manually select a domain for the following reasons:

• You are starting Management Console, Workflow Designer or Workflow Portal or Dub-
list Portal for the first time on a given computer.

• Your work requires that you connect to a different Vantage domain.

After you select a Vantage domain, the program remembers it and connects 
automatically each time you restart the program. You can change domains at any time.

To select a domain, do the following:

1. In any Vantage Windows client program, select File > Change Vantage Domain (in 
Workflow Designer, you can also right-click in the Workflows panel away from any 
buttons).

The program displays the Select Vantage Domain panel.

Figure 6. Select Vantage Domain Dialog

2. Select a domain in the domain list, and click OK.

When you change domains, the program closes its connection and connects to the 
new domain.

Vantage 
domain list on 
your network
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If your domain isn’t listed or you can’t connect, contact your Vantage domain 
administrator and/or refer to the following topics:

 Connecting to an Unlisted Domain

 Connecting with Custom Login Settings

Connecting to an Unlisted Domain

To connect to a domain that is not in the list, click My Vantage Domain isn’t Listed.

Figure 7. Select Vantage Domain Panel

The dialog expands to display fields in which you can specify the domain (the 
computer where the database is running) using the host name or IP address.

You can also specify the name of the Vantage database instance, if different than the 
default VANTAGE instance.

Figure 8. Selecting an Unlisted Domain

Enter the Vantage server name (for example, VantageServer203) or IP address and 
Vantage instance name if different than the default, and click OK to connect. If you do 
not know what to enter, contact your Vantage domain administrator.

If domain connection is successful and you are prompted to enter a user name and 
password, see Logging In.

Connecting with Custom Login Settings

If the Vantage domain is using a SQL database where the default settings for the MS 
SQL server account were changed during installation, open Connection Settings to 
display the SQL Server login and password settings.
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Figure 9. Select Vantage Domain Panel

The program displays the SQL Server login and password settings.

Figure 10. Changing SQL Server Login Settings

Enter the Vantage database SQL server account user name and password (obtained 
from your Vantage administrator), and click OK to connect.

Logging In
To access a Vantage domain, you may need to provide user credentials. Your Vantage 
administrator will either provide you with a Vantage user name or configure Vantage to 
work with your Windows user name.

Note: Administrators can enable or disable user authentication. They can also choose 
whether or not to use Windows user names by enabling or disabling Windows Active 
Directory. Both settings are configured in the Vantage Management Console.

Note: If you don’t have a Vantage user name, ask your Vantage administrator to 
create one for you or add your Windows user as an authorized Vantage user.

Click Connection Settings.
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If Vantage log in is required, the Vantage Domain Login dialog displays.

Figure 11. Vantage Domain Login Dialogs

Enter your user name, and password if required, and click OK to connect.

In Workflow Designer, you may be prompted to create a new category—see Creating a 
Workflows Category in Workflow Designer below.

In Workflow Portal and Dublist Portal, you’ll be prompted to select a configuration 
before you can continue—see Selecting a Configuration in Workflow Portal or Dublist 
Portal.

Creating a Workflows Category in Workflow Designer
When you log in, the only categories that display are those that you are authorized to 
access. (If your user has administrative privileges, all workflows in the domain are 
displayed.) Access to workflow categories by user is controlled in the Management 
Console.

When you log into Workflow Designer, if there are no categories available then you will 
be prompted to create one. If you’re prompted to create a new category, click OK to 
display the Create New Category dialog.

Figure 12. Create New Category Dialog

Enter the name for this category, and click OK. 

Selecting a Configuration in Workflow Portal or Dublist 
Portal
If a configuration has been previously selected, it is used automatically. Otherwise the 
Select Configuration window displays, enabling you to select a configuration to use 
during this session. 

This dialog is for a domain 
not using Active Directory

This dialog indicates that 
the domain is using Active 
Directory.
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Note: The configurations in the list include public configurations (usable by any 
Vantage user), plus those that your Vantage user account is authorized to use. Access 
to configurations is controlled by the Vantage domain administrator.

Figure 13. Select Configuration Window

Select a configuration from the list and click OK.
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Changing Vantage Users in Windows Client Programs
When you are logged in to a Vantage domain that has User Administration enabled (in 
the Vantage Management Console), you can change to another Vantage/Active 
Directory user. 

Select File > Change Vantage User to display the Vantage Domain Login dialog.

Figure 14. Vantage Domain Login Dialog

Enter your user name, and password if required, and click OK to log in.
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Changing Passwords in Windows Client Programs
When you are logged in to a Vantage domain that has User Administration enabled (in 
the Vantage Management Console) and Windows Active Directory is not being used, 
you can change the password of the Vantage user currently logged in.

Select File > Change Password to display the Set Password window.

Figure 15. Set Password

Enter a new password, confirm the password, and click OK to update the password for 
this user. The next time you log in to the Vantage domain with this user, you’ll need to 
use the new password.
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Selecting A Configuration in Workflow Portal
To change configurations when you need to perform other tasks in the same domain, 
follow these steps:

1. Select File > Change Application Configuration.

Workflow Portal displays a list of configurations for this domain.

Figure 16. List of Workflow Portal Configurations

2. Select the configuration you want to use, and click OK.

Workflow Portal opens the configuration, and displays the appropriate user interface 
for this configuration.
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Accessing Vantage Documentation from Workflow Designer
The following topics describe how to access Vantage documentation while using 
Workflow Designer:

 Using the Help Menu to Display Vantage Documentation

 Displaying Context-Sensitive Help

 Displaying Man Pages

Using the Help Menu to Display Vantage Documentation
There are several ways to access the Vantage User’s Guide in Workflow Designer:

• Select Help > Getting Started to display the Tours topic in the Vantage User’s Guide. 
The tours introduce you to Workflow Designer and describe how to create and con-
figure workflows, submit jobs, and monitor jobs.

• Select Help > Contents to display the Vantage User’s Guide table of contents.

• Select Help > Index to display the Vantage User’s Guide index.

• Select Help > Search to display the Vantage User’s Guide search tab, where you can 
enter search criteria to locate topics you want to read.

• If you have access to the Internet, select Help > Online Help to display the Vantage 
Online Help section of the Telestream Web site, where you can access all Vantage 
documentation.

Displaying Context-Sensitive Help
In Workflow Designer, you can click the help button  (see Figure 17) to display the 
topic in the User’s Guide that relates to the specific program feature that has focus.

Figure 17. Clicking the ? Icon Displays Context-Sensitive Help Topics

If the topic is not available, you can search the entire User’s Guide for information.

Displaying Man Pages
In Workflow Designer, man pages are context-sensitive help topics that provide 
detailed information for action configuration options.

To open the man page for an action configuration dialog, click the  button.

Help 
button
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Figure 18. Watch Action Inspector Dialog, Showing Man Page Button

When the man page window is open as you proceed through a series of Inspector 
panels, the man page changes as you display each panel.

Man page 
button
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Web Application Management
Vantage provides the following Web applications:

• Web Dashboard

• Job Status Views Web Application

• Workflow Portal Web App

• Dublist Portal

• Vantage Transcode Web application

The following topics describe general Web application tasks:

 Web Application Browser Requirements

 Starting & Stopping Vantage Web Applications

 Logging into or Changing Domains from Web Applications

 Returning to the Vantage Web Applications Menu

 Logging Out of a Vantage Domain

 Changing Passwords in Web Applications

 Displaying Version Information

 Accessing Vantage Documentation in Web Applications
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Web Application Browser Requirements
Vantage Web applications are implemented for execution in Microsoft IIS. JavaScript 
and cookies must be enabled to use Vantage Web applications properly.

Telestream recommends the following Web browsers for use with Vantage Web 
applications:

• Internet Explorer 10 & 11—32-bit or 64-bit Windows only

• Chrome—current version on MacOS X & Windows

• Firefox—current version on MacOS X & Windows—Firefox is not recommended for 
proxy previewing in Web Workflow Portal on Windows Server systems, due to 
external coded dependencies.

• Safari—current version (MacOS X only).

To configure Internet Explorer for use with Vantage Web applications, do the following:

1. Enable Active Scripting—Open Internet Explorer, select Tools > Internet options, 
select the Security tab, click Custom level, scroll down to Scripting, click Enable 
under Active scripting, click OK, and click OK to close the Internet Options dialog.

2. If you are using Internet Explorer on a Windows Server that is not hosting the 
Vantage Web applications, disable Enhanced Security Configuration (ESC) using 
the Windows Server Manager.

3. If you are using Internet Explorer on a Windows Server that is hosting the Vantage 
Web applications, disable Enhanced Security Configuration (ESC) using the 
Windows Server Manager, or use localhost instead of the domain name or IP 
address (http://localhost/Vantage/Portal/ConfigSelect.aspx).

4. When using the Workflow Portal Web application on a Windows Server platform, 
you must install the Desktop Experience feature in order to view proxy media in the 
HTML5 Media Player.
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Starting & Stopping Vantage Web Applications
User authentication may be used to control user access to Workflow Portal 
configurations. Administrators can choose which Vantage users can utilize a specific 
configuration. Administrators can also make certain configurations available to 
everyone. (These functions are performed in the Vantage Management Console.)

For information on starting and stopping Web applications, see the following topics:

 Starting Web Applications

 Licensing Issues When Starting Workflow Portal

 Stopping Web Applications

Starting Web Applications
Logging on to a Vantage domain from a Web application is a bit different than logging 
on from a Windows client, such as Workflow Designer. When you log on from a Web 
application, you first start the Web application by accessing the Web server via a 
browser. Then, you actually log onto the Vantage domain after that.

To start Vantage Web applications from the Vantage home page, do the following:

1. Open your Web Browser and enter the Vantage Web application home page URL:

http://<IISServerName>/Vantage/

where <IISServerName> is the name of the IIS server (or its IP address)—by default, 
the same as the Vantage domain server.

If you are using Web applications directly on the server hosting IIS (for example, in 
an All-in-one domain), you can use localhost as the server name: http://localhost/
Vantage/.

Note: If you do not know the name of the Vantage IIS server (by default, the same 
server where the Vantage domain database is hosted), contact your Vantage 
administrator or IT department.

2. If you are prompted to select a domain, select the domain name, and click OK.

The first time you connect to a Vantage domain from this computer (or you deleted 
your browser’s cookies), select the domain from the list and click OK to continue. 
Refer to Logging into or Changing Domains from Web Applications for more informa-
tion.

3. Enter an authorized user name and password.

Vantage displays the Vantage Web Applications home page. 
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Figure 19. Vantage Web Applications Menu—Home Page

Click the Web application you want to run.

You can also launch each Vantage Web application directly, by using its URL:

• Web Dashboard—http://<ServerName>/Vantage/Dashboard/

• Job Status Viewer—http://<ServerName>/Vantage/JobStatusViewer/

• Workflow Portal—http://<ServerName>/Vantage/Portal/

• Vantage Transcode—http://<ServerName>/Vantage/Transcode/

Licensing Issues When Starting Workflow Portal
Workflow Portal is an optional, licensed Web application. When you start it, if no license 
is available, it advises you, and operates in demo mode. When operating in demo 
mode, you cannot submit jobs or edit metadata labels.

You can also run multiple instances of Workflow Portal on a single computer, so that 
you can use more than one configuration at a time—and each running instance 
requires its own Workflow Portal license. For example, you may be reviewing and 
submitting assets in one configuration, and setting trim points in another.

Stopping Web Applications
To stop a Web application, quit the Web browser or simply go to another Web site.
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Logging into or Changing Domains from Web Applications
Vantage provides many features that can be managed by your Vantage domain 
administrator. When you start Vantage Job Status Views or Workflow Portal, you may 
need to complete additional tasks before you can begin working. If additional tasks are 
required, Vantage will prompt you to complete those tasks, which are described in the 
following topics:

 Selecting the Domain

 Logging On

Selecting the Domain
Each Vantage domain is a separate, independent Vantage system. As a Vantage user, 
you might need to select a domain for the following reasons:

• You are starting a Vantage Web application for the first time on a given computer.

• Your work requires that you connect to a different Vantage domain.

After you log onto a Vantage domain, the Web app remembers it and connects 
automatically each time you restart the program. You can change domains at any time.

To select a domain, do the following:

1. In any Web app where you want to change Vantage domains, select Change 
Domain in the application title panel.

The Web application displays the Select Vantage Domain dialog.

Figure 20. Select Vantage Domain Dialog

2. To select a listed domain, select a domain in the domain list, and click OK.

When you change domains, your Web application closes its connection and con-
nects to the new domain.

Vantage 
domains on 
your network.
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If your domain is not listed, or your connection attempt is unsuccessful, contact your 
Vantage domain administrator and refer to the following topics:

 Connecting to an Unlisted Domain

 Connecting with Custom Login Settings

Connecting to an Unlisted Domain

If the domain you want to connect to is not in the list, click Advanced. To connect to an 
unlisted domain, do the following:

To connect to an unlisted domain, do the following:

1. In the Select Vantage Domain dialog (see Figure 20), click Advanced.

2. If the domain is not in the list, click My Vantage Domain is not Listed to display the 
Vantage domain server Name/IP field (see Figure 21 below).

Figure 21. Select Vantage Domain Dialog

3. Enter) the domain database server’s computer name (for example, 
VantageServer203) or its IP address and click OK to connect.

4. Specify the name of the Vantage database instance, if different than the default 
VANTAGE instance.
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Connecting with Custom Login Settings

If the Vantage domain is installed on a SQL database where the default settings for the 
MS SQL server account were changed during installation, open Connection Settings to 
display the SQL Server login and password settings.

Figure 22. Manually Entering the Vantage Domain Server Name

Select Use Custom Credentials, and enter the Vantage database SQL server account 
user name and password (obtained from your Vantage administrator), and click OK to 
connect.

Logging On
If you are accessing a Vantage domain for which user login is required, Vantage displays 
the Vantage Login dialog shown in Figure 23.

Figure 23. Vantage Login Dialog
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Note: If you do not have an authorized user name, contact your Vantage domain 
administrator.

To log in to the Vantage domain, do the following:

1. Enter your Vantage user name and password (if required) or use your Active 
Directory user name and password and click OK to connect. Your Vantage 
administrator will either give you a user name, or instruct you to use your Windows 
user name.

2. If you are prompted to select a domain, select the domain name, and click OK.

The first time you connect to a Vantage domain from this computer (or after you 
delete browser cookies), select a domain from the list, and click OK to continue. 
Refer to Logging into or Changing Domains from Web Applications for more informa-
tion.

3. Enter the user name and password assigned by your Vantage Administrator, then 
click Log In.

Note: The default user name is Administrator without a password.

4. Check Remember me next time to store the authentication token in a persistent 
cookie in the browser. This keeps you authenticated if you close your browser and 
reopen it again.

If you entered the Vantage URL, Vantage displays the Vantage Web application home 
page (see Figure 24), so you can select any Vantage Web application. Otherwise, your 
Web application displays.

Returning to the Vantage Web Applications Menu
To return to the main Web applications menu (see Figure 24) so that you can run 
another Vantage Web application, click on the home button in the title panel.

If the title panel is hidden, click the show/hide control.
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Figure 24. Vantage Web Applications Menu—Home Page
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Logging Out of a Vantage Domain
If you are viewing information that is sensitive, or viewing an operational application 
(vs. a view-only application), you might want to log out when you leave your computer 
on and unattended. You must log out when you want to change domains.

To log out of the Web application, click Logout in the title panel.

Changing Vantage Users in Web Applications
When you are logged in to a Vantage domain and User Administration is enabled (in 
the Vantage Management Console), you can change user names. To log in with a 
different user, do the following: 

1. Select Log Out (upper right corner) to display the Domain Login dialog (see 
Figure 25—Dashboard sample).

Figure 25. Vantage Domain Web Application Login Dialog

2. Enter your user name, and password if required, and click OK to log in.

Changing Passwords in Web Applications
If you are logged in using a Vantage user name (not a Windows user name), you can 
change your password. Do the following: 

1. Click Change Password (upper right corner) to display the Set Password dialog.

Figure 26. Web Application Set Password Dialog

2. Enter your new password, confirm the password, and click OK to change it.

The next time you log in to the Vantage domain, use your new password.
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Displaying Version Information
To display version information in a Web application, click About in the Help menu.

Figure 27. Job Status Views About Dialog

Version 
Information
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Accessing Vantage Documentation in Web Applications
The Help menu in the Web applications is at the bottom of the left, command column.

Figure 28. Web Applications Help Menu

These menu items provide access to the following information and documents:

• About—Displays the Web application’s version number.

• User Guide—Displays the Vantage User’s Guide (this guide) in PDF format. The PDF 
version contains bookmarks, and you can use the PDF search option to search for 
one or all occurrences of a term. This is also the best format for printing.l

• Web Help—Displays the Vantage User’s Guide (this guide) in HTML format. Web Help 
features include Contents, Index, Search, and Favorites pages. You can use Favorites 
to save links, so that you can quickly display an important topic.

To open the User’s Guide PDF or the Web library, do the following:

1. Locate the Help menu in the left pane of the Web application.

2. If no entries display under Help, click the control to the right to display the list.

3. To open the PDF version of this guide, click User Guide.

4. To open the Web library, click Web Help.

You can also view help directly on the home page (applications that display depend on 
the licenses you own—Dublist Manager, for example).

Figure 29. Vantage Web Applications Menu—Home Page

For each application, you can click on the User’s Guide, or click Web Help for the specific 
application you’re interested in.
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Understanding Paths for Vantage Storage
Vantage stores are named locations for temporary files. They are used frequently in 
Vantage to access media, attachments, and to write media and other output files. In 
Vantage, over a dozen different services require access to these files; Windows clients 
such as Workflow Portal also read and write these files. These Vantage programs (both 
services and Windows programs) may run on one computer. Usually, however, they are 
distributed on many computers—from a few, to dozens in a large Vantage array. In 
these distributed Vantage arrays, file access must be managed properly to ensure that 
the client programs can function correctly.

Vantage stores on Windows platforms can be specified using the following path forms:

• UNC form (shares): \\ComputerName\Sharename

• Drive-letter form: C:\folder\folder

If all of your Vantage services, clients, Vantage stores and folders are on the same server 
(an all-in-one domain), you can use either path form. However, Telestream 
recommends that you always use the UNC path form. It is a requirement when you are 
operating in a Vantage array.

Drive-letter paths are defined on the local computer, and the drive-letter form does not 
identify the computer that hosts the drive. This prevents them from being useful in 
situations where more than one computer is being used.

For example, if you specify a Vantage store on drive C using the drive-letter path form 
and a Workflow Portal operator on a different computer tries to view files in that store, 
Workflow Portal will search for those files on drive C on the operator’s computer, not on 
the Vantage server.

In another example, you create a workflow in Workflow Designer running on Computer 
A. It includes a Watch action, which will be executed by a Monitor Service, running on 
Computer B. You specify a hot folder on drive C (because you have created it on your 
computer). Now, when the service runs the Watch action, it attempts to locate the hot 
folder on the C drive of Computer B, which does not exist.

When any Vantage service or client program needs to access and use Vantage storage 
or a directory on a different computer, you must specify the path using the UNC form. 
You should also use the UNC form if you think you might ever support Vantage services 
or clients on another computer—a Vantage array.

Note: When services or clients will access Vantage storage from another computer, 
the Vantage storage location or directory must be published as a share, and access 
must be granted to the appropriate Windows users. For more information, see 
Windows Authentication Guidelines in the Vantage Domain Management Guide.

When you want to use a SAN system, be aware that some SAN systems expose the 
shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of 
the SAN. You can utilize SAN drives via a letter drive reference, provided that each 
Vantage server is a client of the SAN and that all mount points use the same letter.
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Note: If you are creating a store to hold proxy files viewed in Workflow Portal, be sure 
to reference the store with a UNC path. Some SAN clients do not allow frame-accurate 
representation of proxies when using shared drives.
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Vantage Workflow
Designer Tours
These tours are designed to help you learn how to create and configure workflows in 
Workflow Designer. You’ll also learn how to submit media for processing. As you gain 
hands-on experience creating workflows and processing media in Vantage, you’ll 
become familiar with important Vantage concepts, develop a working knowledge of 
Vantage and its components, gaining proficiency in using Vantage to meet your 
organization’s media processing requirements.

Note: In all-in-one Vantage domain, sample files are provided for use in the tours: 
<Install_Drive>:\VantageStore (typically, C:\VantageStore): FlipDemo.wmv (48 seconds), 
FlipDemo_short.wmv (15 seconds), and FlipDemo.mss (an MPEG2 Program Stream file).
If your domain was installed using the Array Node option or you want another copy, 
you can download the sample media from the Telestream Web site. To navigate there, 
go to the main page, select Downloads > Vantage > Download, and log in if required. 
Scroll to the bottom, click on the Workflow Examples tab and click the Download 
Vantage Sample Media link. Unzip the zip file and save the media for later use.

Tours
 Tour 1: Creating and Configuring Workflows
 Tour 2: Processing Media in a Workflow
 Tour 3: Using the Workflow Design Workspace
 Tour 4: Transcoding Files Using Settings You Want
 Tour 5: Using Nicknames to Identify Files
 Tour 6: Processing Attachments in Workflows
 Tour 7: Controlling Workflow Execution with Variables
 Tour 8: Decision Making in Workflows
 Tour 9: Analyzing and Modifying Media Files

Note: You can take tours 1-4 without a Vantage license. For tour 5 and beyond, you’ll 
need a trial license to run workflows. Also, without a license, you can only decode 
WMV files in workflows. For a trial license, contact sales@telestream.net.

http://dynamic.telestream.net/downloads/download-vantage-workflow-examples.asp?prodid=vantage&#tabs
http://dynamic.telestream.net/downloads/download-vantage-workflow-examples.asp?prodid=vantage&#tabs
http://dynamic.telestream.net/downloads/download-vantage-workflow-examples.asp?prodid=vantage&#tabs
http://www.telestream.net/vantage/help
mailto:sales@telestream.net
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Tour 1: Creating and Configuring Workflows
This tour takes about 15 minutes and provides a hands-on introduction to the concept 
and process of creating a typical Vantage transcoding workflow. In the following tour, 
you’ll submit some media to transcode, monitor your job as it executes, and then play 
the new media that Vantage produced using the workflow.

Vantage Workflow Designer is an intuitive, flexible, visual workflow design tool for 
creating and configuring workflows—the workhorses of Vantage. With visual workflow 
design and job status views, Workflow Designer provides a powerful, simple way to 
build an automatic video transcoding process from ingest to transcoding to output and 
distribution.

A workflow in Vantage is a series of connected actions arranged in a specific order to 
automate a specific media-related task: transcoding a file from one format to another, 
for example. In addition, metadata processing, analysis and data extraction, and other 
workflow functions can all be performed in the same workflow.

Vantage provides many types of actions (the smallest amount of work you can specify 
in Vantage) which you can use to implement a specific media processing solution. For 
example, a Watch action continually polls a hot folder (such as a media server directory 
or a local or network folder) for incoming media to process—which Vantage performs 
by automatically submitting a job to the workflow you've created. Likewise, a Flip 
action transcodes media, and a Copy action replicates a file to another location.

The task specified by each type of action (Watch, Flip, Copy, etc.) is actually executed by 
a Vantage service (a special type of Windows program)—for example, the Watch action 
is executed by the Vantage Monitor service.

In this tour, you’ll log on to your Vantage domain using Workflow Designer, and create 
and configure a workflow to encode a QuickTime file.

Starting Workflow Designer and Logging In
You can run Workflow Designer directly on your Vantage server, or you can install and 
run it on another Windows workstation on the LAN.

1. Double-click the Vantage Workflow Designer shortcut on your desktop or select 
start > Programs > Telestream > Vantage > Vantage Workflow Designer.

2. First Time—Select a Vantage domain. If this is the first time you’ve started Workflow 
Designer on this computer, you select the domain. (A Vantage domain is identified 
by the computer that hosts the Vantage domain database—you are actually 
connecting Workflow Designer to the domain database. For example, if your 
Vantage domain database is on a server named Vantage_01, then you select that 
name to connect.) After connecting the first time, Workflow Designer remembers 
the last domain you used, and connects automatically.
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Figure 30. Using the Select Vantage Domain Panel to Connect to a Vantage Domain

3. Select the domain you want to use, and click OK.

If you are having problems connecting to the domain, see Connecting to an Unlisted 
Domain or Connecting with Custom Login Settings, or contact your IT department or 
Vantage administrator for assistance.

4. If the Vantage Domain Login dialog is displayed, enter your Vantage user name and 
password in the login dialog to proceed.

Note: If you need a user account, obtain it from the administrator or create one 
yourself in the Management Console. For assistance, run the console and select Help 
> Online Help.
The default Vantage user name is Administrator, with no password assigned.

Figure 31. Vantage Domain Login Dialog

Once you’re logged in, Workflow Designer displays the main window.

This is the list of domains 
running on your network.
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Creating a Workflow Category
When Vantage is installed, there are no categories or workflows stored in the Vantage 
domain database. So, the first user that logs in to a new domain is prompted to create a 
new category and workflow.

Note: Even if categories are present, you should make a category for use during these 
tours, so that your practice workflows don’t interfere with the work of others, and that 
they remain separate from production workflows.

If you’re prompted to create a new category, click OK. Otherwise, select File > Create 
New Category to display the Create New Category dialog.

Figure 32. Create New Category Dialog

Enter <Your Name> Tutorial Workflows and click OK. 

Note: For these tours, the category is referenced simply as Tutorial Workflows. 
Workflow Designer displays help tips as you use it, to help you become familiar with its 
features. If you don’t want Workflow Designer to display them, check Don’t show me 
this again.

Creating a Workflow
Now, let’s create your first workflow to convert files to a small-frame (proxy) QuickTime 
file for preview purposes. 

1. If you’re prompted to create a new workflow, click OK. Otherwise, select File > 
Create New Workflow. Workflow Designer displays the Create New Workflow 
dialog.
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Figure 33. Create New Workflow Dialog

2. Select the category you just created, from the list at the top of the dialog.

3. Enter the name Simple Transcode (in your Tutorial Workflows category), and click 
OK. (There’s no need to change the expiration policy settings now.)

Your new workflow is automatically added to the list in the Workflows panel under 
the category you created earlier.

When you create a workflow, it is automatically placed in edit mode, so you can begin 
adding actions.

You do not need to explicitly save workflows you create or modify. The changes you 
make as you create (or update) a workflow are saved automatically in the database.
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A Quick Look at Workflow Designer’s Main Window
Now that you have a category and workflow created, you can take a minute to 
familiarize yourself with Workflow Designer’s window.

Figure 34. Workflow Designer Window, Displaying Workflow Design Workspace with Typical Workflow

Workflow Designer has a comprehensive set of menus, and several tabbed workspaces 
or panels.

On the left is the Workflows panel, with all of the domain’s workflows organized by 
category. To the right are several workspaces, identified by tabs—Workflow Design, 
Monitor Status, Job Status, and Domain Monitor Status, Domain Job Status, and 
Workflow Analytics. Each of these tabs displays a workspace for specific tasks you’re 
performing. In this tour, you’ll be working in the Workflow Design workspace, where 
you can create and configure your workflows.

Zoom control

Workflows panel—displays your 
workflows by category.

Use the Workflow Design workspace to 
construct and configure workflows.

Actions toolbar—
drag actions onto 
design area to add to 
workflow.

Zoom control

Workflow design in 
progress.

Nicknames | 
Variables View

Workflow Designer 
has workspaces for 
each key activity.
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Adding Actions to Your Workflow
You add actions and connect them together to form a workflow. Every workflow starts 
from an origin action (such as a Watch action monitoring a hot folder for new media to 
process) and continues execution of all other connected actions, each of which execute 
in left-to-right order when a job is submitted by the origin action.

All of the actions in Workflow Designer are arranged in functional groups in the Actions 
toolbar at the top of the Workflow Design workspace. The list you have may vary from 
the actions depicted here—some actions are licensed, and may be disabled.

Note: To re-arrange the groups in the actions toolbar, right-click in the toolbar and 
select Sort by Name or Sort by Behavior.

1. Open the Monitor group in the actions toolbar (click the arrow in the upper left 
corner of the group)—to display the Watch action and Associate action.

Figure 35. Action Toolbar, Showing Monitor Group Open

2. Click and drag a Watch action down onto the Workflow Design workspace to add 
your first action to the workflow. (Notice that it automatically centers itself—
Workflow Designer visually optimizes workflow actions automatically.) A Watch 
action polls a hot folder (which you need to specify) for new media files placed in 
the folder, and starts a job to execute the workflow using that file.

Note: You can also copy and paste actions in a workflow to duplicate them—the 
Copy and Paste commands are in the context menu. Right-click an action in the 
workflow and select Copy, then right-click in an empty area in the workspace and 
select Paste.

Actions are grouped 
by category. 
Click the arrow to 
open or close the 
group.
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Figure 36. Workflow Designer Workspace, Showing a Single Watch Action

3. Open the Transcode group and—rather than dragging an un-configured Flip 
action onto the workflow—click the Flip action one time to display a 
comprehensive list of pre-set Flip actions. (You can either use an un-configured 
action, or select a pre-configured action, which may make configuration easier.)

Figure 37. Flip Action Templates
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4. Select Web > QuickTime > QuickTime H.264 with AAC. The (pre-configured) action 
is added to the workflow and is arranged just to the right of the Watch action.

Connecting Your Actions Together
To create a chain of actions which execute in sequence, you connect them together. 
Here are ways you can connect actions together:

• Click and drag a connecting line from one connector pin to another

• Click and drag an action (either from the actions toolbar or one already in the work 
area) and bump it into the edge of the action you want to connect it to—until a 
pale blue vertical line displays. (You must drag your mouse pointer up to the edge 
of the action you’re connecting to).

• Copy an action, and right-click on a connector line and select Paste to add the cop-
ied action between the two actions. Or, drag an action onto a connector line until it 
displays as a larger line. Then, drop it to connect it between the two actions.

There are also two ways to disconnect actions:

• Hover over the center of the connecting line until a red X displays; click the red X to 
delete the line. 

• Hover over the connecting line until a red X displays, then right-click and select 
Delete.

Try connecting your actions now:

1. Click and drag a connector line from the yellow connector pin on the right side of 
the Watch action to the yellow connector pin on the left side of the Flip action. 
(Connector pins display in yellow until they’re connected.)

2. Next, open the Transport action group and drag the Copy action out onto the 
canvas.

3. Now, click and drag the Copy action so that your mouse is directly over the right 
side of the Flip action (a connector bar displays in pale blue, as shown below). 

Figure 38. Workflow Design Workspace, Showing Bumping to Connect Actions
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4. When the pale blue bar displays, release the mouse—the Copy action 
automatically connects to the Flip action.

Figure 39. Workflow Design Workspace, Showing Completed Connections

5. Now, delete the Copy action, because it is not required for this workflow. Select it 
and press Delete—or click the X button in the upper right corner—and confirm the 
Delete dialog.

Note: Workflow Designer automatically saves your workflow in the database as you 
modify it. You do not have to save workflows manually.

Configuring the Watch Action
Each action in a workflow performs a specific task or function (copy a file, for 
example)—and must be configured to perform the function specifically the way you 
want for a given workflow. 

You configure actions using the Inspector. The Inspector is one or more panels with 
configuration options—and the Inspector for each action varies, according to 
requirement of the action. For example, you configure a Watch action very differently 
than a Flip action.

Each action displays an i (for Inspector) button  in the top left corner; the color 
yellow indicates that it has not yet been configured (or configured correctly)—it 
displays blue when properly configured).

Vantage can process a broad array of media types and formats, and access all major file 
systems. In addition to standard file systems including Windows and FTP, Vantage 
intelligently works with several complex media types such as Avid reference movies, 
and P2 camera media files.

You’ll configure this Watch action to poll for any type of media file placed in a specified 
folder on a Windows server.
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1. Click on the  button of the Watch action (or, just double-click the action) to 
open the Inspector, and display the first panel.

Figure 40. Watch Action—File Type Panel

This first panel allows you to choose a special media type to watch for (such as an 
Avid reference movie). Or, you can select Any Media which will work for most media 
types.

2. Select Any Media to poll for any type of new media and click Next. (Media files is 
checked by default.) Workflow Designer displays the next panel in the Inspector.

Note: Entries in these lists that are disabled have not been licensed, and thus, are not 
available to use.

File formats supported by 
Vantage—those in gray 
have not been licensed.
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Figure 41. Watch Action—File System Panel

This second panel allows you to choose which type of file system (such as FTP or 
Windows) that the action will be watching (monitoring).

3. Select Windows as the type of file system to monitor, and click Next to display the 
next panel in the Inspector.

Figure 42. Watch Action—Watch Folder Panel

Note: If you’re using a Vantage array, where Vantage services and clients are 
distributed among several servers and workstations—or you access or deliver media 
on network servers—you must use UNC paths to identify media locations. The path 
must be a share with proper permissions (for example, \\MyDomainServer\HotFolder). 
Otherwise, your workflows will not function because it can’t find the path. Be sure to 
read Understanding Paths for Vantage Storage for guidance. 

4. Open Windows Explorer and create a folder directly on the Vantage domain server 
for this workflow and name it VantageTourOneIn. If you plan to reference it as a 
share, display Properties and enable sharing.

5. Return to Workflow Designer and click Browse to navigate and select the fully-
qualified path in this field. Or, enter the share path manually. 
This is now the hot folder for this workflow.

6. Click Next. Workflow Designer displays the configuration panel.

Click Browse to navigate to 
and select your hot folder or 
manually enter the path.
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Figure 43. Watch Action Inspector—Watch Configuration Panel

7. Take a moment to review these settings. (You can place your mouse cursor over the 
controls to display tooltips which describe each setting.) You don’t need to make 
any changes to this panel.

8. Select a nickname for the incoming file—in this case, Original is already selected, so 
you don’t need to change it. (You’ll learn more about nicknames in Tour 5.)

9. Click the  button at the top right of the panel to open context-sensitive help (a 
man page) with detailed information about configuring this Inspector. Wherever 
you see the context-sensitive help button, you can click it to display details about 
the part of Workflow Designer you’re focused on. (Click the ? to display the User’s 
Guide—the document you’re reading.)

10. Click Next and then click Finish to save this configuration of the Watch action.

Now that you’ve configured the action, notice that the Inspector button is hidden to let 
you know that it has been configured. Move your mouse back over the action—
Workflow Designer displays the Inspector button again—in blue. You can always re-
open the Inspector to review or change its settings.

You must select or enter a nickname in every 
action that acts on or creates a file, to uniquely 
identify and track this file instance throughout 
the workflow.
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Configuring the Flip Action
The Inspector button on the Flip action is yellow as well—meaning, it must be 
configured. Why does it need to be configured, given that you selected a pre-
configured action? Because the output file’s nickname hasn’t been specified.

1. Double-click the action to open the Flip Inspector, and note the red asterisk by the 
Output media file nickname field, indicating that a nickname is required.

Figure 44. Flip Action Inspector

2. Click the menu to view the list of nicknames for output files. Enter QuickTime H264 
AAC as the nickname for the file this action creates. Now, all subsequent actions in 
the workflow can reference the output from this Flip action, simply by referring to 
the nickname QuickTime H264 AAC.

Some of the nicknames in the list are key Vantage nicknames— they enable certain 
Vantage features or are required in certain actions. When you create your own nick-
names, they should be meaningful in the context of your workflow.

Note: The nickname you assign a file has no effect on the output file name (which by 
default, will be the same as the input filename, except for the extension). For example, 
if you submit test.mpg, this Flip action will create test.mov. The input file in this 

You must select or 
enter a nickname in 
every action that acts 
on or creates a file, to 
uniquely identify and 
track this file through 
the workflow during 
execution of the job.
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workflow is always referenced by the nickname Original and the output file is always 
referenced by the nickname QuickTime H264 AAC. 

3. Take a moment to click on each of the video stream, audio stream, and H.264 and 
AAC codec components, as well as the QuickTime Movie container component in 
turn, and review the details panel for each component (the details panel displays 
below the building blocks). Also note the toolbar directly above the building 
blocks. This is the comprehensive user interface for configuring Flip (transcoding) 
actions in Workflow Designer.

4. Click Save to save this configuration of the Flip action, and note that the yellow 
Inspector button no longer displays. 
Now, when you hover over the action, the Inspector button displays in gray, and 
when you hover over the Inspector button itself to select it, it displays in blue.

Conclusion
Congratulations! You’ve just learned how to create a workflow, and learned the basics 
of configuring actions using Workflow Designer’s Inspector. You’ve created a complete 
workflow which can detect new media files placed in a hot folder, and convert them to 
QuickTime format.

In the next tour, you’ll learn how to activate workflows, submit jobs, and monitor them.
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Tour 2: Processing Media in a Workflow
This tour takes about 15 minutes, and shows you how to process media in your 
workflow—which involves activating a workflow, submitting media to transcode, 
monitoring the job as it executes—and view the new media it generates.

You can start a job from an active workflow in various ways:

• Place a media file in a hot folder to submit a job automatically

• In the Watch action Inspector, check Process Existing Media. Then, select a hot 
folder which already has one or more media files, and activate the workflow—this 
causes Vantage to process all existing media in the directory, rather than ignore it.

• Click the Submit Job button (at the bottom of the window) and select the file (or 
files) to submit manually. Just follow the steps in each panel.

• Drag and drop a file (or files) directly onto the origin (Watch or Receive—or Catch 
or Dublist in TrafficManager) action of a workflow. 

In this tour, we’ll drop a media file in a hot folder to start a job automatically.

Activating a Workflow
To activate a workflow, follow these steps:

1. If you closed Workflow Designer, open it again.

2. Select your Simple Transcode workflow in the Workflows panel on the left.

3. Click the Activate button at the bottom of the window. 

Figure 45. Activating a Workflow to Process Jobs

Click Activate to release the workflow from editing, save 
it, and activate it to start the Watch action.
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Workflow Designer releases it from edit mode and the Vantage Monitor Service starts 
the Watch action in your workflow, polling the hot folder you specified, searching for 
new media files to process. A job is started for each new file placed in this folder.

Monitoring your Workflow Status
When you activate a workflow, Workflow Designer automatically displays the Monitor 
Status workspace to show you the status of all Watch actions. (You can always select 
any workflow and view its monitor (or job) status, including a record of past jobs.)

Figure 46. Monitor Status Workspace

Notice that the action state of the Watch action is listed as In Process, which indicates it 
has started executing, and it is polling for new files. When a new file is discovered, a job 
is created that executes the Simple Transcode workflow. Actions may also be Waiting—
the state that the transaction enters while Vantage is determining which service should 
process it. A transaction remains in Waiting state until it is accepted by a service for 
processing.

If you deactivate the workflow, the Watch service stops monitoring the hot folder, and 
the record is saved in the database for history. When you re-activate the workflow, a 
new record is added to the list. 

You can double-click the Watch action entry in the table to display more detailed 
information. You can confirm that it is polling the directory that you specified, and that 
no new files are detected—or that you’ve made an error in the file path that needs to 
be fixed, for example.
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Note: You may have also noticed the Domain Monitor Status workspace—the only 
difference is one of scope—it displays all of the monitors in the entire domain.

Figure 47. Monitor Status/History Dialog

When jobs are started, each action is executed by a corresponding Vantage service, and 
can be optimized for execution if multiple services (for example, multiple Transcode 
services) are in your domain.

Now, submit a job by following these steps:

1. Drag a file to your hot folder to submit a job. We suggest that you use one of the 
sample media files provided, which are located at <InstallDrive>:\VantageStore 
(typically, C:\VantageStore), in an All-in-one domain. (If sample media was not 
installed, just use your own.)

2. Click the Job Status tab to display the Job Status workspace to monitor the status of 
running jobs.
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Figure 48. Job Status Workspace—Each Action Displays a Color-coded Status

3. Click on the new job entry in the table, and observe each action change color as the 
entire job executes each task specified by the actions in the workflow. 

Actions display specific border colors to identify each action’s state. For example, a 
yellow border indicates the action hasn't started executing yet. A green border 
indicates the action is currently executing, and a blue border indicates the action 
has completed without errors. For a complete list of colors and their meanings, see 
Using the Jobs Table.

4. Move your mouse over actions in the workflow in the Job Status workspace to 
display the i (Inspector) button in the top left corner. 

5. Click the Inspector button to display run-time information about the action in the 
Status/History window.

Figure 49. Status/History Window Displays Action Execution Details
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6. Click on each succeeding status line in the Status/History window to display details 
about the action. Close this window when you’re done.

When all actions are outlined in blue, the job has completed successfully.

Playing Your New File
Now that the job has completed, Vantage has encoded a new QuickTime file.

Note: You didn’t configure the Flip action to tell it where to save new files. So, where 
are the new files saved? The short answer: unless otherwise specified, new files are 
written to a Vantage store—a pre-defined directory for storing temporary files.

1. In the Job Status workspace, make sure your job entry is selected in the Jobs table 
at the bottom.

2. Click on the Binders  button to display the binder for this job.

A binder in Vantage keeps track of the location of media files associated with a job, 
plus metadata labels and other attachments (files).

Figure 50. Binder Window Displays Assets—Media, Metadata, and Attachments

3.  Right-click the output file which your workflow transcoded into QuickTime to open 
the containing Windows folder, then double-click it to play it!

Deactivating a Workflow
In an upcoming tour, you’ll use a copy of this same workflow. You should deactivate this 
workflow so that you can use the same hot folder in the next workflow, without the 
Simple Transcode workflow ingesting new media you add to the hot folder. 

Select the Simple Transcode workflow in the Workflows panel, and click Deactivate at 
the bottom of the window.
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Figure 51. Workflow Designer Window, Showing Deactivate Button

If you want to edit the workflow again, select File > Edit Workflow or click Edit at the 
bottom of the window. When you’re done editing a workflow, you should click Release 
so that it can be edited or executed by others in the organization.

Conclusion
Congratulations! You’ve just learned how to automatically submit media to a workflow, 
monitor its execution, and view the transcoded media file.

In the next tour, you will explore how to use the Workflow Design workspace 
effectively.
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Tour 3: Using the Workflow Design Workspace
Now that you know how to create workflows and submit media, let’s take a moment to 
learn some techniques for using the Workflow Design workspace effectively. This tour 
takes about 10 minutes.

Some workflows—like Simple Transcode—have only a few actions in them; others may 
have dozens of actions. Sometimes you’re working on the big picture of a workflow—
laying out actions and connecting them together. Other times, you’re working on 
action details—configuring the details of a transcode task, for example. 

In each case, you may want to zoom in or out, scroll around, or center the work area, to 
help you focus directly on the work you’re performing at the moment.

Types of Workflow Actions
There are many different types of actions you can use to build your workflows, each 
designed to help you create comprehensive, powerful media processing tools. Here’s 
an overview of major groups and actions.

Monitor—includes Watch and Associate, for ingesting files and starting jobs for the 
workflow. These monitor directories on a wide variety of computers and media-centric 
file systems and platforms. The Workorder action enables batch submission multiple 
input files to a given workflow.

Traffic—for processing local and regional, and national commercials to on-air or 
broadcast, including interacting with catch servers. Actions include the Catch action 
and Dublist action. These actions are part of TrafficManager.

Metadata—includes actions (Populate action and Transform action) which allow you to 
automatically edit and update metadata labels, and transform labels and attachments.

Catalog—includes actions (Register action and Exist action) which allow you to register 
media in Vantage’s catalog for safekeeping and further processing and analysis by 
other workflows.

Transcode—the Flip action includes a broad suite of encoders and codecs, and allows 
you to encode media on a file-by-file basis.

Analysis—includes a wide variety of actions which allow you to examine video and 
audio for specific characteristics and metrics, and extract the results for use in building 
intelligent, adaptable workflows.

Multiscreen—the Multiscreen Flip action allows you to encode adaptive- or multi-
bitrate packages such as Apple HLS and MPEG DASH.

IPTV VOD—The IPTV Flip action allows you to encode Transport Stream containing 
MPEG-1, MPEG-2, H.264 and HEVC (H.265). It uses Manzanita multiplexing technology 
to give you fine control over Transport Stream creation.

Edit—Includes the actions for Post Producer. The Conform action renders complex 
editing timelines into output media files, allowing you to automate the production of 
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hundreds of customized outputs. The Compose action allows you to import timelines 
from editing systems such as Final Cut, Adobe, and Avid.

Transport—includes actions which allow you to copy, move, and delete files, and 
deploy them to external systems.

There many other utilitarian categories and actions, as well as third-party actions for 
interaction with their systems: Aurora, Signiant, Aspera, and others.

Take time to browse through the groups—open them up, and drag their actions onto 
the design space and review their Inspectors to gain a solid understanding of Workflow 
Designer’s comprehensive workflow building blocks.

Zooming In and Out on a Workflow
There are three ways to zoom in and out on a workflow:

• Drag the zoom slider bar at the bottom left of the workflow

• Repeatedly press Control+/- (the plus and minus keys)

• Use the scroll wheel on your mouse while pressing the control key.

To zoom a workflow, do the following:

1. If you closed Workflow Designer, open it again, and select the Simple Transcode 
workflow from your category in the Workflows panel (on the left).

2. With your Simple Transcode workflow selected and displayed in the Workflow 
Design workspace, click Edit at the bottom of the window.

3. Use the zoom slider bar at the bottom left corner to zoom in and out to suit your 
viewing and editing needs.

Figure 52. Workflow Designer Zoom Control

Moving the Workflow Around in the Workspace
A workflow with many actions may be larger than you can view effectively in your 
workspace, when viewed at the zoom level you’re currently using. 

To move the workflow around in the workspace, click and hold anywhere on the 
workflow canvas itself (do not click on an action). When the cursor changes to a 
compass, continue to hold down the mouse button and drag the workflow in the 
appropriate direction.

Use the zoom slider bar to zoom 
your workflow in and out.
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Centering the Workflow in the Workspace
To center the workflow in your workspace, right-click in the workspace and select 
Recenter Workflow from the context menu. Alternatively, you can press Control-R on 
the keyboard.

Before you continue, take a few moments to practice zooming, moving, and centering 
the workflow—you’ll use these features frequently, especially as you create larger and 
more complex workflows. Becoming familiar with them now will make it easier to focus 
on the design process.

Using Auto Arrange
Use the Auto Arrange feature to assist you in visually optimizing and organizing the 
layout of actions in your workflow.

Figure 53. Enabling Auto Arrange

To disable automatic arrangement of actions while you're adjusting actions in a 
workflow (especially a large one—30 actions or more), click the Auto Arrange button, 
located at the bottom of the Workflow Design workspace, to toggle it off. While Auto 
Arrange is off, the Auto Arrange button displays the phrase Auto Arrange SUSPENDED 
in yellow, and actions will not automatically organize themselves.

Click the button again to toggle auto arrangement back into effect.

Displaying Workflow Details
To display or hide a workflow’s details panel, do one of the following:

• Select File > Workflow Details panel.

• Click in the Workflow Design workspace’s title bar.

When you display the workflow’s details panel, Workflow Designer obscures the tabbed 
workspaces to display details about the workflow.

Enable or disable Auto Arrange to 
suit your construction style.
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Figure 54. Workflow Details Panel, Showing Workflow Title Bar

In the workflow details panel, you can use the following controls to manage the 
workflow information:

• Name text box—Edit the workflow name.

• Description text box—Edit an optional description for the workflow.

• Expiration controls—Modify to configure the job expiration time.

• Apply—Click Apply to save your configuration changes.

• Close—Click Close to hide the workflow details panel.

The information that displays below the Apply button is informational and cannot be 
changed. Details include creation and modification dates, and the workflow’s GUID in 
the database.

The Expected Variables list indicates which variables are being utilized by actions in this 
workflow. If an action parameter in the workflow binds to a variable, it displays here.

Conclusion
Congratulations! You’ve just learned how to use some of the features in the Workflow 
Design workspace. In the next tour, you will learn how to set up a workflow’s 
transcoding actions to use the settings that you want.
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Tour 4: Transcoding Files Using Settings You Want
This 20 minute tour adds to your workflow design and configuration skills. It’s an in-
depth look at how effectively Vantage deals with the complexities of media transcoding. 

Duplicating a Workflow
It is often easier to duplicate a workflow and make minor modifications to it, rather 
than starting over with a new one. To duplicate a workflow, do the following:

1. If you quit Workflow Designer after the last tour, start it again. In the Workflows 
panel, open your Tutorial Workflows category. 

Figure 55. Workflow Designer Window, Showing Workflows Panel on Left

2. Select the Simple Transcode workflow.

3. Select File > Duplicate Workflow (or right-click and select Duplicate...). Workflow 
Designer displays the Duplicate Workflow dialog.

Figure 56. Duplicate Workflow Dialog (Shown Completed)

4. Name the new workflow Complex Transcode. Click OK to create the new workflow 
and close the dialog.

Workflow Designer automatically selects the new workflow, places it in edit mode and 
displays it in the Workflow Design workspace.
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Adding a Branch to a Workflow
Now, let’s add a second, pre-configured Flip action to your workflow. Recall that 
Workflow Designer has many pre-configured actions, making it easier to build 
workflows.

Let’s add this Flip action so that Vantage can encode two separate output files 
simultaneously, in a single workflow. By creating a branch with parallel Flip actions, 
each Flip is executed independently as soon as the Watch action completes (making 
the resources available). This design is more time-efficient than if one Flip action 
followed the other. Creating branches for parallel encoding is an important part of 
Vantage scalability and high-volume transcoding. To add a branch, do the following:

1. Open the transcode action group on the action toolbar.

2. Click on the Flip action and select Mobile > 3GPP 300KBit H.264 with AAC preset 
from the menu to add it to the workflow (see Figure 57).

Figure 57. Selecting a Pre-configured Action to Add

3. Connect the new Flip action to the Watch action—click and drag a connector line 
from the out connect pin on the right side of the Watch action to the in connect pin 
(left side) to connect the new Flip action—creating a new branch in the workflow.

4. Open the new Flip action’s Inspector and specify an output file nickname to identify 
the new file you’re encoding—Mobile 3GPP. 

5. Click Save to update the workflow in the database and close the Inspector.
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Writing Output Files to Specific Locations
As this workflow is currently designed, newly-encoded media is saved in a Vantage 
store, because you have not explicitly configured the workflow to place the media in a 
specific folder. In order to use the new file after the workflow has completed—for 
example, on a broadcast server or QA server—you need to explicitly move it to a known 
location on your network.

Let’s add a Move action to each branch, so that the workflow places the new media in a 
specific folder. Move actions are part of the Transport group, and are file system actions. 
A Move action actually copies the file to the new location, then deletes the original.

Move actions (and other file system actions) utilize a special feature called the Vantage 
folder address book, which enables you to store output locations, IP addresses, folder 
names and credentials in a single place. This makes it easier to manage destination 
locations for files.

For a detailed discussion of using UNC paths, see Understanding Paths for Vantage 
Storage.

To move the new files:

1. Open the Transport action group on the action toolbar. Drag a Move action onto 
the QuickTime branch, and another onto the 3GPP branch, connecting each to the 
Flip action, so that each Move executes after the Flip action.

2. Open the QuickTime branch’s Move action Inspector.

Figure 58. Move Action Inspector (Prior to Configuration)

3. Select the QuickTime H264 AAC file by nickname, to identify the file to move.

4. Click on the browse  button to the right of the Destination field. Workflow 
Designer displays the Vantage Folder Address Book.
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Figure 59. Vantage Folder Address Book

Vantage folders simplify directory referencing by allowing you to specify a fully-
qualified output location by a simple name. They also allow you to update a path or 
credentials centrally, and automatically update all actions using that Vantage 
folder.

For example, you might have a folder on a given server for HD MPEG2 content: 
\\Voyager\SunupCampaign\Darwin\WaitingApproval\HDMPEG2. You can create a 
Vantage folder in the address book for this path, and name it SunupHDWaitingAp-
proval. If you need to change the path or any password associated with the address 
later, you can simply change it in the address book and all actions will automatically 
be updated.

5. Create a new Vantage folder—click the Add Folder button in the toolbar (the new 
folder button at far left):

Figure 60. Add New Folder Dialog

6. Enter the folder name in the Name text box: VantageOut.

7. Click Modify to specify the directory that this Vantage folder address points to. 
Workflow Designer displays the Folder Location Editor.

8. Choose Windows File System and click Next. (Vantage folders can be defined for 
any supported file system.)
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9. Click Browse to select a directory (for example, in Windows Explorer make a folder 
named C:\VantageOut) where you want the output media file copied, and click 
Select Folder. (Don’t use drive letters on a distributed Vantage array or distributed 
clients—they won’t work.)

10. Click Finish to close the Folder Location Editor dialog. (You may have to click OK on 
the local folder warning dialog.)

11. Click OK to add this new Vantage folder and close the Add New Folder dialog.

12. Click Select to specify this new folder as the destination for the Move action.

Figure 61. Move Action Inspector—After Configuration

13. Click Save to save this configuration and close the Inspector.

14. Repeat these steps for the 3GPP Move action—select the Mobile 3GPP nickname for 
the file you’re moving, and select the same destination—VantageOut.

When you’re done, your workflow should look like this:

Figure 62. Completed Complex Transcode Workflow

15. Activate this workflow.

16. Automatically submit a media file to this workflow, using one of the sample media 
files in <InstallDrive>:\VantageStore\ (typically, C:\VantageStore). (If sample media 
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was not installed, just use your own.)
If you don’t remember how to submit a job by dropping the file in a hot folder, refer 
to Tour 2: Processing Media in a Workflow.

As the job executes, notice in the Job Status window the simultaneous execution of 
both Flip actions, resulting in two new media files.

Configuring a Flip Action
Now, let’s look at the original QuickTime Flip action that you added in Tour 2 in more 
detail, and learn how to change Flip action settings.

To change settings in this action, do the following:

1. Click Edit to deactivate the workflow and enter editing mode.

2. Display the Inspector of the QuickTime Flip action.

Figure 63. Flip Action Inspector Dialog

3. Click the Encoder menu to display the list of codecs you can use in the Flip action.

4. Click on the Video Stream component to display the Processor menu in the details 
panel below, where you select which video processor to use: Legacy 8-bit RGB, 
4:4:4, Multi-core 16-bit YCbCr 4:4:4:4, or Lightspeed Accelerated 16-bit YCbCr 
4:4:4:4, and others. 

5. At the right of the video stream, click the Video Codec menu to display the video 
codecs that are available. (Click the gear icon to cycle through the selection.)

6. To the right of the audio stream, click the Audio Codec menu to display the audio 
codecs that are available.

Encoder menu 
displays all 
encoders in the 
domain.

Video button & 
codec menu.

Audio button & 
codec menu.

Container button 
and menu.

Video and Audio 
stream buttons.

Video Processor 
selector.
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7. At the far right of the Video and Audio Stream components, click the Container 
menu to display the containers that are available (notice that the QuickTime 
encoder only provides a QuickTime container).

Note: As you click on the video codec, audio codec, and container buttons to select 
them, configuration details display in the configuration panel at the bottom of the 
window. For example, the Video Codec configuration panel enables you to set frame 
width, height, and bitrate for the video in the QuickTime file.

When you select a stream (by clicking the audio or video stream buttons, far left), 
you can also add processing filters.

8. Select the Video Stream button in the toolbar and then click on the Video Filter 
menu to display a list of video filters.

Figure 64. Flip Action Inspector Dialog, Showing Video Filters

9. Select the Contrast filter. 

Workflow Designer adds it to the video stream, as shown below.
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Figure 65. Video Stream Configuration, Showing Contrast Filter

These filters are applied during a transcode, and provide you a great deal of control 
over how the transcode functions.

10. Click on the Video Codec at the far right to display the codec settings at the bottom 
of the window:

Figure 66. Flip Action Inspector Dialog, Showing the Video Codec Button

11. Open Frame Size/Frame Rate and change the frame size to 640x360.

12. Finally, click the Encoder menu at the top to display the encoders that you can 
select. (Recall that you can configure a Flip from scratch, or you can select a 
template—which you did earlier when you added the 3GPP Flip action).

13. Click Cancel to close the Inspector without making any changes.

Note: Click the Edit Filename Pattern button to control the output file name. By 
default, Flip actions name the files they create using the same root name as the 

Video codec 
button
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original file’s name plus an appropriate extension, based on the encoder. For example, 
a QuickTime movie flipped from FlipDemo.mss is named FlipDemo.mov.

Conclusion
In this tour, you’ve learned how to duplicate an existing workflow, how Vantage 
performs multiple simultaneous encodes, and how to create and use Vantage folder 
addresses. You’ve also learned how to configure Flip actions to perform encoding tasks 
the way you want.
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Tour 5: Using Nicknames to Identify Files
This tour rounds out your knowledge of nicknames, and how you use them to easily 
track and process multiple files action by action in a workflow. It takes about 10 or 15 
minutes to complete.

Overview
A key feature of Vantage workflows is the notion of nicknames. A nickname in Vantage 
provides a convenient means of referencing a file, using only a word or logical phrase—
such as Original or QuickTimeH264AAC.

In the context of a workflow, all files are referenced by a nickname which you assign as 
you either ingest (usually with a Watch or Associate action) or create a file (for example, 
with a Flip action). 

Nicknames are used in every action that creates, accesses, or operates on a file. 
Nicknames provide an easy way to tell an action which logical file it should use. For 
example, after a transcode, a Move action might move either the output of the 
transcode, or the original file used as the source. You can use the Move action to move 
either one, and you use a nickname to identify which file to move. Vantage 
automatically keeps track of which file and its associated nickname as a job runs.

Vantage provides a set of default nicknames which can be used in certain types of 
workflows or to enable certain Vantage features. You can assign your own nicknames 
which are meaningful in the context of your workflow. Nicknames can be used over and 
over again in multiple workflows—they only have scope, or relevance, during the 
execution of the workflow, and have no context outside the workflow itself.

Note: For some complex media types—such as Omneon reference files or P2 camera 
files—media is actually a collection of files, all of which are necessary to make the 
media work. In this case, the nickname refers to the entire collection of media files; 
Vantage tracks all the video and audio files which comprise the media automatically.

Deleting a File Using its Nickname
To reinforce the notion of using nicknames, let’s make one more change to the 
Complex Transcode workflow. The Delete action is a file system action which you use to 
delete a file that is no longer needed, using the nickname of the file. Let’s use it to 
delete the original file that was ingested by the Watch action, at the end of the 
workflow.

1. Select the Complex Transcode workflow—duplicate it as Complex Transcode Delete.

2. Open the transport actions group, and click and drag a Delete action into the new 
workflow, without connecting it to any action. Notice that no nicknames display on 
this action.
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3. Connect the Delete action to the top Move action so that it executes when the 
Move action is complete. 

Note: Notice that the nicknames now display on this action. The list on the left are 
files available before execution; the list on the right are files available after execution. 
(After configuration, the files used in this action are highlighted.)

Figure 67. Nicknames Display Directly on an Action

4. Open the Delete action Inspector (click the yellow i in the top left corner). 

Figure 68. Delete Action Inspector Lists Files by Nickname

The Delete action accepts one parameter: The nickname of the file that you want to 
delete. This list displays the nicknames of all files in the workflow that it knows of at 
the moment, based on its connection—Original (from Watch) and QuickTime H264 
AAC (from the connected Flip action).

5. Select Original (which identifies the input file) and click Save to close the Inspector.

Workflow Designer immediately highlights the other Flip action’s Original nick-
name in red, indicating an error. In this case, you’re attempting to delete a file while 
it is simultaneously being transcoded by a peer Flip action in the other branch! By 
using nicknames, Workflow Designer can help you discover many workflow design 
issues automatically.

6. Connect the Move action to the Delete action to merge the branches, (see below).

Nicknames of files 
in this workflow 
before execution of 
this action.

Nicknames of files 
in this workflow 
after execution of 
this action.
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Figure 69. Merged Branches Synchronize Actions

When the workflow branches are merged, the Flip actions are synchronized. As 
designed, the workflow waits for all upstream workflow branches to complete before 
executing the first action in the merged branch. Thus, the Delete action will not execute 
until both Flip actions have completed. If it executed right after the top Flip action, it 
might delete the file (or attempt to and fail) before the 2nd Flip had completed.

Figure 70. Nicknames are Updated When you Connect to Another Branch

Also notice that the nicknames on the Delete action have been updated to include the 
file from the second Flip—Mobile 3GPP.

The Mobile 3GPP 
nickname is added 
to the list.
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Tour 6: Processing Attachments in Workflows
This 15-minute tour shows you how you can add files other than media files to a 
workflow, and process them. 

Note: The workflow for this tour is called SCC Caption File Application. This workflow, 
along with others, is available on the Telestream Web site at http://
www.telestream.net/telestream-support/vantage/workflow-examples.htm. You can 
also find it in your Telestream installation folder at C:\Program Files 
(x86)\Telestream\Vantage\Samples\Transcoding (or other drive where Vantage was 
installed). Locate and have this workflow available before taking this tour, which 
explains how to use it.

In addition to creating and processing media files, workflows can also process non-
media files, called attachments. An attachment might be an XML file, an SCC caption 
file, or an STL subtitle file. It might even be a PDF or other type of file which does not 
contain video or audio media, and just needs to be stored with the media file as part of 
a job requirement.

The key concept of the tour is this: You use an Associate action in your workflow to 
watch hot folders for attachment files, just like you use Watch actions to watch for 
media files. The Associate action discovers the attachment and pairs it with the media 
file so they can be processed together.

Importing the Sample Workflow
The Vantage Management Console (often referred to as simply the console) is the 
program you use to configure and administer your Vantage domain—including 
Vantage services, licenses, and workflow design items. You can also import many items, 
such as stylesheets, workflows, etc. To begin this tour, import the SCC Caption File 
Application.xml workflow file into Vantage as follows:

1. Double-click the Vantage Management Console shortcut on your desktop to 
launch it.

2. Display Workflow Design Items > Vantage Workflows.

3. Click the Import button, then browse and select the SCC Caption File Application.xml 
workflow file for importing.

http://www.telestream.net/telestream-support/vantage/workflow-examples.htm
http://www.telestream.net/telestream-support/vantage/workflow-examples.htm
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Figure 71. Importing a Workflow using the Management Console

The imported workflow appears in the list of workflows under the category you 
specified when you imported it.

Note: You can also import workflows directly in Workflow Designer by using the File > 
Import Workflow menu. For this tour we used the Management Console so that you 
can become familiar with using it. 

Understanding Attachment Workflows
Suppose you have a set of media files and associated SCC caption files that need to be 
matched and applied during a transcode so that captions get inserted into the video. 
You could set up one Watch action to wait for incoming media files, and you could set 
up another watch action to wait for incoming SCC files, but how would you associate 
them together?

The answer lies in the Associate action, which is used instead of a Watch action to cause 
the job to wait for an incoming attachment file and then add the file to the job’s binder 
already created by the Watch action that picked up the media file. The Associate action 
accomplishes this by matching the attachment file name to the media file name that 
already exists in the binder, based on a pattern you configure in the Inspector. Now 
both files are in the binder, and they can be used in the workflow.

The SCC Caption File Application workflow works in exactly that way. It watches a folder 
for media, associates a caption file from a different directory (waiting if necessary for it 
to arrive), and then transcodes the media file while also applying the caption file to the 
output.



Vantage Workflow Designer Tours
Tour 6: Processing Attachments in Workflows

110
Attachment Workflow Description
Follow these steps to learn the details about how the SCC Caption File Application 
workflow operates:

1. Launch Workflow Designer.

2. Locate and click the SCC Caption File Application workflow in the Workflows panel. 
The workflow opens in the Workflow Design workspace. If necessary, click the 
Workflow Design tab to see it.

Figure 72. Importing a Workflow

3. Click the inspector button  on the Associate action (or just double-click on the 
action itself ) to open the Inspector. The Inspector opens in read only mode 
because you imported the workflow.

On the first panel, note that Attachments is selected. (You can select other media 
files, but you cannot transcode them when ingested by an Associate action.)

4. Click Next two more times to view the second and third Inspector panels. 

As in the Watch Inspector, these panels allow you to select the file system (Win-
dows in this case) and specify the folder to watch for attachment files. Note that this 
is the same folder being watched for media files.

5. Click Next to view the fourth Inspector panel.

In this panel the incoming attachment file is assigned the nickname SCC File. Notice 
also that the File Match Pattern is set to accept only files with names matching the 
pattern [NAME]*.scc. Additionally, the Match file name is set to Original—the nick-
name of the media file ingested by the Watch action that started the job. These set-
tings ensure that only SCC caption attachment files with a root name that matches 
the media file name will be accepted. Finally, notice that a File Path variable (Cap-
tion File) to create a file path variable and passed downstream to specify the associ-
ated caption file location.

6. Click Next and Cancel to close the Associate Inspector.

7. If necessary, click Release at the bottom of the Workflow Design workspace and 
click Edit to allow you to modify the workflow.
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8. Click the inspector button  on the Flip action to display the Inspector. 

On the open panel, note that the selected Encoder is an MPEG-2 Program Stream, 
the Input media file is nicknamed Original, and the output media file is nicknamed 
Broadcast. The specified output location is the default Vantage Store. 

In the middle of the panel, the video and audio streams are shown and the Add 
Movie Filter is set to SCC Caption Insertion. This filter inserts the SCC captions into 
the transcoded video stream.

Click on each of the selections in the middle area to see the many transcoding and 
filtering options available, and also notice the additional parameters at the bottom 
of the panel that change with each selection in the middle area. 

If you click on the Add Movie Filter menu, for example, you’ll notice that there are 
many other filters you can apply to a video stream to add blanking, modify time-
code, output an SCC file from 608 captions already present in the video (the reverse 
of what this workflow is doing), and so on. 

Click on the SCC Caption Insertion filter, and click the General menu. Notice that the 
SCC File field is green, indicating that the SCC file name and location are bound to 
(originate from) the Caption File variable defined in the Associate action. If you click 
the green button at the far right of the SCC File field, you will see how this is set up. 
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Running the Attachment Workflow
Now it’s time to test the attachment workflow:

1. Create a folder on your C drive and name it VantageIn.

2. Activate the workflow, so that it will detect the MPG media file and start a job.

3. Locate or create an MPEG media file and a matching SCC caption file. Ensure that 
they are named identically except for the extension. Note that the files must be a 
properly paired media and SCC file, and they must use the same frame rate, such as 
29.97; if they are mismatched, the workflow will not caption the output.

4. Drop the MPG media and SCC caption file into the C:\VantageIn folder. 

5. Click on the Job Status tab and select the job to watch it execute.

6. When it’s done, locate the file—select the job in the table and click on the Binder 
icon in the toolbar to open the binder. 

7. Right-click on the Broadcast file and select Open Containing Folder to display it in 
Windows. Or, select Open With Default Program to play it directly.

Note: You can also add another Flip action to the workflow, and configure it to 
encode the Broadcast file into either a WMV or QuickTime proxy so you can preview it.

8. Deactivate the workflow when you’re finished.

Conclusion
In this tour, you learned about using the Associate action to match files, such as SCC 
caption files, with media files. Using these same principles, you can associate any file 
with a media file and keep them together throughout the workflow.
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Tour 7: Controlling Workflow Execution with 
Variables

This 30 minute tour introduces you to one use of variables in workflows. This tour also 
provides you a first look at the Vantage Management Console. This tour focuses on the 
role that variables play in Vantage workflows: passing important job information 
between actions, controlling execution flow, changing action priority, and controlling 
job routing.

Overview
In Vantage, a variable is a named unit of data (for example, an integer named Video 
Width) that only lasts as long as the job is executing. Variables can be used to pass data 
between actions. For example, an Analysis action might publish a variable named 
Video Width containing the width of the frame in a particular media file, and a Decide 
action might make a decision based upon the value of Video Width.

You can create and define variables in the Management Console, or you can define 
them directly in Workflow Designer, as you are configuring an action.

A variable can be supplied a default value, and the value of the variable may also 
change during the course of workflow execution. You can also use the current value of 
a variable without changing it—for example, determining if a numeric value (in the 
variable Video Width) is 720.

Each variable has a name (such as Number of Audio Channels), a type (such as Integer 
Number), and a default value (such as 50), all of which are defined when the variable is 
created. You can change variable values in a variety of ways. For example, a variable 
value can be changed in actions that are designed to use variables, such as the Analysis, 
Populate, Watch and Associate actions. Variable values can also be changed when 
adding a variable to an action in a workflow or when manually submitting a job.

Variables are passed from action to action according to the action connections. When 
an action creates (or sets) a variable, all downstream actions that use variables can 
access the variable’s current value. If an action creates a variable but doesn’t explicitly 
set its value, the variable’s default value (which is set in the Management Console) is 
used. For example, in the Complex Transcode workflow, you could set the Priority 
variable to 100 (higher priority) in one of the Flip actions; the other could use the 
default value of 0 (lower priority).

Finally, variables are temporary; the information only lasts as long as the job is 
executing—and is known only in the context of the running job. 

Variables can be used in several ways:

• To dynamically control settings or change configurations in actions

• For routing tasks for execution on specialized platforms

• For decision-making to determine which branch of actions execute

• To determine the priority of a particular action.
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Setting a variable in an action on one branch of a workflow does not affect the value of 
a variable with the same name on the other—because these are actually two different 
copies of the variable, in different branches.

If workflow branches merge, variables with the same name collide in the first merged 
action. The value from the branch which completes last is updated last—and it is the 
value that is passed on. Because the branch which finishes last cannot be known when 
you create the workflow, Telestream recommends that merged branches have actions 
which explicitly reset colliding variables, before using them again downstream. If you 
need both variable values past the merge, you should start with 2 different variables; 
one on each branch.

Starting the Vantage Management Console
The Vantage Management Console is the program you use to configure and administer 
your Vantage domain—including Vantage services, licenses, and workflow design 
items, including variables. Vantage user accounts are also created in the console.

1. Double-click the Vantage Management Console shortcut to launch it.

2. If you haven’t previously launched the console, you’re prompted to select a 
domain. You’ll log in using a Vantage user with administrative privileges (default: 
Administrator, no password), unless User Administration is disabled. 
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Creating Variables
1. Select Workflow Design Items > Variables to display the Variables panel.

Figure 73. Creating and Configuring Variables in the Management Console

The Variables panel displays a list of variables, which includes default variables plus 
those created by Vantage users in this domain. You can use the default variables in 
workflows as-is, and you can create your own.

2. Select the Curtained variable to display its details (which you can configure) at the 
bottom of the panel. (When focus is on the table, you can use keyboard keys to 
locate a given variable by name—for example, press R to go to the first variable in 
the list that starts with R.)

Rather than using a default variable, let’s create a new Date variable called File Mod-
ification Date.

3. To start, click the New Variable button in the toolbar (far left button).

4. Vantage displays the Create New Variable dialog. Select the type of variable you 
want to create—Date.

New Variable button in the toolbar
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Figure 74. Creating a New Variable

5. In the details panel, enter the name File Modification Date, and leave the 
default value unchanged.

6. Click the Save button  to save your variable.

Note: There is nothing special about the name File Modification Date—you can create 
variables with any name that is not already in use. In this workflow, we will use this 
specific variable to store the modification date of the file, so we’ll name it descriptively.

Using the Priority Variable
There is one special variable whose name can not be changed—Priority. This variable 
sets the priority of any actions that receive it when determining task balancing. Priority 
is a number, where larger numbers mean higher priority (for example, priority 10 is a 
higher priority than 1).

Aside from this special meaning, the Priority variable acts like any other variable. Its 
value can be set just like other variables, and it can be used for all the same purposes. 

Setting Variable Values in a Workflow
The power of variables is that their value can change dynamically during execution of a 
workflow. There are several ways that a value changes:

• As the result of an action executing. For example, analysis (and many other) actions 
can publish their results as variables—such as determining the number of pixels 
that compose a letterbox. Similarly, Watch and Associate actions can publish infor-
mation about files that they detect, using variables.

• From external metadata. Specifically, the Populate action can set variables based 
upon metadata label values found in external files.
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• From a Compute action, which can create variables from other variables. For exam-
ple, Compute can add two number variables to create a new variable.

• As a pre-step to an action executing; any action can set the value of any variable 
prior to execution.

• As a pre-step to a server executing an action; any service on any server can be con-
figured to set a variable before executing an action.

Let’s experiment with two of these. First, let’s modify one Flip action in the Complex 
Transcode workflow, so that Vantage processes it with a higher priority than the other.

1. Open Workflow Designer, and duplicate the Complex Transcode Delete workflow as 
Complex Transcode Tour 7.

Figure 75. Adding Variables to an Action in a Workflow

2. Right-click the QuickTime Flip action and select Add Variables from the context 
menu to display the Add Variables dialog.

Figure 76. Add Variables Dialog

3. Click the Add Variable(s) button in the toolbar to display the Select Variables dialog.
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Figure 77. Selecting Variables Dialog

4. Scroll through the list (or press the first letter of the variable—in this case P) and 
select the Priority variable—click OK to add it to this action.

Now, the Priority variable is attached to the workflow and its default value is 5. You 
can change the value of the variable at the bottom of the panel—higher numbers 
indicate higher priority, lower numbers indicate lower priority. 

Figure 78. Add Variable Dialog

5. Enter a large number (for example, 100) and click OK to make this variable setting 
permanent.

Next, let’s configure the Watch action to set the value of the File Modification Date 
variable that you created earlier, each time it picks up a file and submits a job.

6. Open the Watch action Inspector and click Next three times to display the 
Configure Settings panel.
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Figure 79. Watch Action Inspector Dialog

7. Under Generate Variables, check the File Modified Date checkbox.

8. Use the menu to the right to select File Modification Date, the variable that you 
created in the Management Console earlier in the tour. You could also add the new 
variable right here in the dialog.

9. Click Next, then click Finish.

Now, your Watch action will assign the file modified date value of each file that it 
submits for processing to the File Modification Date variable. You’ll see how we can use 
this variable in the next tour.

Conclusion
In this tour, you learned about managing and creating variables, as well as how to set 
variable values in a workflow. In the next two tours, you’ll learn about how to use 
variables for decision-making, and how to use them to pass information between 
actions in a workflow.
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Tour 8: Decision Making in Workflows
This hands-on tour takes about 20 to 30 minutes and introduces you to the concept of 
decision-making using variables to control the logical flow of media through a 
workflow.

Action States
As actions execute, they are passed the job’s action state from the previous action. If 
the action executes, they also set the action state before passing it on. Monitor actions 
represent an exception—as an origin action, they do not inherit an action state. Actions 
set one of three action states: Success, Ignore, or Fail. Some actions (Decide, Examine, 
Compare, and Identify, for example), allow you to configure a state. However, most 
actions’ state is set automatically—by the service that executes it.

The action state is automatically passed from one action to the next so that each action 
may determine whether or not to execute, based upon the incoming state. This pattern 
repeats throughout the execution of the entire workflow.

Action states also enable decision-making—causing actions (or entire branches of the 
workflow) to not execute.

To understand how to implement and utilize action states for decision-making and 
logic, it’s important to understand their precedence, whether an action receives states 
from one or multiple incoming actions (a merge of multiple branches):

• If at least one incoming action state is Fail, regardless of other incoming states, the 
action inherits Fail and must pass it on whether the action executes or not—Fail has 
precedence over all action states. Most actions will not execute if they inherit Fail. If 
one action fails, the entire job fails.

• If there is no Fail state, but at least one Success state, then the action inherits Suc-
cess—which has precedence over Ignore. Usually, actions execute when they 
inherit Success. After execution, the action may emit Success, Fail, or Ignore.

• If all incoming states are Ignore, the action inherits Ignore. Ignore has lowest prece-
dence of the three states. An action may or may not execute when inheriting an 
Ignore, based on its state execution setting. If an action receives an Ignore state and 
does not explicitly fail, then it emits a Success state. Otherwise, it emits a Fail state 
unless it is an action which can emit Ignore, and you have configured it to do so.

Generally speaking, actions only execute if (1) none of their predecessors set the Fail 
state, and (2) at least one of the predecessors set the Success or Ignore state.

Similarly, if an action sets Ignore, the next action will also likely not execute. Most 
actions, excluding Watch and Receive (since they are origin actions), can be configured 
to perform on certain states—this allows workflows to send an email for example, if 
they detect a failure.

Note: Actions can be configured to execute upon Fail or Ignore—for example, to 
send an email when an action failure is detected. To configure an action’s execution 
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based on the incoming action state, right-click and select Perform On.
You can also set an action to execute regardless of the state: Right-click and select 
Perform On > Any.

The Decide Action
The Decide action analyzes selected incoming variables and sets the action state based 
upon the result of its analysis. Decide effectively acts as a gatekeeper to control 
branching by setting a Success, Ignore, or Fail state, which is passed on to the next 
actions, which can be set to conditionally execute, based on the incoming action state.

Because variable values are often specified at run-time, Decide enables you to perform 
an analysis and set its state at run-time as well—and thus, the workflows may behave 
differently for every job processed by the workflow. Decide is a powerful action 
allowing you to build data-driven processing into a workflow.

Note that if you want to have multiple branches in a workflow, and only execute 
specific branches for each job, then you’ll need multiple decides—one acting as a 
gatekeeper for each branch in the workflow.

Processing New Files
Let’s look at an example (start Workflow Designer if it isn’t already open).

1. Open the Complex Transcode Tour 6 workflow and duplicate it as Complex Transcode 
Tour 8. We’ll update this workflow to process only new files that are in the hot 
folder. 

Recall that the Watch action was configured to publish a variable named File Modifi-
cation Date. We’ll use this variable to process only those files created or modified 
after January 1st, 2010.

2. In the actions toolbar, open the Common category and drag a Decide action onto 
the workflow.

3. Modify the workflow so that the Decide action follows Watch, and all remaining 
actions follow the Decide action, as shown in the following figure.

Figure 80. Workflow Design Workspace, Showing Decide Action
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4. To break action connections, roll over the connector between them and click the 
red X button. In this case, delete the connectors between the Watch and both Flip 
actions. Then, reconnect the actions the way you want them to execute.

5. Open the Decide action Inspector. 

6. The Decide action is designed to perform evaluations upon variables, and set a 
state if they meet all the conditions that you specify. 

7. In the top left, click Select Variables and add the File Modification Date variable.

8. Select the > (Greater) operator and set the test value to January 1, 2010, 12:00:00 
AM. 

9. Verify that the state selection is Success—meaning that if the date is later than 
January 1st, this action will emit a Success—and that the Otherwise state is Ignore. 

10. Click Finish to close the Inspector and update the workflow.

Now—because actions by default operate only when the incoming action state is 
Success, your workflow will process files created after January 1st, but will not process 
files created on or before this date. 

Filtering Old Files
But what if you wanted to simply delete old files?

Let’s modify the workflow to delete old files. To do that, you’ll create a new branch off of 
Watch, with a Decide action and Delete action (shown in Figure 81).

Figure 81. Delete Actions in a Workflow—Example

1. Add the Decide action, connected to the Watch on a separate branch. 

2. Now, open the Decide action Inspector, and configure similarly to the previous 
one—add the File Modification Date variable, select the reverse operator <= (Less 
Than or Equal), and set the date to January 1, 2010 AM. If this is true, Success is set; if 
false, Ignore is set. 
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3. Click Finish to close the Inspector.

4. After the Decide action, add a Delete action and configure it to delete the Original 
file. It executes by default only on Success states.

This workflow now has two branches, each controlled by a Decide action—one will 
process only new files, the other will process only old files. Because of the way we 
configured the Decide actions, each file submitted will only be processed in one branch 
in this workflow.

Conclusion
In this tour, you’ve learned how to assign values to variables, to test those values, set 
action states, and use the Decide action to make run-time decisions—all features 
designed to enable you to add control to your workflows, based on information you’ve 
gleaned from your input file.
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Tour 9: Analyzing and Modifying Media Files
This hands-on tour takes about 15 minutes and introduces you to the concept of 
dynamic parameters in Vantage, and how they can be used to pass information 
between actions in a workflow.

Note: To execute workflows you create in this tour, you’ll need a license—certain 
features (the Examine action, for example) will not execute without one. For a trial 
license, contact sales@telestream.net.

Thus far, when we have configured our actions in a workflow, parameters have been set 
at a fixed value. For example, the frame size of a transcode output is 320x240. 
Obviously, by using fixed values the action performs the task the same way each 
time—creating an output file that is 320x240—every time this action executes.

How would workflow processing improve, if we could change these settings and 
parameters job-by-job, on the basis of the media being processed?

Vantage supports this capability to dynamically change the value of parameters and 
settings by binding parameters to variables. Recall that variables are metadata that is 
only known at run-time, and this metadata may be different for every single file. In 
Vantage workflows, you can configure almost any parameter, in almost any action, to 
use a variable (and its current value) as its input.

Automatically Detecting and Cropping Curtains
Let's build a real-world example. In this example, we know that some of our content has 
black on the left and right—curtains—that we want to crop. However, the amount of 
black is likely to be slightly different for every file being processed in Vantage. Instead 
of creating many workflows to deal with each situation—and manually measuring the 
black before processing, we'll build a workflow to crop the curtains automatically, as 
appropriate for each incoming media file, by combining an Examine action with a 
transcode with filters implemented.

1. Open the Complex Transcode Tour 4 workflow again, and duplicate it as Complex 
Transcode Tour 6. 

2. Open the Analysis group and add an Examine action—connect it between the 
Watch action and the QuickTime H.264/AAC Flip action. (You can place the action 
directly on the connector line and it will automatically connect to both, replacing 
the line.)

3. Open the Examine action Inspector.

4. Click the Analyzer menu and select Curtain Detection. Workflow Designer displays 
the configuration setting for this analysis tool.

5. Open Generate Variables and configure this action to publish two variables (by 
checking them): Suggested Crop Left (select the Curtained Left Pixels variable) and 
Suggested Crop Right (select Curtained Right Pixels). 

mailto:sales@telestream.net
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Note: Vantage provides many predefined variables for use in your actions. While this 
is convenient, you’re certainly free—and often will need to—create your own 
variables—they behave just like the ones Vantage provides.

6. Under Input Media File Nickname, select Original as the file to analyze. 

7. Click Save to update the action and close the Inspector.

8. Open the Inspector of the Flip action immediately after Examine.

9. Click on the Video Stream button, then click the triangle in the Video Filter button 
(2nd from the right) to display the video filters you can use. Add a Crop video filter 
to the transcode. 

10. Select the Crop filter to display its parameters at the bottom of the window.

11. On the Left value, click the green variable browser button to display a list of 
available variables, and select the Left parameter to bind to the Curtained Left Pixels 
variable.

12. Perform these steps to do the same for the Right parameter and the Curtained Right 
Pixels variable.

13. Click Save when you’re done. 

You've now created a dynamic transcode, which will automatically adjust crop settings 
based upon incoming curtain data from the curtain detection Examine action. Every 
media file that is processed will have its own, custom transcode setting appropriate for 
that file!

Take a moment to explore the rest of the transcode settings in this Inspector, and 
notice the bind buttons on many parameters. You’ll find the bind button in other 
actions as well—for example, the Web Service notification action allows you to send 
variables to external Web Services, and the Email Message action allows you to include 
variables as part of an email.

If you have curtained material, submit a job for processing and view the results.

Conclusion
In this tour, you learned how to create dynamic parameters that use variables as their 
inputs. This feature enables you to create powerful, dynamic workflows that adaptively 
change what they do based upon the metrics of the media being processed.
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Managing Workflows
Vantage Workflow Designer is the primary client program in Vantage: you use it to 
design and configure workflows to meet your media transcoding requirements. 
Workflow Designer combines a wide range of workflow design and media processing 
capabilities into a single program, enabling you to create workflows to solve a broad set 
of operational media processing problems.

Workflow Designer also allows you to activate and deactivate workflows, and allows 
you to submit media, and monitor the jobs that are created as workflows process the 
media you've submitted for processing.

Use this chapter to learn how to design, construct, and configure workflows to perform 
specific media processing tasks in your organization.

Note: For basic information on starting and stopping Workflow Designer, and 
changing domains, user names and passwords, see relevant topics in Vantage Client 
Programs Overview.

Telestream recommends that you also take the Vantage Workflow Designer Tours to help 
you become familiar with creating and configuring a wide variety of workflows.

 Starting Workflow Designer

 Understanding Workflows

 Using the Workflow Design Workspace

 Managing Workflows

 Constructing Workflows

 Configuring Actions and Specifying Action Settings

 Implementing Processing Logic in Workflows

 Managing Vantage Folders

 Troubleshooting Workflow Designer

Note: Vantage Transcode (a licensed Web-based workflow design option) can also be 
used to create simple transcoding workflows.
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Starting Workflow Designer
To start Workflow Designer, do one of the following:

• Double-click its shortcut on your desktop

• Click Start > All Programs > Telestream > Vantage > Workflow Designer.

Next, select a domain and log in.

Note: For complete information on managing Windows clients, including starting 
and stopping the program, logging into and changing domains, changing Vantage 
users and passwords, and selecting configurations, go to Windows Client Program 
Management.

Understanding Workflows
These topics provide information about workflows you’ll find helpful before starting 
the construction and configuration process.

 Workflow Basics

 Understanding the Workflow Construction and Configuration Process

Workflow Basics
A workflow in Vantage is a set of connected actions (each of which performs a specific 
task). Vantage provides over four dozen different actions, which you use as the building 
blocks of workflows. Workflows can be designed and configured to perform a 
controlled, automated media processing application. Workflow Designer organizes its 
actions by category (and incidentally, by the service which executes them), for ease of 
use. While most workflows center around the process of decoding and encoding video, 
you can also construct workflows that—while still media-centric—don’t flip media. 
Instead, they might process metadata files, or perform other tasks.

You construct and configure workflows in Workflow Designer using the Workflow 
Design workspace, by adding various types of actions (Watch action, Flip action, Copy 
action, etc.) and connecting them together to form a logical chain of successive tasks. 
Workflows are stored in the Vantage domain database, and actions in the workflow are 
executed by Vantage services.

A valid workflow must start with an origin action (for example, a Watch action, 
Workorder action or Receive action), and consist of at least two actions, which must be 
connected. Single actions that are not connected to another action do not execute—a 
single, disconnected action invalidates a workflow, which prevents it from being 
activated for use.
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Workflows may have more than one origin action, but each origin action will function 
independently of the others. Multiple origin actions permit different methods (or 
locations) in which to submit jobs to the same workflow. 

Workflows are not required to end with a terminating action—an action without an 
output pin. The only formal terminating action is the Forward action. The Forward 
action permits you to pass control directly to another workflow, which must have a 
corresponding Receive origin action. This enables you to create simpler, general 
purpose workflows, and chain them together to provide more automation.

Workflows are executed by jobs, which are created whenever a new file is discovered by 
the workflow’s Watch (or other origin) action, or when you submit a job manually 
(Submitting Files Manually in Workflow Designer).

Figure 82. Workflow Design Workspace

Generally, you construct a workflow in stages: first, conceptualize and design the 
workflow and then add the actions, connecting them together to control execution. 
Finally, you configure each action in the workflow to perform exactly the way you want. 
Now, you can test your workflow, and fine tune it as necessary. 

Once you have constructed and configured a workflow, you click Activate so it can be 
utilized. To edit it again—or just disable it—you just deactivate it. Then, click Edit, and 
when you’re done, you click Release. When you are editing a workflow, others using 
Workflow Designer can view—but not edit—the workflow. These buttons are all 
displayed at the bottom of the main window.

To activate, deactivate, edit, or release multiple workflows at one time, see Performing 
Batch Workflow Operations.
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Understanding the Workflow Construction and 
Configuration Process

Before constructing a workflow, it is helpful to have a solid understanding of its 
objective or application—what you want to accomplish with it. You’ll have to 
determine what actions (tasks or steps) are necessary to implement the objective; 
where the media (and optionally, metadata and associated files) originate; what 
transcoding and metadata processing is required; where any new copies of media, 
metadata, and associated files should be stored or deployed, etc.

You should also know in advance what external systems these jobs will interact with, 
and whether you want to register and track the output files and related metadata in a 
Vantage catalog for future use. 

Armed with these details, you can construct the workflow, and configure each action to 
correctly perform its assigned task. Of course, if you don't have all this information at 
the start, you can configure the workflow later. 

Once you have tested a workflow, you have to click Activate so it can be utilized. To edit 
it again—or just disable it—you just deactivate it. Then, click Edit, and when you’re 
done, you click Release. These buttons are all displayed at the bottom of the main 
window.
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Using the Workflow Design Workspace
This topic provides general information about using the Workflow Design workspace.

 Design Panel Overview

 Viewing and Specifying Workflow Details

 Displaying Nicknames or Variables on Actions

 Displaying Action Summary Information

 Showing and Hiding Grid Lines

 Moving the Workflow Around in the Design Space

 Centering a Workflow

 Zooming In and Out on a Workflow

 Automatically Arranging Workflow Actions

 Automatically Validating Workflows

 Action Toolbar Display Options

 Using Context Menus in the Workflows Pane

 Controlling Workflow Status
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Design Panel Overview
You use the Workflow Design workspace (click the tab or select File > Workflow Design) 
to view, construct, and configure workflows, and activate workflows for job processing. 

The figure below illustrates the layout and main components of this panel (the 
Workflows panel (left) is not part of the panel, but is shown here for clarity).

Figure 83. Workflow Designer Window, with Typical Workflow

At the top of the Workflow Design workspace is the actions toolbar, categorized in 
groups by action type. To sort them, right-click in the toolbar and select Sort by Name 
or Sort by Behavior.

Click the arrow to open each action group and display the set of actions in this group.

Zoom control

Workflows panel—displays your 
workflows by category.

Use the Workflow Design workspace to 
construct and configure workflows.

Actions toolbar—
drag actions onto the 
workspace to add to 
workflow.

Zoom control

Nicknames | 
Variables View

Workflow Designer 
has workspaces for 
each key task.
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Viewing and Specifying Workflow Details
To display or hide the selected workflow’s details panel, do one of the following:

• Select File > Workflow Details Panel 

• Click in the Workflow Design panel’s title bar

This panel displays details about the workflow: name, description, binder expiration for 
jobs processed with this workflow, and variables used in the workflow.

Vantage displays details about the selected workflow as shown in Figure 84.

Figure 84. Workflow Details Panel, Showing Workflow Title Bar

In the workflow details panel, use the following controls to manage the workflow 
information:

• Name text box—Edit the workflow name.

• Description text box—Edit an optional description for the workflow.

• Expiration controls—Modify to configure the job expiration time.

• Apply—Click Apply to save your configuration changes.

• Close—Click Close to hide the workflow details panel.

The information that displays below the Apply button is informational and cannot be 
changed. Details include creation and modification dates, and the workflow’s GUID in 
the database.

Workflow title bar
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Note: For SDK submission, you can select the GUID and then copy and paste it into 
other applications as required.

The Expected Variables list indicates which variables are being utilized by actions in this 
workflow. If an action parameter in the workflow binds to a variable, it displays here.
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Displaying Nicknames or Variables on Actions
The nicknames, metadata labels, and attachments, or variables can be displayed 
directly on all actions (in detailed action view) for quick reference.

Figure 85. Copy Action, Showing Nicknames

Nickname View—To display nicknames, select View > Action Details > Nicknames. In 
Nicknames view, each action displays a list of file nicknames and metadata labels, plus 
attachments, that are available to the action before it executes (on the left), and the 
nicknames and labels that are available downstream when the action completes (on 
the right).

Items on an action change color based upon the validity of the workflow. Highlighted 
nicknames have been utilized/created in this workflow. Nicknames displayed in red 
represent an error.

Note: Nicknames and labels that are used or affected by the action are highlighted. 
Nicknames and labels also change color indicating whether or not the workflow is 
valid.

For example, if you configure an action to utilize nickname Copy7 provided by an earlier 
action and then delete the action that created Copy7, then Copy7 displays in red on the 
now-invalid action.

Variable View—To display variables, select View > Action Details > Variables. The 
variable view displays variables that are used to bind parameters in this action. 

Input nicknames

Output nicknames
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Displaying Action Summary Information
To display action summary data, hover over the inspector button as shown in Figure 86. 

Figure 86. Action Summary Text

The summary displays the action type, description (editable), and a high level 
description of how the action is configured.

Showing and Hiding Grid Lines
To toggle the grid lines, do one of the following:

• Select View > Show Grid Lines (Control-G).

• Right-click in the workspace (but not on an action) and select Show Grid Lines to 
display horizontal and vertical grid lines.

Repeat to hide the grid lines.

Moving the Workflow Around in the Design Space
A workflow with lots of actions may be larger than your workspace when viewed at the 
zoom level you’re using. 

To move the workflow around in the workspace, click and hold anywhere on the design 
area other than directly on an action. The cursor displays as a compass: you can drag 
the workflow in the appropriate direction, and release it when done.

Inspector 
button
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Centering a Workflow
To center a workflow in your workspace, do one of the following:

• Right-click in the workspace and select Recenter Diagram (Control-R)

• Select View > Recenter Diagram to position the workflow in the middle of the work 
area.
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Zooming In and Out on a Workflow
You can zoom the design space based on the current position of actions, or you can 
select an action and center the design space on that action as you zoom.

Figure 87. Zooming In and Out to View your Workflow Better

Zooming In—To zoom in on a workflow so you can better view details, do one of these 
actions:

• Drag the zoom slider bar to the right

• Select an action, press Shift, and drag the zoom slider bar to the right to zoom in 
directly on the selected action

• Select View > Zoom In

• Repeatedly press Control-+ (the Plus key)

• Press Control and move the mouse scroll wheel up

Zooming Out—To zoom out on a workflow so you can see more actions, do one of these 
actions:

• Drag the zoom slider bar to the left

• Select an action, press Shift, and drag the zoom slider bar to the left to zoom out on 
the selected action

• Select View > Zoom Out

• Repeatedly press Control-- (the Minus key)

• Press Control and move the mouse scroll wheel down

Zoom in or out to get a better view 
of your workflow and actions.
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Automatically Arranging Workflow Actions
Use the Auto Arrange feature to assist you in visually optimizing and organizing the 
layout of actions in your workflow.

Figure 88. Enabling Auto Arrange

To disable automatic arrangement of actions while you're adjusting actions in a 
workflow, click the Auto Arrange button, located at the bottom of the Workflow Design 
workspace, to toggle it off. While Auto Arrange is off, the Auto Arrange button displays 
Auto Arrange SUSPENDED in yellow. 

Click the button again to toggle auto arrangement back into effect.

Enable or disable Auto Arrange 
to suit your construction style.
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Automatically Validating Workflows
By default, Workflow Designer monitors how actions are connected and organized in 
your workflow. Workflow Designer notifies you of problems, and prevents activation in 
the case of an improperly-organized or incorrectly configured workflow.

Disabling validation allows new actions to be connected or inserted in large workflows 
(those with about 30 or more actions) much faster. It also makes it faster to delete 
action connections.

To disable workflow validation, select Options > Auto Validate Workflow. When Auto 
Validate Workflow is disabled, validation is deferred until you open an action inspector, 
activate the workflow, or switch workflows. In addition, an orange indicator displays at 
the bottom of the tab, which you can use to re-enable validation. 

When you create a workflow with 30 actions or more, Workflow Designer displays a tip 
to inform you about the Auto Validate capability.

Action Toolbar Display Options
Use the context menu to configure the Action toolbar to suit your preferences.

Figure 89. Action Toolbar Context Menu

Toolbar Display Size—To reduce the size of the Action toolbar at the top of the design 
area, select Icons only. To display the action names (making the toolbar a bit larger), 
select Icons and Text.

Action Group Display Order—To display the action groups in alphabetic order, select 
Sort By Name. To display the action groups by functionality and (generally) in order of 
utilization in a workflow, select Sort By Behavior.
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Using Context Menus in the Workflows Pane
Right-click in the Workflows panel to display the following context menus:

In the panel title or empty space—Use the context menu to change the Vantage domain, 
or to create a new workflow category or workflow, import a workflow, or open a 
workflow you’ve used recently.

On a category—Use this context menu to create a new workflow or to rename or delete 
the category.

CAUTION: When you delete a workflow category, all workflows in this category are 
permanently removed from the database.

On a workflow—Use this context menu to change the status of the target workflow. You 
can also perform a variety of operations on the workflow (see Managing Workflows), or 
manually submit a job if the workflow is activated.
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Controlling Workflow Status
This topic describes the four workflow status commands and how and when to change 
a workflow’s status. You change the workflow status via menu items in the File menu or 
by using the buttons at the bottom of the main window.

Figure 90. Changing a Workflow’s Status

The process of editing and activating workflows is really the process of changing their 
state. You can place a workflow into an Edit, Idle, or Active state, and administrators can 
lock a workflow to limit what you can do to it. 

Each state has a unique icon (or combination), as shown below, in Table 4, Workflows 
States and Icons. 

Note: If you are an administrator, you can lock workflows either in an idle or active 
state to prevent unauthorized changes or deletion. To lock a workflow, select File > 
Lock Workflow or right-click on the workflow and select Lock. Workflow Designer 
displays a lock icon beside the workflow. Locked workflows can be activated and 
deactivated even when they are locked. However, they can’t be edited or deleted.

Edit—Select File > Edit Workflow or click the Edit button to modify the selected 
workflow. If the workflow is currently active (a Watch or Receive action is running and 
the workflow can process jobs), Vantage displays a warning dialog that it is about to 
deactivate the workflow. Click OK to continue. To edit or release multiple workflows at 
one time, see Performing Batch Workflow Operations.

The Actions toolbar displays at the top of the panel when in design mode, so that you 
can add new actions to the workflow.

When you are editing a workflow, other Workflow Designer users can view the 
workflow, but cannot edit or activate it.

Release—When you’re done editing a workflow, select File > Release Workflow or click 
the Release button. Released workflows can be activated, and can also be edited by 
others. To edit or release multiple workflows at one time, see Performing Batch Workflow 
Operations.

Activate—Select File > Activate Workflow or click the Activate button on a deactivated 
workflow to start a Watch or Receive action so that jobs can be submitted and 
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processed by this workflow. To activate or deactivate multiple workflows at one time, 
see Performing Batch Workflow Operations.

Deactivate—Select File > Deactivate Workflow or click the Deactivate button to 
deactivate the workflow. New jobs cannot be submitted and media cannot be 
processed by the workflow in this state. Existing jobs using this workflow continue 
executing to completion. To activate or deactivate multiple workflows at one time, see 
Performing Batch Workflow Operations.

The table below shows the icon or icons associated with a given workflow state, and 
provides a general description. 
Table 4. Workflows States and Icons

Workflow State Icon Description

Idle Indicates that this workflow is not being 
edited, but it is not running either. To set the 
idle state, either click the Release button (when 
editing), or click the Deactivate button (when 
the workflow is active).

Editing Indicates that the workflow is being edited by 
you. To edit a workflow, click the Edit button. 
When you are editing a workflow, it cannot 
accept media and others cannot edit it.

Active Indicates that the workflow’s origin action is 
currently executing and the workflow will 
accept media and start jobs. When a workflow 
is active, it cannot be edited.

Editing by other user Indicates that the workflow is being edited 
(and thus, owned) by a different user. 

Idle, locked by 
Administrator

The workflow has been idled by the 
Administrator user. Only the Administrator can 
unlock it. Administrator-locked workflows can 
be activated and idled, but not edited.

Active, locked by 
Administrator

The workflow has been activated by the 
Administrator user. Only the Administrator can 
unlock it. Administrator-locked workflows can 
be activated and idled, but not edited.
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Managing Workflows
This topic describes how to organize, add, rename, and delete workflows and 
categories, change their states, and perform batch operations and other workflow-
related operations.

Note: Whenever you are performing a workflow operation, you can select the 
workflow directly from the Workflow panel or select File > Recent Workflows, and 
select the workflow from the list.

 Managing Workflow Categories

 Creating a Workflow

 Renaming a Workflow

 Deleting a Workflow

 Moving Workflows Between Categories

 Duplicating a Workflow

 Exporting Workflows

 Importing Workflows

 Printing Workflows

 Performing Batch Workflow Operations

 Upgrading Actions After Upgrading to a New Version

Note: To set the status of a workflow, see Controlling Workflow Status.
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Managing Workflow Categories
Vantage provides workflow categories so that you can organize your workflows by 
categories that you design, and so that you can isolate and control workflows by 
Vantage user accounts (which is performed in the Management Console).

Note: Administrators can prevent Vantage specific users from seeing (and therefore 
using) workflows by category. To select workflow categories and specify which users 
have access to them, use the Vantage Management Console.

The following topics describe how to manage workflow categories:

 Creating a Workflow Category

 Renaming a Workflow Category

 Deleting a Workflow Category

Creating a Workflow Category
All workflows are stored in categories, and you must have at least one category created 
before you can create a workflow.

To create a new category, do the following:

1. Select File > Create New Category, or right-click in the Workflows panel (on the left 
side of the main window) away from any categories or workflows, and select Create 
New Category. Workflow Designer displays the Create New Category dialog shown 
in Figure 91.

Figure 91. Create New Category Dialog

2. Enter the name of the category you want to create, and click OK.

Workflow Designer creates the category in the database, and displays it in the list.

Renaming a Workflow Category
To change the name of a category, right-click on the category name in the Workflows 
Panel and select Rename. Workflow Designer makes the text editable so you can 
change it. Press Enter or just click away from the field when you’re done.

Deleting a Workflow Category
To delete a category, right-click on the category name in the Workflows panel and 
select Delete. Workflow Designer displays a warning that you are about to delete the 
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category and all workflows stored in this category. Click OK to delete the category and 
its workflows.

CAUTION: This action deletes all workflows in the category, and cannot be undone.



Managing Workflows
Managing Workflows

147
Creating a Workflow
To create a new workflow, select File > Create New Workflow, or right-click in the 
Workflows panel (on the left side of the main window) away from any category or 
workflow and select Create New Workflow. Workflow Designer displays the Create New 
Workflow dialog:

Figure 92. Create New Workflow Dialog

Category—Select the category for this workflow from the list at the top.

Name and Description—Enter the name of the workflow you want to create and an 
optional description in the Name and Description fields.

Expiration Policy—If checked, specifies (in hours) the time that elapses before job 
records for jobs submitted by this workflow are deleted from the database. The time for 
expiration is based on the last updated time in the job record—not the job submission 
time. Once the expiration period has elapsed, the jobs are subject to automatic 
deletion by the system.

OK | Cancel—Click OK to create the new workflow. Workflow Designer creates the 
workflow in the database, adds it to the specified category, and displays it in the 
Workflow Design workspace in edit mode—that is, deactivated and editable.

Renaming a Workflow
To change the name of a workflow, right-click on the workflow name in the Workflows 
panel and select Rename. Workflow Designer makes the text editable so you can 
change it. Press Enter or just click away from the field when you’re done.

Note: You can only rename a workflow when it is in edit mode.

Select the category where 
you want to save the 
workflow.

Enter the name of the new 
workflow and click OK.
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Deleting a Workflow
To delete a workflow, select File >Delete Workflow or right-click on the workflow name 
in the Workflows Panel and select Delete. Workflow Designer displays a warning that 
you are about to delete the workflow and all job history for this workflow. Click OK to 
delete the workflow and its history.

To delete multiple workflows at one time, see Performing Batch Workflow Operations.

CAUTION: This action deletes the workflow and its job history, and can’t be undone.

Moving Workflows Between Categories
To move a workflow from one category to another, select File > Move Workflow or 
right-click on the workflow and select Move. Workflow Designer displays a Category 
dialog. Select the category you want to move the workflow to, and click OK.

To move multiple workflows at one time, see Performing Batch Workflow Operations.

Duplicating a Workflow
To duplicate a workflow, select File > Duplicate Workflow or right-click on the workflow 
and select Duplicate. Workflow Designer displays a Category dialog. Select the 
category you want to create the new workflow in, enter a name, and click OK.

Exporting Workflows
When you export workflows, the following elements are also exported, if they are used 
in the workflow:

• Media nicknames

• attachment nicknames

• Variables

• Metadata labels

• Stores

• Output folders

Exporting a Single Workflow—To export the selected workflow, select File > Export 
Workflow or right-click on the workflow and select Export Workflow. Workflow 
Designer displays a File System dialog. Navigate and select the location where you 
want to save the workflow XML file, and click Save. Workflow Designer exports the 
workflow as an XML file.

Exporting Workflows by Category—To export all workflows in a given category, select 
File > Export Workflows by Category. Workflow Designer displays a dialog with all 
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categories listed. Check the ones you want to export, and click OK. In the File System 
dialog, navigate and select the location where you want to save the workflows. 
Optionally, create a new folder, and click OK. 

Workflow Designer creates a folder for each category in the domain, then exports each 
workflow in each category, as an XML file.
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Importing Workflows
You can import workflows which have been previously exported (as XML files) from this 
or other domains.

You can import workflows into your domain that have the same name as another 
workflow in a different category. However, if you import a workflow into a category 
which already has a workflow with the same name, Vantage assigns the imported 
workflow an incremental copy number. You can’t have two workflows of the same 
name in the same category.

Importing a workflow can create a problem with duplicate variables: The variable 
already exists, but the imported variable has a different default value. When this 
happens, the original value remains intact.

Note: You cannot import a workflow that includes any action whose service is not 
running in the domain.

To import workflows, use any of the following options:

 Importing Workflows into a Category You Select

 Importing Workflows by Category

 Importing Workflows into a Specific Category

Importing Workflows into a Category You Select
Use this method when you want to select the workflow or workflows, and then select a 
category or create a new one:

1. Select File > Import Workflows.

Workflow Designer displays a File System dialog.

2. Navigate to the directory where the previously exported workflows are located.

3. Select one or more workflows and click Open.

Workflow Designer displays the Import Workflow Category dialog.

4. Select the category or check Use Folder Name to create a new category and click 
OK.

Workflow Designer imported the selected workflows into the category.

Importing Workflows by Category
Use this method when you want to import a category or categories of workflows (for 
example, when importing all workflows you’ve exported from another domain). The 
workflows you are import should be organized into folders, with the folder name being 
the name of the category you want to use or create.

To import workflows by category, follow these steps:
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1. Select File > Import Workflows by Category.

Workflow Designer displays the File System dialog.

2. Navigate to the directory directly above the folders of exported workflows (where 
each folder is named the same as the workflow category) and click Select Folder.

Workflow Designer displays the Import Workflows by Category dialog.

3. Check each folder that you want to import the workflows from and click OK. 

If a category already exists in this domain, the workflows in that folder are 
imported. If the category does not exist, a category of the folder name will be cre-
ated, and the workflows imported.

Importing Workflows into a Specific Category
Use this method when you want to import selected workflows directly into a specific 
category:

1. Right-click on the category title in the Workflows panel, and select Import 
Workflows.

2. Navigate to the directory where the previously exported workflows are located.

3. Select one or more workflows and click Open.

Workflow Designer imports the workflow into the selected category. You can now 
rename and edit the workflow as appropriate.

Note: When importing workflows that have been created and exported from another 
domain, you may end up with duplicate variables in your domain. For example, you 
might end up with two Agency variables. This is typically not a problem. However, to 
determine which workflows use a particular variable—so that you can correct them to 
use only one definition of it—go to the Management Console > Workflow Design 
Items > Variables. Select the variable you want to search workflows for, and click the 
Find Workflows Using this Variable button in the toolbar (5th from left).

Printing Workflows
Select File > Print Workflow to print the selected workflow using the current workflow 
settings. The workflow is scaled to fit on a single page (with landscape or portrait mode 
preset based on workflow shape), unless the workflow is sufficiently large to make it 
difficult to read when scaled to a single page. Then, Workflow Designer provides you 
the option of printing across multiple pages.
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Performing Batch Workflow Operations
You can select multiple workflows and initiate the following tasks: edit/release, lock/
unlock, activate/deactivate, delete, move, or upgrade actions.

Figure 93. Performing Batch Operations on Selected Workflows

Note: This feature is enabled only by users with Administrator privileges.

To change the status of (or operate on) multiple workflows, do the following:

1. Select File > Batch Workflow Operations.

Workflow Designer displays the Batch Workflow Operations dialog, which lists 
every workflow in the domain.

2. Select one or more workflows (using shift and control keys).

3. Click one of the buttons at the bottom of the dialog to perform the task.

4. When you’re done, click Close.

Upgrading Actions After Upgrading to a New Version
During a Vantage upgrade (you are converting your domain to a newer version), some 
actions may have new or modified extensions—for example, a Flip action with an 
updated WMV encoder, or an Analyze action with a new filter. You can update the 
copies of these actions in your existing workflows as well, although you are not 
required to.

The following actions can be upgraded:

• Traffic

• Monitor

• Transcode
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• Analysis

• Multiscreen

• IPTV VOD

• Edit

Actions with only changes to the action itself (a new check box, for example) upgrade 
automatically, when new versions are installed. When you open a workflow, Workflow 
Designer, checks to make sure that the actions are current. If not, the action’s title 
displays in italic to indicate that you can upgrade it.

Figure 94. Upgrading an Action (Flip Shown as Example)

Right-click the action and select Upgrade to upgrade it. Or, right-click outside of an 
action and select Upgrade to upgrade all upgradable actions in the workflow. Then, 
open the inspector and review your configuration, making changes as appropriate, 
based on the action’s new or changed controls.

The Upgrade menu item is hidden when there are no upgrades available (for any 
actions in the workflow). The Upgrade menu item is grayed out when upgrades are 
available, but can’t be performed now (for example, when the workflow is not editable).

To upgrade multiple workflows at one time, see Performing Batch Workflow Operations.

Note: For more information on the Vantage upgrade process, see the Vantage 
Domain Management Guide.

When the title is displayed 
in italic, right-click and 
select Upgrade.
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Constructing Workflows
The following topics describe the operations you’ll use to construct workflows, which is 
done by creating actions, arranging them in order of execution, and connecting them 
together. One operation—exporting an action—can only be performed on Flip actions. 
It is used in conjunction with implementing an SDK-based Vantage application.

Note: Before you can edit a workflow (work with actions or change configuration), it 
must be deactivated and editable. When you first create a new workflow, Workflow 
Designer places it in edit mode automatically.

 Adding Actions

 Controlling the Order of Action Execution

 Deleting Actions

 Removing Line Crossings

 Re-ordering Actions

 Exporting a Flip Action
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Adding Actions
There are several ways to add actions to a workflow, depending on the situation. 

New action—to add an un-configured action, open the appropriate category in the 
Actions toolbar and drag the desired action onto the design area. When you drag an 
action from the toolbar, it must be configured before you can use the workflow.

Action template—many actions have action templates—pre-configured actions that 
make it easier to assemble workflows. Vantage provides many built-in action templates, 
and you can also make and use your own. For details, see Creating Action Templates.

To add an action template, click on the action in the action group, select an action 
template from the list, and drag it onto the workflow. The configuration of a template 
may be exactly what you need, or you may need to make minor configuration changes.

Figure 95. Opening a Category to Add an Action to your Workflow

Copy and paste—to copy and paste actions in a workflow, first right-click the action you 
want to copy and select Copy. To select multiple actions, control-click and drag across 
the desired actions in the design work space.

Next, right-click on the design area, right-click and select Paste to add the copied action 
or actions to the workflow. 

To paste an action’s configuration into an action of the same type, right-click and select 
Paste—this configures the action identically with the copied action.

Note: An origin action (Watch or Receive action) is required as the first action in a 
workflow, even if you plan to manually submit jobs to this workflow.

When you drag an action onto the design area, Vantage may automatically align it near 
where you dropped it (unless auto-arrange is off; see Automatically Arranging Workflow 
Actions). Until you connect an action to other actions, you can move it anywhere you 
want on the work area. If you bump the action you’re adding right next to an existing 
action, Workflow Designer will automatically connect the two.

Generally, it’s easiest to drag and drop actions in a pattern similar to the flow of the 
desired workflow, working from left to right (on each branch, if more than one). 
However, you can drag actions anywhere, and connect them as desired later.

Vantage will tidy up actions—moving them and organizing them by column. Once an 
action is connected, you can move it vertically (up or down) but it cannot be moved 
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from its column. Alternatively, Vantage can also attempt to optimize the workflow, 
removing as many line crossings as possible. 
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Controlling the Order of Action Execution
You connect actions together linearly in a workflow to control the order of execution 
relative to other actions in the same workflow, and to control the flow of variables and 
files from one action to another.

Job execution proceeds action by action, from left to right: When a workflow executes, 
the origin action (at the far left) executes first to start the job, and each action following 
the previous action executes next.

Connecting Your Actions Together
You connect actions together to specify order of execution, from the output pin (right-
side) of one action to the input pin (left side) of the action you want to execute next in 
the workflow. 

Actions can only be connected from an output pin (on the right side of the action) to an 
input pin (on the left side of the action), and control (file or logic) flows from output to 
input—from left to right.

Here are ways you can connect actions together:

• Click and drag a connecting line from one connector pin to another

• Click and drag an action (either from the actions toolbar or one already in the work 
area) and bump it into the edge of the action you want to connect it to—until a 
pale blue vertical line displays. (You must drag your mouse pointer up to the edge 
of the action you’re connecting to).

• Copy an action, and right-click on a connector line and select Paste to add the cop-
ied action between the two actions. Or, drag an action onto a connector line until it 
displays as a larger line. Then, drop it to connect it between the two actions.

Certain connections are not permitted:

• You cannot form recursive loops, by connecting actions to themselves or to the 
input of preceding actions in the workflow.

• You cannot connect one input (left) pin to another input pin, or one output pin 
(right) to another output pin.

Note: When you connect actions by clicking and dragging a connection, Workflow 
Designer can display a popup message that provides connection details. To enable or 
disable this feature, select Options > Show Connection Helper.

You can connect one action to multiple succeeding actions, creating logical branches, 
as shown in the figure following. When you do, none of the actions you connect can 
execute before the preceding action upon which they depend completes. 

When you have branches in a workflow, you can optionally, use a Synchronize action as 
a visual connector at either end of the branches, to better organize them. Synchronize 
does not perform any special task, it merely aids in design. In this example, three Copy 
actions execute in parallel after the Watch action completes.
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Figure 96. Multiple Actions Can Branch From a Common Action

These three Copy actions execute independently of each other, and their start time and 
completion time relative to each other is non-determinant. They execute in parallel 
from the perspective of the actions which precede and follow these actions.

You can also connect multiple actions (branches) back to a single succeeding action, as 
shown in the following figure. When you do, each of the actions you connect must 
execute before any succeeding common action can execute. 

Figure 97. Multiple Action Branches Precede a Common Action

In this example, all Copy actions must execute before the Message action executes.

You can also create multiple, independent action branches—each branch starting with 
an origin action. Each origin action creates its own job. Although this is not generally 
recommended, you may have situations where it is the best solution.
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Figure 98. Multiple Independent Branches in a Workflow

In this example, two independent sets of actions are in this workflow. As each origin 
action detects new files to process, a separate job is initiated.

Note: Although this is a legitimate workflow, it is an unusual configuration. Typically, 
two completely independent processes would be better defined as two separate 
workflows.
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Deleting Actions
To delete an action, select it and press Delete or right-click the action and select Delete. 
When you delete an action, Workflow Designer connects the preceding and 
succeeding actions, unless you uncheck Fill connections after delete in the Delete 
confirmation dialog.

To select multiple actions, control-click each additional action or control-click and drag 
across them in the design work space. When the appropriate actions are selected, 
delete them using one of the following options:

• Press Delete.

• Right-click one of the selected actions, and select Delete.

Removing Line Crossings
On occasion, you might connect two actions on rows in the layout that are more than 
one row apart—resulting in an unintended line crossing. To manually optimize the 
workflow layout, select View > Remove Line Crossings or right-click and select Remove 
Line Crossings. Workflow Designer reformats the workflow and optimizes the layout of 
the actions in a grid.

Re-ordering Actions
To re-order actions vertically, drag one or more of the actions up or down in the design 
area to the location where you want it. To select multiple actions, control-click each 
additional action or control-click and drag across them in the design work space. 
Workflow Designer adjusts the other actions to accommodate the manual placement 
of the other action.
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Configuring Actions and Specifying Action 
Settings

The following topics describe how to configure actions, and specify action settings. 
These settings are all accessed by right-clicking the action and selecting the setting 
from the context menu.

 Using the Action Inspector

 Setting Conditional Action Execution

 Adding Variables to an Action

 Binding Settings to a Variable

 Configuring an Action’s Run On Rules

 Configuring an Action’s Fallback Rules

 Specifying Retry Rule Settings

 Modifying Resource Costs for Cost-Based Task Balancing

 Generating Execution Metrics

 Changing Action Descriptions

 Creating Action Templates

 Exporting a Flip Action

Note: Not all actions provide each of these settings.
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Using the Action Inspector
Each action (except the Synchronize action) has an action Inspector—a series of one or 
more dialogs—which you use to configure the action to perform its task in a particular 
way. 

 Displaying the Inspector

 Using the Filename Pattern Editor

Displaying the Inspector
To access the action inspector, click the inspector button (round i button) in the upper 
left corner of the action, or right-click the action and select Configure. 

Figure 99. Action Inspector Button

Until an action has been configured, the inspector button displays yellow; a workflow 
cannot be activated until all actions have been configured. If you hover directly over 
the button, a summary of the action displays. 

The inspector dialog or dialogs vary, depending on the type of action, and the 
configuration choices you make. For example, to configure a Copy action, you make all 
changes in one dialog (see Figure 100).

Figure 100. Typical Action Inspector Dialog

However, the inspector for a Watch action typically consists of about 7 or more dialogs, 
depending on the file system you configure it to monitor.

Unconfigured actions display 
their inspector button in yellow 
to alert you to a problem.
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When you’re viewing an inspector of an action in a workflow that is activated or 
someone else is editing it, the term Read Only displays in the inspector’s title bar. Also, if 
you have changed the configuration, an asterisk (*) displays immediately before the 
action name: For example, *Watch.

Detailed help is available on each panel in the inspector: Click the M button to display 
its man page or click the ? button to display this topic in the Vantage User’s Guide.

Using the Filename Pattern Editor
Some action inspectors utilize a filename pattern editor, so that you can customize the 
pattern for filename generation, based on the task and the workflow requirements. The 
filename pattern editor is implemented in actions including Flip, Copy, Move, Agility 
Job Profile, and Transform.

To display the editor, click the filename pattern editor button in the inspector:

Figure 101. Filename Pattern Editor Dialog

Use the editor to implement a filename generator pattern for your workflow. To 
produce the name generator pattern you require, you can include raw text (for 
example, .xml) and any combination of the following elements: base name, variable 
(select your variable), date, and time.

Note: In Transform and Flip actions, the basename element is the base name of the 
source file without the extension (for example, myfile for a file named myfile.mpg). In 
Copy, Move, and Agility Job Profile actions, the basename is the full name of the file, 
including the extension. For example, myfile.mpg.
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Setting Conditional Action Execution
You can configure most actions to only execute when the upstream action or actions 
pass a specific action state to the downstream action. You cannot test action states and 
set conditional execution in origin actions—Watch, Receive, Dublist, and Workorder, for 
example.

 Action States

 Setting The Execution Action State

Action States
The action state describes the condition of an action during execution or after 
completion. During execution, an action may be in a variety of states (for a detailed list, 
see the jobs table’s State Column). These keywords display in the Job Status workspace.

After execution, an action’s final state is assigned: Success | Ignore | Fail. These keywords 
may be tested by actions immediately following the target action, to determine 
whether or not the action should execute. Each action’s state is passed to the next 
action or actions in the workflow.

If an action fails, the next action inherits the Fail action state and (in most cases) will not 
execute—unless its Perform On state is set to Fail.

Some actions can be configured to set the Ignore state. The next action inherits the 
Ignore state and will likely not execute (unless it has been explicitly set to execute on 
Fail). Most actions, such as Message, can be configured to perform on certain states—
this allows workflows to send an email if they detect a failure.

If an action receives states from two incoming actions (such as a merge of two 
branches), then states are given the following priority:

• If at least one incoming state is Fail, regardless of other incoming states, the action 
will inherit the Fail state—Fail has precedence over all action states.

• If there is no Fail state, but at least one Success state, then the action will inherit the 
Success state—Success has precedence over Ignore states.

• Only if all incoming states are Ignore, will the action will inherit the Ignore state. 

Ignore has lowest precedence of the three states.

Setting The Execution Action State
To set the conditions (states) under which an action will execute, right-click and select 
Perform On > Success | Failure | Ignore | Any. The Any option is not a state—it is a 
selection to indicate this action should execute regardless of the state passed to it.

By default, actions only execute when the action state (as set by upstream actions) is 
Success. Success means that the upstream actions have completed normally and the 
incoming state is Success. 
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The Fail state indicates that at least one action has executed and failed to complete 
normally or completed normally, but was explicitly set to Fail. If you have an action 
configured to execute on Fail, it only executes if at least one upstream action has 
reported a failure.

You can also configure an action to execute on the Ignore state by selecting Ignore.
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Adding Variables to an Action
Sometimes, you need to provide information to one or more actions (or directly to a 
job, when you’re manually submitting it) that is independent of the functionality of the 
actions. To do so, you can manually add a variable and set a static value. These variables 
can be used by downstream actions or by other Vantage components such as services, 
to execute the workflow appropriately.

For example, you can add a variable to set the execution priority of one workflow 
branch to high, and another to low.

 Understanding Variables

 Adding Variables

 Creating New Variables

Understanding Variables
In Vantage, a variable is a container for temporary job information—a symbolic name 
(or identifier) which contains some known or unknown quantity or element of 
information; a value. You use the variable name to reference the current value; this 
separation of name and content allows the name to be used independently of the 
exact information it represents. The variable can be bound to a value during run time, 
and the value of the variable may change during the course of workflow execution.

Each variable has a name (such as Number of Audio Channels), a type (such as Integer 
Number), and a default value, all of which are defined when the variable is created. You 
can change variable values in a variety of ways. For example, a variable value can be 
changed in actions that are designed to use variables, such as the Analysis, Populate, 
Watch and Associate actions. Variable values can also be changed when adding a 
variable to an action in a workflow or when manually submitting a job.

Variables are passed from action to action according to the action connections. When 
an action creates a given variable, all downstream actions that use variables can access 
the variable and its current value.

Variables are used by some actions to control their functionality and execution—and 
thus, implement workflow logic. (Variables are also used by Vantage services as defined 
by the Vantage domain administrator.)

Many parameters in Vantage can be bound to a variable, allowing the workflow to 
dynamically update parameters on a job-by-job basis. For details on binding 
parameters to variables, see Binding Settings to a Variable.

When a variable is set to a specific value, that variable value is only available to actions 
within the same branch as the one that set the variable and actions in downstream 
branches.
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Note: If two branches merge to a common action, and both have set a value for the 
same variable, then the last upstream action to finish executing will set the variable for 
the common action. The last action to finish can not be known from job to job.

Adding Variables
To manually add a variable to an action, right-click and select Add Variables. Workflow 
Designer displays the Add Variables window.

Figure 102. Add Variables Window

In the Add Variables window, you can add variables to the action prior to execution. 
Values set in this window are available to this action, and all downstream actions 
(including actions in connected workflows).

Click the Add Variables button in the toolbar to display a list of variables.

Figure 103. Select Variables Window

Select the variable to add and click OK.

Add Variable & Delete Variable toolbar buttons.
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Note: Click Create New Variable to create a variable if you need a new one. For details, 
see Creating New Variables.

Next, with the variable selected, modify its default static value if necessary, and click OK 
to add it to the variable for use in the workflow.

Creating New Variables
Vantage includes some default variables, and you can create variables directly in 
Workflow Designer. Vantage domain administrators can also create variables using the 
Vantage Management Console (Workflow Design Items > Variables).

On variable selection windows in Workflow Designer, click the Create New Variable 
button. Workflow Designer displays the Create New Variable dialog (Figure 104).

Figure 104. Create New Variables Dialog

Configure the new variable as follows:

1. Enter an appropriate name for the variable in the Name text box.

2. Enter a description in the Description text box. (This is optional.) 

3. Select a variable type from the Value Type dropdown list.

4. Enter a value for this variable in the Default Value text box.

5. Click OK to save the variable.
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Binding Settings to a Variable
Most settings in an action are configured with a static value—one that does not 
change from job to job. For example, you configure a Watch action to poll a specific 
directory—and job after job, this directory never changes—that is, it is a static value.

However, many actions also have settings whose values change from job to job—and 
thus, must be assigned a value when the job runs—typically, based on the media being 
processed. 

For example, you may have a Message action that generates an email—and the To 
address in the email should be the address of the associate producer of the show, 
which is provided in metadata, and assigned to a variable prior to the Message action. 
Or, a variable may be assigned a value by an Analysis action to determine how many 
lines of black are at the top of a video frame; a crop filter later in the workflow can bind 
to that variable, ensuring that every crop in every job is appropriate to the workflow.

To support unique values for a job, Vantage enables many settings to be bound to a 
variable, allowing the workflow to dynamically update the value on a job-by-job basis.

Settings that can be bound to a variable display a green variable browser button.

Figure 105. Message Action Inspector—Bindable Parameters

Click the variable browser button to display the Select Variable dialog (Figure 106).

Parameters that can be bound to a 
variable display a green variable browser 
button.
Click it to select a variable, which will 
supply its current value as the value for 
the parameter.
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Figure 106. Select Variable Dialog

The list of variables includes those variables that are present in the domain, and are of 
the correct type for the parameter. For example, the subject line only accepts text 
variables; the email address can only accept email address variables.

Select the variable to bind to this parameter, and click OK.

Note: Click Create New Variable to create a variable if you need a new one. For details, 
see Creating New Variables.

Figure 107. Message Action Inspector with a Bound Parameter

Now, the setting displays with a green border, indicating its value is derived directly 
from the current value of a variable, not the manually entered value.

Settings bound to a variable display a 
green border.
Click the green variable browser button 
again to unbind a variable, or change 
which variable you want to use.
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Configuring an Action’s Run On Rules
Most actions (except the common actions—Compute, Construct, Decide, Forward, 
Receive, and Synchronize) have a set of rules called run on rules, which can be 
configured to determine if a given Vantage service has the features or characteristics 
which enable it to execute a given action. Unlike qualification rules, which are service-
centric, run on rules are action-centric.

Note: In addition to setting up specific rules on an action, Vantage domain 
administrators can set up service-based qualification rules using the Vantage 
Management Console.

Run on rules provide you explicit control over which service can execute a particular 
action in a given workflow.

As you design a workflow, you can indicate that you need to have a particular action 
execute on a particular service (or set of services). To implement this, you define a True/
False variable and provide it a value of TRUE to indicate that this instance of the service 
can satisfy the requirement. Next, you assign this variable to the service or services that 
qualify, in the Vantage Management Console > Services > Variables.

For example, you are designing an HD transcoding workflow, and the Flip action must 
be executed by a Transcode Service deemed HD-capable—that is, it is running on a 
server with a processor set capable of adequately handling HD media transcoding. For 
this example, it’s a server named Vantage_HD_Transcoder.

In Workflow Designer, open your HD workflow, right-click on your Flip action and select 
Run On Rules to display the Run On Rules dialog.

Figure 108. Creating Run On Rules for an Action

Click the Add Run On Rules button in the toolbar at the top, and create an HD_Capable 
variable and set its value to TRUE, as shown below. 
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Figure 109. Creating a Variable for use with Run On Rules

Next, click OK to create this variable, and click OK to save the Run On Rule.

In the Vantage Management Console, select Services > Variables and add the 
HD_Capable variable to the Transcode Service running on the Vantage_HD_Transoder 
server.

Note: When a variable is added to a service, that variable is added to the job if the 
service executes it. Be careful about which variables you use for run on rules, and 
which are used for decision-making; generally you will want to use different variables.
Run on rules only analyze variables explicitly set by a service. They do not analyze 
variables already set in a job. This ensures that run on rules only execute actions on a 
service that explicitly sets them.

Now, return to Workflow Designer and open your HD workflow again. Right-click on 
your Transcode action and select Run On Rules to display the Run On Rules dialog.

Click Check Services to verify that the Vantage_HD_Transcoder now responds correctly 
to queries about being HD-capable.

Figure 110. Check Services Dialog
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Configuring an Action’s Fallback Rules
Actions that have been configured to utilize the Lightspeed Server (for example, by 
selecting the Lightspeed Accelerated VPL), by default, will use the Legacy Telestream 
VPL when:

• No services are available to run the Lightspeed Accelerated VPL. 

• The queue length of jobs waiting for Lightspeed Servers is larger than a configu-
rable number. This setting is available only to customers who have purchased the 
Advanced Task Scheduling option.

To enable Lightspeed fallback rules, right-click on the action and select Fallback Rules 
to display the Fallback Rules dialog.

Check the Fallback if Queue Greater than option, and select the maximum number of 
actions already in queue you will accept, before running this action on a capable 
service running on a standard Vantage server. The rule will be activated if every capable 
service has a queue length greater than the number you have selected.
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Specifying Retry Rule Settings
Certain actions (typically, those that deal with files or other network-accessible 
computer systems) which may fail due to file system latency or network delays, can be 
configured to execute multiple times in an effort to overcome the problem, according 
to user-specified parameters, called retry rules.

Overview
Default retry rules are set for each action type by the Vantage domain administrator. For 
example, the Vantage domain administrator might specify a default retry rule (in the 
Vantage Management Console) so that all Flip actions retry one time after five minutes.

The default retry rules can be modified for an action in Workflow Designer, and the 
action retry rules override the default rules. For example, you might specify that a 
specific Copy action in a workflow should retry three times: once after five minutes (in 
case of a SAN blip), once after four hours (in case of Internet congestion), and up to a 
certain number of times after two days (in case of complete Internet failure). 

It is important to keep in mind that individual action retry rules specified in Workflow 
Designer override the default retry rules specified in the Vantage Management 
Console. If an action does not have override retry rules, the default retry rule for the 
action type is used instead. If there are no override rules specified for an action, and no 
default rules for its action type, then a failed action is not retried.

Each time an action is executed, it is handled according to task balancing rules, and it 
may be assigned to a different service for execution.

If you restart a job that is in the Stopped by User or Failed state, the actions execute as a 
first-time execution. For example, you have an action with retry after 4 hours. Restarting 
this job results in immediate execution, because the action is executing on its first try.

Configuration Details
Right-click on an action and select Retry Settings to view or configure retry rules. 
Workflow Designer displays the Automated Retry Settings dialog.

Table 5. Actions with Retry Rules

Archive Delete Message

Associate Deploy Move

Compare Examine Multiscreen Flip

Compose Faspex Delivery IPTV Flip

Conform Flip Notify

Copy Gather Process MMF

Chronicle Identify
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Figure 111. Automated Retry Settings Dialog

The dialog in Figure 111 supports the following options:

• No Retry—Override any default retry settings, and not retry execution on failure. 

• Default—Utilize the default retry settings specified by the Vantage domain admin-
istrator. 

• Custom Limited Retry—Configure up to three retry settings. 

• Custom Recurring Retry—Configure the time and priority (which is optional) 
between retries, and optionally, stop after a certain number of iterations.
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Modifying Resource Costs for Cost-Based Task Balancing
Vantage supports two types of task balancing: cost-based and session-based. Cost-
based task balancing is available with the Advanced Task Scheduling license and is 
disabled by default. To determine if cost-based task balancing is enabled, contact your 
Vantage domain administrator.

Note: When cost-based task balancing is disabled (the default setting), Vantage uses 
session-based task balancing and resource cost settings are ignored. For information 
on configuring task balancing, see the Vantage Domain Management Guide.

When cost-based task balancing is enabled, each action has a default cost and a 
custom cost. The default cost is defined by the Vantage domain administrator. The 
custom cost is defined by the workflow designer in the workflow. When you define a 
custom cost, that cost applies to action processing instead of the default value.

Cost-based task balancing provides a way to control how action processing is 
distributed among multiple services. During workflow processing, the action cost 
defines the relative resources that must be available on a Vantage service to process 
the action. If there are multiple services that can process an action, and if one service 
does not currently have the resources to process that action, another service with 
available resources will process the action.

The resource cost is an integer value that has an ordinal relationship to the other action 
costs and to a target resource usage value defined by the domain administrator. A 
higher resource cost in an action means that fewer actions can run simultaneously on 
the same service. A lower resource cost allows more actions to run simultaneously. The 
actual values you enter for a workflow action must conform to the service settings 
defined by the Vantage domain administrator. To determine the range of resource cost 
settings available to you, consult with your Vantage domain administrator.

To view or set a resource cost on a given action, do the following:

1. Right-click on the action and select Resource Cost.

Workflow Designer displays the Resource Cost Settings dialog shown in Figure 112.

Figure 112. Resource Cost Settings Dialog

2. Select Default, or select Custom and enter an integer value.



Managing Workflows
Configuring Actions and Specifying Action Settings

177
3. Click OK to save.
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Generating Execution Metrics
For most actions, you can collect execution metrics, and assign them to variables for 
processing downstream. For example, you can generate start and end times, total 
elapsed time, and final action state, among other values. You can use these metrics to 
enhance your ability to fine tune your system, and improve throughput, or identify 
bottlenecks. 

To generate execution metrics for a given task, right-click the task and select Execution 
Metrics. Vantage displays the Execution Metrics dialog.

Figure 113. Execution Metrics Dialog

Check the metrics you want to collect, and assign each one to a variable. Then, 
downstream you can access these variables for analysis.

Changing Action Descriptions
You can change an action description by directly clicking on the description text field at 
the bottom of the action, or right-click and select Description. Enter the new text and 
then click away. This text is displayed only when Detailed Action View is enabled in the 
Workflow Design workspace.



Managing Workflows
Configuring Actions and Specifying Action Settings

179
 Creating Action Templates
Vantage provides many actions with a variety of action templates, which you can use 
(along with your own) to make workflow construction easier. 

To make your own action template, follow these steps.

1. Add an action to a workflow. 

2. Configure it as appropriate.

3. Edit the description (at the bottom of the action), which is used to name the action 
template.

4. Right-click and select Create Template to save the selected action as a template.

Figure 114. Create Template Dialog

5. Enter a description (this is optional).

6. Add or select a group, or select None and click OK.

Grouping allows you to organize your action templates. If you want more than one 
level of grouping, separate each group with a vertical bar (|)—for example, Broadcast 
Servers | Grass Valley. The description of the action displays as the name of the action 
template.

The action template is added to the template list, and can be selected by clicking on 
the action.
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Exporting a Flip Action
When you are creating a custom Vantage application using the Vantage SDK, you can 
create and configure a Flip action and then export it as an XML file, for use as a template 
in your application.

To export a Flip action, first create and configure the action to meet your requirements. 
Next, right-click the Flip action and select Export. Workflow Designer displays a File 
Save dialog, where you can navigate and save the XML file with a name you choose. 

You can use this XML file (which contains a definition of your Flip action) in your 
Vantage SDK-based application. You can also edit the XML file separately from 
Workflow Designer, of course. 

Note: Only Flip actions can be exported using this feature.
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Implementing Processing Logic in Workflows
Many workflows consist of several actions connected in a single line—thus, each action 
is executed, in turn, for the entire workflow.

However, you may want to create branching workflows that are intelligent and flexible, 
so that they can process media files with differing output requirements automatically. 
These workflows can collect information about the media or the file itself at runtime, 
and store that information in variables. Then, you can add a Decide action to examine 
the values in the variable or variables, and pass control to one branch or the other, 
based on the value.

Generally, controlling the flow of media through a workflow is achieved by three 
things: adding variables and assigning them values, using a Decide action to evaluate 
variables, then setting an action state for each branch that follows the Decide action, so 
that only the appropriate branch executes for each job.

Branching workflows are scalable; you can add as many decide actions and branches as 
you need, to further refine your processing choices.

Figure 115. Use Decide Actions to Implement Execution Branching Logic

In this example, some metrics about the input file are being examined by the Watch 
action—file modification date, for example. The Decide action determines if the date is 
prior to or later than a given date, and sets Success or Fail, based on the answer. 

The top branch’s Flip action only executes on Success (processing those files whose 
modification date is prior to the test date), and the lower branch’s Flip action only 
executes on Fail (processing those files whose modification date is later than the test 
date).
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Managing Vantage Folders
Vantage folders are aliases or alternate names for actual file system folders. You create 
(and name) Vantage folders to identify specific paths you use frequently. Vantage 
folders simplify directory referencing by allowing you to specify a short, descriptive 
folder name instead of a long, complex path and file name. Vantage folders also allow 
you to update a path or credentials once, and automatically update all actions using 
that Vantage folder.

For example, you might have a folder on a given server for HD MPEG2 content: 
\\voyager\SunupCampaign\Darwin\WaitingApproval\HDMPEG2. You can create a 
Vantage folder in the Vantage folder address book for this path, and name it 
SunupHDWaitingApproval. If you need to change the path or any password associated 
with the address later, you can simply change it in the address book and all actions will 
automatically update.

Telestream recommends using UNC paths instead of drive letter paths, and it is 
required in Vantage arrays. For a detailed discussion, see Understanding Paths for 
Vantage Storage.

Now when you create a workflow that generates media you want saved in this folder 
path, you simply select SunupHDWaitingApproval in the Flip action’s inspector.

You can create Vantage folders in both the Vantage Management Console and in 
Workflow Designer.

To manage Vantage folders in Workflow Designer, do the following:

1. Click on the browse  button to the right of any location field that accepts Vantage 
folders.

For example, open a Flip action and select Vantage Store/Folder to see a Browse 
button. Vantage displays the Vantage Folder Address Book (see Figure 116).
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Figure 116. Vantage Folder Address Book

2. Click the Add Folder toolbar button (the new folder button at far left).

Figure 117. Add New Folder Dialog

3. Name—Enter the Vantage folder name.

4. Location—Click Modify to display the Folder Location Editor.

5. Select a file system and click Next.

6. Click Browse to navigate and select the directory that this Vantage folder address 
should reference. Or, enter the fully-qualified path manually, preferably in UNC 
form (be sure to only use drive letters when the domain is a single machine.). When 
manually entering a fully-qualified path, the text displays in red if it does not 
conform to the proper convention for the supported file system.
For a detailed discussion, see Understanding Paths for Vantage Storage.

7. Click Finish to close the Folder Location Editor dialog. (You may have to click OK on 
the local folder warning dialog.)

8. Click OK to add this new Vantage folder address to the domain and close the Add 
New Folder dialog.
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9. Collision Resolution—Select Create Unique Name | Overwrite | Set Failure State to 
specify what Workflow Designer should do when a file of the same name already 
exists in this location.

– Create Unique Name—Workflow Designer adds a suffix to the filename, making it 
unique, then saves the file in the location.

– OverWrite—Workflow Designer deletes the current file and saves the new file in 
the location.

– Set Failure State —Workflow Designer does not save the file; it sets the action 
state to Fail so that downstream actions may detect the error and perform a 
specified task under this condition.

10. Click Select to close the dialog and use the currently-selected folder address, then 
press OK to save changes. Click Close to simply close the Vantage Folder Address 
Book dialog with changes.
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Troubleshooting Workflow Designer
When opening Workflow Designer for the first time, depending on the design of your 
network and the location of your workstation and Vantage server, the Domain login 
dialog may not display the domain. If this is the case, you can log in by using the name 
or IP address of the server.
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Vantage Actions
This chapter describes each of the action groups and their actions. Workflow Designer 
groups actions according to the service that executes them, with one exception. The 
actions in the Common group can be executed by all Vantage services.

Some actions require a specific license, and are noted appropriately.

Note: For detailed, implementation-oriented help, open the Inspector on any action 
and click the M icon to display its man page.

 Agility Actions
 Analysis Actions
 Faspex Delivery Action
 Aurora Action
 Baton Action
 Catalog Actions
 Common Actions
 Communicate Actions
 Edit (Post Producer) Actions
 FileCatalyst Action
 IPTV Flip Action
 MediaMate Action
 Metadata Actions
 Monitor Actions
 Multiscreen Flip Action
 Nexidia Action
 Pulsar Action
 Signiant Delivery Action
 Staging Actions
 Traffic Actions
 Transcode Flip Action
 Transport Actions
 VidChecker Action



Vantage Actions
Agility Actions

188
Agility Actions
Use Agility actions in workflows where you have an Agility ECS system and you want to 
submit jobs to it for processing. You can use Agility actions to create workflows, submit 
and monitor jobs, process MMF files, and control jobs during execution in Agility.

Note: Before you can use Agility actions, the Agility ECS must be identified in the 
Management Console: Settings & Options > Agility ECS, and you must have an Agility 
ECS Connector license installed.

Agility actions are executed by the Agility Service:

 Job Profile Action

 Job XML Action

 Process MMF Action

Job Profile Action
Use the Agility Job Profile action to obtain and display a list of Agility profiles from an 
Agility ECS (which must be configured in the Vantage Management Console and 
available at design time), from which you can select and configure, to submit jobs.

Job XML Action
Use the Job XML action to submit the job described in the specified XML to the Agility 
system for processing. This is an alternative to Vantage-based configuration using the 
Job Profile action, and is intended for use primarily by Agility users with SDK 
implementations to generate XML-based job profiles for Agility execution.

Process MMF Action
Use the Process MMF action to process an attached MMF file in Agility, and generate 
variables from it.
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Analysis Actions
Use these actions (executed by the Telestream Transcode & Analysis Engine on behalf 
of the Analysis Service) in workflows when you want to perform measurements on 
media files, compare media files, or identify the characteristics of media files, and 
publish the results as variables or metadata labels, or set the state of the workflow 
based on the results.

You can publish analysis results in a metadata label within the binder, or you can 
publish results as variables so that they can be used for decision-making, or to feed 
parameters in other actions. In some cases, you can also set the action state of the 
action based on the results of the measurement.

 Analyze Action

 Compare Action

 Examine Action

 Identify Action

 MediaInfo Action

 QC Action

 Report Action

Analyze Action
Use the Analyze action (which is executed by the Analysis Service), to perform analysis 
on media using a variety of analysis tools, and variables for use downstream, with the 
result of the analysis.

Compare Action
Use the Compare action to examine two media files and determine their differences.

DPP Validate Action
Use the DPP Validate action to confirm compliance of a DPP metadata XML file. If the 
XML file passes validation, TRUE is generated; otherwise FALSE is generated. You can 
test the results of the action downstream to change the workflow’s actions based on 
the validation results. Optionally, you can also generate a report.

Examine Action
Use the Examine action to analyze the video and audio of a media file, by selecting a 
given analyzer (black detection, macroblocking analysis, slate detection, etc.).
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Identify Action
Use the Identify action to examine and identify certain media characteristics, or extract 
the properties of a media or attachment file (for example, file name, extension, size, or 
path) or to generate an MD5 hash of a media or attachment file, which you can use to 
compare two files downstream, or in other workflows.

You can also extract metadata (such as Author or Title) from media files.

In addition, you can extract a comprehensive set of properties from media files (for 
example, frame size, frame rate, codec, bitrate, number of audio channels, etc.). 

Extracted values are assigned to variables (which you create in Vantage Management 
Console or directly in Workflow Designer), for use later in a workflow. You can also set 
the workflow state as a result of execution conditions.

MediaInfo Action
Use the MediaInfo action to perform 2 tasks, based on its analysis of the media file and 
its streams: Create variables from properties via the MediaInfo API, and create a report 
of the properties and their values.

In each category, you can produce variables of selected metrics with the results the 
analysis.

QC Action
Use the QC action to perform analysis on media using a variety of analysis tools. The QC 
action is similar to the Analyze action, with additional features in addition to generating 
variables for each property.

In each tool, you can test various properties for True/False, min/max values, allowable 
values, or ranges, and then set pass/fail and other variables based on the results of the 
analysis. You can use these variables in downstream actions.

Option, you can also produce a report on the analysis.

Report Action
Use the Report action to generate a report file which contains a list of variables and 
their values.
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Faspex Delivery Action
Aspera servers and applications enable secure, high-speed batch file transfers of 
various file types, including media and metadata files. The Aspera action is an optional, 
licensed feature in Vantage; it is used to deliver media or other files to Aspera systems.

The Faspex Delivery action is used to deliver media or other files to Aspera Faspex drop 
boxes and users.
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Aurora Action
The Aurora action is an optional, licensed feature in Vantage. It uses the Aurora Service 
to utilize and interact with various QC tests provided by the Digimetrics Aurora 
software. The tests provide the ability to determine whether a particular input media 
(specified by nickname) either passes or fails a particular QC check. Each test also 
generates a report file that may be utilized during later stages of the workflow.
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Baton Action
The Baton action is an optional, licensed feature in Vantage. It uses the Baton Service to 
enable Vantage workflows to utilize and interact with various QC tests provided by the 
Baton software. The tests provide the ability to determine whether a particular input 
media (specified by nickname) either passes or fails a particular QC check. Each test also 
generates a report file that may be utilized during later stages of the workflow.
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Catalog Actions
Catalog actions enable you to query a Vantage catalog to determine if a binder exists, 
and also to register a binder in a catalog. These actions executed by the Catalog 
Service.

 Exist Action

 Register Action

Exist Action
Use the Exist action to determine if a binder of the same name already exists, thus 
indicating that a job has already run on the same media file.

Register Action
The Register action adds the workflow binder generated by each job to a Vantage 
catalog. This allows Vantage to preserve the binder—and all files referenced by it—
even after a job expires (which by default, deletes the associated binder). This is also 
how binders become accessible to operators in Vantage Workflow Portal. For more 
information about configuring Workflow Portal, see Using Workflow Portal.
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Common Actions
Common actions are typically light-weight, short duration, utilitarian actions, and do 
not have a dedicated Vantage service to execute them. Instead, these actions are 
implemented in every Vantage service, so that any service available can execute them 
efficiently and instantaneously.

 Compute Action

 Construct Action

 Decide Action

 Forward Action

 Receive Action

 Synchronize Action

Compute Action
A Compute action uses variables to set other variables. For example, you can use 
Compute to add two numbers and assign the result to the selected variable. Compute 
can perform mathematical operations such as addition, subtraction, division and 
multiplication. It can also convert variables between types (such as converting a time 
code to a string), string manipulation, such as appending strings together into an 
output variable, and comparison functions.

Construct Action
A Construct action enables you to construct complex strings, paths, and math 
expressions from literals, variables, and tokens, for use in downstream actions.

Decide Action
A Decide action sets the action state based upon variables. It is commonly used to 
determine whether or not a branch in a workflow should execute (it sets the Success 
state) or not (it sets the Ignore state).

Figure 118. Decide Actions Enable You to Branch Media Processing
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For example, if one branch is for HD, it will start with a Decide action that will set the 
state to Success for HD content, ignore otherwise; if another branch is for everything 
else, it will start with a Decide action that performs the opposite behavior.

Forward Action
A Forward action starts a new job for the target workflow, delivering a binder and all 
current variables from the originating. A Forward action can only be added to the end 
of a workflow, and requires that the target workflow has a Receive action as its first 
action.

The Forward action is the only terminating action in Vantage—it does not have a 
connecting pin on the right side. Thus, once you add a Forward action to a workflow (or 
branch in a workflow), you cannot add any more actions, because control has passed to 
another workflow with a Receive action as its origin action.

Typically, workflows are created with a Receive action when they are intended for 
execution by another workflow that immediately precedes this one. This ability to chain 
workflows enables you to create run-time customizable workflows consisting of smaller 
workflow building blocks.

Receive Action
The Receive action is similar to a Watch action in that it starts jobs. Unlike a Watch 
action, it allows you to ingest a file from an external source and submit it for processing.

Methods you can use to submit jobs to a Receive-based workflow:

• Another workflow

• An SDK-based application

• Workflow Portal

• Drag and drop a file on it. 

The ability to chain workflows enables you to create run-time, customizable workflows 
consisting of smaller workflow building blocks. When you chain workflows, you can 
also pass binders and variables between them.

Other ways to submit media to a Receive-based workflow include manually submission 
with Workflow Portal (see Using Workflow Portal), or with an application built on the 
Vantage SDK.

Note: An origin action is required as the first action in a workflow, even if you plan to 
only manually submit jobs to this workflow.
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Synchronize Action
The Synchronize action is used in workflows where multiple actions connect to 
multiple subsequent actions. Synchronize provides a common connection point, where 
all upstream actions need to be connected to all downstream actions.
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Communicate Actions
Communicate actions are used to communicate with external systems. They are 
executed by the Communicate Service.

 Message Action

 Notify Action

Message Action
A Message action enables you to generate and transmit an electronic message—an 
email, for example. You must configure Vantage to use an SMTP server before email can 
be utilized; this can be done in the Vantage Management Console.

Notify Action
A Notify action transfers job information to external systems via Web Services or other 
methods to transfer data. The job information may also be transferred via an XML file or 
files of other formats. You can also use the Notify action to invoke a command shell.

The Notify action is extensible, and can communicate with a wide variety of systems or 
produce various files, including:

– BXF Files

– Dolby DP600

– Dump XML Files

– External Command Shell

– Avid Interplay

– Civolution NexGuard

– SeaChange MVL

– Text/CSV Files

– General Purpose Web Services Notification

– Automation System Files
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Edit (Post Producer) Actions
Edit actions are components of Vantage Post Producer, an optional, licensed feature. 
These actions are executed by the Edit Service, and may run on a Vantage Lightspeed 
Server or a standard Vantage server. 

 Chronicle Action

 Colocate Action

 Compose Action

 Conform Action

Chronicle Action
The Chronicle action converts a post-rendered Composition XML file into formats for 
use in other systems—ad-insertion systems, for example.

Colocate Action
The Colocate action converts a Composition XML file with non-file-based URLs (for 
example, Amazon S3) and localizes the media and produces a modified CML file with 
the URLs converted to the localized file paths.

Compose Action
The Compose action converts various media descriptor file formats: Anystream AN2, 
Final Cut Interchange XML, Simplified Avid AAF, QuickTime Reference, Adobe FC7XML, 
and Telestream TSEDL) into a Composition XML file so that it can be used by the 
Conform action to compose media.

Conform Action
The Conform action assembles and optionally transcodes multiple video and still 
image files into a single output file, applying filters as specified by you. The input files 
and related instructions for the output file are all defined in a Composition XML file.



Vantage Actions
FileCatalyst Action

200
FileCatalyst Action
The FileCatalyst action is an optional, licensed feature, which enables Vantage 
workflows to access and deliver files to FileCatalyst servers via integrated FileCatalyst 
client software.
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IPTV Flip Action
The IPTV Flip action (in the IPTV Flip category) is included with the Cable / IPTV version 
of TrafficManager. IPTV transcoding is designed for generating MPEG2 Transport 
Stream files and meeting multiplexing requirements. The IPTV Flip action is executed 
by the IPTV VOD Service, which can optionally run on a Lightspeed Server for GPU-
accelerated x264/x265 encoding and video processing. 

The IPTV Flip action and IPTV VOD Service supports the features required to handle 
varying IPTV, set-top box and cable encoding requirements, and ancillary metadata 
specific to cable ad splicing and cable/IPTV set-top box environments. Transcoding is 
performed by the Telestream Media Transcode and Analysis Engine on behalf of 
Vantage.
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MediaMate Action
The MediaMate action enables you to implement screen subtitling. This is an optional, 
licensed feature. The MediaMate action is used to provide screen subtitling, by utilizing 
various subtitling systems from Screen.

Note: The MediaMate action is only supported on the 64-bit version of Windows 
Server 2008.



Vantage Actions
Metadata Actions

203
Metadata Actions
Metadata actions are an optional, licensed feature available in certain Vantage editions. 
They are used to perform conversions between attachment files, metadata labels, and 
variables. These actions executed by the Metadata Service.

 Populate Action

 Transform Action

Populate Action
Populate actions transform data between variables, attachments, and metadata labels. 
During ingest, metadata labels can be added to ingested media and generally include 
trim information, audio levels, file properties, and commercial metadata. The metadata 
labels can then be reviewed and modified by operators using Workflow Portal. At any 
stage of a workflow, Vantage can extract information from labels using the Populate 
action, allowing Vantage for example to use trim points during a transcode, or audio 
level information when creating the final broadcast asset.

Transform Action
A Transform action transforms data between XML files (attachments) and labels. XSL 
style sheets are used to perform these transformations.

Note: The Transform action is available in Metadata and Transcode Connect licenses. 
You can only use style sheets that have been imported into the database; you cannot 
reference XSL files directly. The Vantage administrator manages your XSL style sheets 
using the Vantage Management Console (Vantage Domain > Workflow Design Items 
> Style Sheets).
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Monitor Actions
Monitor actions are used to identify and ingest files to be processed by a workflow, and 
in the case of the Watch action, start jobs for this workflow. They are executed by the 
Monitor Service.

 Watch Action

 Associate Action

 Workorder Action

Watch Action
A Watch action is an origin action, which uses the Monitor Service to continually (and at 
regular periods) poll a target location (a directory, for example) on a device or file 
system (FTP, network folder, etc.) to discover new files.

The Watch action submits a job to the workflow which it is part of, when:

• A new file is discovered in the target folder

• You manually submit a file to the workflow

• You drag and drop a file on the Watch action in the workflow.

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

Associate Action
An Associate action uses the Monitor Service to poll a target location (a directory, for 
example) on a device or file system (FTP, network folder, etc.) to discover new files in the 
context of a job.

Often, an Associate action follows a Watch action, and utilizes the file name of an 
existing media file or attachment as the basis for discovering new files; for example, if 
media file Vantage.mpg is currently in the workflow, then the Associate action may look 
for Vantage.scc. The Watch action can publish the file name as a variable, and pass it to 
the Associate action to pick the corresponding file (the file extension must be dropped 
to accomplish this). The required file match pattern can be configured in the Associate 
action's Inspector dialog.

Associate actions only execute when a job has been submitted. Subsequent actions 
can’t execute until the file is found or a time-out occurs. When the new file is 
discovered, the Associate action ingests the file, assigns a nickname, and makes the file 
available to other actions in the workflow.

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow—Associate is not an origin action.
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Workorder Action
A Workorder action is an origin action; it uses the Monitor Service to regularly poll a 
target Windows directory for new workorder files to process. The Workorder action 
provides a simple and highly effective method of submitting multiple similar jobs 
without using the SDK. 

A Workorder file is a comma-separated value (CSV) text file containing one or more 
work orders, or job descriptions. Each row in the CSV file specifies a job, and each 
column specifies either an input file or variable value. Workorder file configurations are 
specified in the Domain Management Console. At least one workorder scheme must be 
created in order to use a Workorder action.

When a new CSV file is discovered, the Workorder action submits one job for each row 
in the CSV file.
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Multiscreen Flip Action
The Multiscreen Flip action is an optional, licensed feature. Multiscreen Flip actions are 
executed by the Multiscreen Service. The Multiscreen service may run on a Vantage 
Lightspeed Server or a standard Vantage server. 

The Multiscreen Flip action allows you to encode and package decoded digital 
baseband media into industry-standard adaptive rate streaming formats, including 
Adobe HDS, Apple HLS, Microsoft HSS, and others. Transcoding is performed by the 
Telestream Media Transcode and Analysis Engine on behalf of Vantage.
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Nexidia Action
The Nexidia action is an optional, licensed feature in Vantage. It uses the Vantage 
Nexidia Service to interact with Nexidia QC servers running Nexidia QC software. The 
specified input files are passed to the Nexidia QC software where they are analyzed 
using the test profile selected.
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Pulsar Action
The Pulsar action is an optional, licensed feature which enables broadcasters to 
integrate the Pulsar suite of content verification components directly in Vantage 
workflows.
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Signiant Delivery Action
The Signiant Delivery action is an optional, licensed feature which enables Vantage 
workflows to deliver files to Signiant-enabled servers. The Signiant Delivery action is 
executed by the Signiant Service, and uses the Signiant Content Transfer Engine (CTE) 
feature, which must be licensed on the Signiant server.
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Staging Actions
The optional, licensed Staging Service actions are responsible for file operations in 
preparation for moving files to other systems/platforms with special packaging 
requirements. They are executed by the Staging Service:

 Archive Action

 Gather Action

Archive Action
Use the Archive action to convert the selected input file to another format, usually in 
preparation for copying, moving, or deploying a file to a given system that has special 
file format requirements. The Gather action is only enabled with the optional, licensed 
Metadata option.

Gather Action
Use the Gather action to collect one or more files from a specified server and directory 
(and optionally, its sub-folders), and bring them into the workflow as attachments. Use 
of a file matching pattern allows you to select only certain types of files. The Gather 
action is only enabled with the optional, licensed Metadata option.
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Traffic Actions
The following actions are executed by the Traffic Service and monitor catch servers and 
dublist servers for new files. These actions are both origin actions, and are a component 
of TrafficManager, an optional, licensed feature.

 Catch Action

 Dublist Action

Catch Action
Use the Catch action (an origin action) to select a catch server, and configure the action 
to monitor it for new commercials and syndicated content arriving from the publisher, 
expose all relevant metadata, and submit the commercial for processing in 
TrafficManager workflows. The Catch action is part of TrafficManager; an optional, 
licensed feature of Vantage.

The Catch action submits a job to the workflow which it is part of, when:

• A new file is discovered in the target folder.

• You manually submit a file to the workflow.

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

Dublist Action
Use the Dublist action (an origin action) to perform dublist processing in 
TrafficManager workflows. The Dublist action is part of TrafficManager, an optional, 
licensed feature of Vantage.

In the Dublist action’s inspector, you can select a dublist system or server as the target, 
and configure the action to monitor it for new dublists, which it resolves with the 
standing dublist. 

The Dublist action submits a job to the workflow which it is part of, when:

• A new file is discovered in the target folder

• You manually submit a file to the workflow

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

The Dublist action uses the binder name as the unique identifier for the commercial, so 
it should be set to the Ad ID.
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Transcode Flip Action
The Flip action is executed by the Transcode Service (which in turn utilizes the 
Telestream Transcode & Analysis Engine). Use the Flip action to create media of a new 
format, and save it as a file, using a prescribed codec profile. How you configure the 
encoder depends on the encoder you choose.
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Transport Actions
Transport actions are executed by the Transport Service and perform file operations on 
specified files.

 Copy Action

 Move Action

 Delete Action

 Deploy Action

Copy Action
Use the Copy action to duplicate a file from one directory to another directory on a 
given file system. The new file can be tracked by the workflow—that is, referenced in 
the binder. As a result, the new file must be given a nickname.

Move Action
Use the Move action to remove a file from one directory and place it in another. You can 
optionally specify a different destination nickname during the move.

Delete Action
Use the Delete action to delete a file on the specified file system. This action also 
removes the file reference from the binder.

Deploy Action
The Deploy action copies one or more files to a destination in a single step, and may 
perform additional custom steps depending upon the type of deployment.

Deployed files are not referenced in the binder, and are not tracked after the action 
completes.
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VidChecker Action
The VidChecker action is an optional, licensed feature which enables broadcasters to 
integrate VidChecker, automated QC and intelligent automated correction, directly in 
Vantage workflows.



215
Monitoring Workflows and
Managing Jobs
The topics in this chapter describe how to submit jobs, monitor workflows, and manage 
jobs in Workflow Designer.

 Submitting Jobs to Workflows

 Checking Workflow Activation Status & History

 Monitoring and Managing Jobs

 Creating Job Reports

 Managing Job Report Formats

 Viewing Binders

 Controlling Action Execution in Jobs

 Viewing Action Status

Note: In addition to submitting jobs in Workflow Designer, you can also submit jobs 
by dropping media files into target directories, or by using the Dublist Portal and the 
Workflow Portal clients. You can also submit jobs from other programs using the 
Vantage SDK.

Note: You can also monitor and manage jobs using the Job Status Views Web 
application. See Using the Job Status Views Web Application.
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Submitting Jobs to Workflows
This topic discusses the various methods used to submit media or other files to Vantage 
workflows. You can submit jobs in the following ways: 

• Directly in Workflow Designer using various methods. See Submitting Files Manually 
in Workflow Designer, below.

• By adding files to monitored directories on supported platforms.

• By submitting a workorder file to a Workorder-based workflow.

• Using Workflow Portal and the Workflow Portal Web Application. See Using Work-
flow Portal.

• From Dublist Portal. See the TrafficManager User’s Guide.

• From the Transcode Web Application. See Using Vantage Transcode.

• From third-part or custom programs using the Vantage SDK.

Submitting Files Manually in Workflow Designer
To submit files manually to a workflow for processing directly in Workflow Designer 
(which starts a new job for each file submitted), do one of the following:

• Drag and drop the selected file or files from a Windows Explorer directory directly 
onto the origin action of the target workflow. See Submitting Files via Drag and 
Drop.

• Select the workflow and click the Submit Job button to submit one or more files. 
See Submitting Files via the Submit Button.

Note: The file you are submitting doesn’t have to be a media file; though it usually is. 
You can manually submit any file that the workflow can process. It might be some 
form of XML (metadata, for example). Or, it might be a workorder file for a Workorder 
action workflow, for submitting several jobs at once. It might be some other form of 
file, based on your workflow.
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Submitting Files via Drag and Drop
To submit files for processing using drag and drop, follow these steps:

1. In Workflow Designer, select the target (active) workflow and display it in the 
Workflow Design workspace.

2. In Windows Explorer, navigate to the directory where the file or files that you want 
to process are stored.

3. Select one or more files and drag them over the origin action in the workflow.

Figure 119. Submitting Media via Drag and Drop

4. When the origin action highlights (displays a bright green border), drop them onto 
the action to submit them for processing.
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Figure 120. The Origin Action Highlights to Indicate that you can Drop the Files

Vantage displays a confirmation dialog when all jobs have been submitted:

Figure 121. Job Submission Confirmation

Click OK to dismiss the dialog, and display the Job Status workspace to track your jobs.
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Submitting Files via the Submit Button
To submit a file to an activated workflow manually, follow these steps:

1. Select the target (activated) workflow in the Workflows panel.

2. Click the Submit Job button as shown below.

Figure 122. Using the Submit Job Button to Manually Submit Files

In a multiple origin action workflow, Workflow Designer displays a dialog that lists 
the origin actions. 

3. Select the action you want to start the job, then click Next to continue.

Workflow Designer displays the Submit Job dialog:

Figure 123. Submit Job Dialog’s File System Selector Panel

Click the Submit Job 
button to select 
media files for 
processing with the 
selected workflow.
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4. Select the type of file system (or a Vantage folder) where the input file or files are 
stored, and click Next.

Workflow Designer displays the Windows Explorer window:

Figure 124. Selecting Media Files to Submit

5. Navigate to the server and directory, and select one or more directories and/or files 
for processing and click Open. Click Browse to add more files or click Clear to start 
over. As you select files, they are added to the list:

Figure 125. Submit Job Window, with Selected Media Files
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6. When the list is correct and you’re ready to submit them, click Next. 

Figure 126. Submit Job Dialog, with Variables and Submit Buttons

7. Optionally, click Variables to manually add a variable with a static value to this job. 
For details, see Adding Variables to an Action.

8. Click Submit to submit the file(s) for processing.

Vantage displays a confirmation dialog when all jobs have been submitted:

Figure 127. Job Submission Confirmation

When you have submitted the job(s), you can view their progress in the Job Status 
workspace (see Monitoring and Managing Jobs).
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Checking Workflow Activation Status & History
To check on the status and activity history of your workflows, use one of these tabs:

• Select a workflow and click the Monitor Status tab (or select File > Monitor Status).

• Click the Domain Monitor Status tab (or select File > Domain Monitor Status).

The Monitor Status workspaces are useful when you’re performing operator-related 
tasks or when you’re managing or performing domain-wide production media 
processing. The only difference between the two tabs is one of scope.

The Monitor Status tab displays all activation records for the selected workflow, 
indicating the dates and times when the workflow was active. Each time a workflow is 
activated, a new activation record is added. It displays each origin action’s execution 
(for example, Watch actions) in the selected workflow, and indicates its current status. 

Figure 128. Monitor Status Displays Activation Records for the Selected Workflow

The Domain Monitor Status tab displays all of the monitors currently executing in the 
entire domain. Because the Domain Monitor Status tab displays all monitors in the 
domain, it also displays two additional columns of information not found in the 
Monitor Status tab: Workflow and Category.

Static information in the activation record includes the origin action, resource cost, and 
several date/time stamps, including when the action will expire. The state is real time 
information, indicating the state of the action: In Process (currently executing), 
Completed, etc.

Click any column to make it the primary column and sort it in ascending or descending 
order.

These topics provide information on using the Monitor Status tab:

 Using the Monitor Status Toolbar

 Viewing Origin Action Record Details

Each row is an active origin action, indicating status and other details.

Monitor Status toolbar
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Using the Monitor Status Toolbar
The Monitor Status workspace provides the following buttons in the toolbar:

• Show in groups button —Click to organize records for the selected action by 
group, based on the primary column—the one selected. Click again to turn group-
ing off. For example, if you select State as the primary field in the table and display 
Groups, Workflow Designer sorts the records by state: In Process and Complete. 

When displayed in groups, click the Down arrow on the table entry to display the 
origin records in this group (In Process, or Complete, for example).

• Delete button —Click to delete the selected record(s). Or, right-click on the 
record, and select Delete. You can only delete records whose origin actions are 
complete—that is, the session has ended because the workflow was deactivated.

• Status button —Click to display the selected workflow’s origin action details. Or, 
right-click and select View Status.

Viewing Origin Action Record Details
To display details about the origin (the first) action for the selected workflow, double-
click the row (or select a row and click the Status button ).

The Status/History dialog (Figure 129 and Figure 130) provides details about the status 
of the origin action.

Figure 129. Status/History Dialog, Showing Completed Action Status

When an action is complete, the Status/History dialog displays information on each 
aspect of the action’s execution. You can use this information to review details about its 
execution, and when an action fails, you can use this information to determine why and 
correct the problem.
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The text in the upper panel of the Status/History dialog provides a summary of some 
aspect of action execution. To display more information related to a line in the upper 
panel, click on the line. The detailed information appears in the lower panel. 

Click the symbol to the left of the summary lines in the upper panel to hide or display 
subordinate summary lines.

When an action is In Process, (Queued, Paused, In Process, or Waiting states), the Status/
History dialog displays a progress bar, the path of the target directory, and the status.

Figure 130. Status/History Dialog, Showing In-Process Action Status

For jobs in the Success, Ignore, and Failure states, the Status History dialog displays the 
following buttons:

• Export—Click Export to display a File System dialog, and save the status/history 
information as an XML file. You can send these files to Telestream for support issues, 
or export them for processing in other systems.

• Session Log—To display a session log, select a session in the upper panel and click 
Session Log.

Figure 131. Session Log Dialog

The session log displays session activity entries, if any, including which variables have 
been provided to each action. This information can be helpful when debugging the use 
of variable, or when working on an issue with Telestream Customer Service.

Click Done to close the window.
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Monitoring and Managing Jobs
To monitor and manage jobs, display one of these two workspaces:

• Select a workflow and click the Job Status tab (or click File > Job Status)

• Click the Domain Job Status tab (File > Domain Job Status).

The Job Status and Domain Job Status workspaces each display a list of jobs and 
provide job details. Use these workspaces to monitor media processing, set priorities, 
view binders and associated files, and to pause and resume jobs in progress.

Note:  When the Include Completed Jobs option is enabled in the Console (under 
Settings & Options), these tables also display all jobs that have completed. 

These workspaces are useful when you’re performing operator-related tasks, or when 
you’re managing or performing domain-wide production media processing. The only 
difference between the two tabs is one of scope.

The Job Status workspace allows you to select a workflow in your user account and 
display all of this workflow’s jobs. The Domain Job Status workspace displays all the 
jobs currently executing in the domain, plus all completed jobs.

Figure 132. Job Status Workspace

Because the Domain Job Status workspace displays all of the jobs in the domain, the 
Jobs table also displays two additional columns of information not found in the Job 

Each row is a job processed by the selected workflow, indicating 
status and other details.

Job Status toolbar

Real-time view of transaction processing.
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Status workspace: Workflow and Category. It also displays an Emergency Stop button in 
the bottom right-corner. For details, see Stopping All Jobs in the Domain.

When an action is executing, it is displayed with a green border, and a progress bar 
displays at the bottom of the action, indicating execution progress. This indicator 
provides a relatively accurate prediction of how far along the total execution has 
progressed.

Figure 133. During Execution, each Action Displays a Progress Bar

The following topics provide additional information for using the job status 
workspaces:

 Viewing Actions in Detailed Action View

 Using the Jobs Table

 Using the Job Status Table’s Toolbar and Context Menu

 Stopping All Jobs in the Domain

The progress bar indicates progress for this action.



Monitoring Workflows and Managing Jobs
Monitoring and Managing Jobs

227
Viewing Actions in Detailed Action View
To view actions in detailed action view, select View > Detailed Action View. In this view, 
each action displays its state, creation and update dates, and resource costs directly on 
the action.

Figure 134. Actions, Displayed in Detailed View
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Using the Jobs Table
Click any column title in the Jobs table to make it the primary column and sort it in 
ascending or descending order.

Job Column
The Job column displays the name of the file submitted to start the job, and the type of 
submission: Manual Submit, for example.

Workflow Column (Domain Job Status Only)
The Workflow column displays the name of the workflow that is processing or has 
processed this job.

Category Column (Domain Job Status Only)
The Category column displays the category of the workflow.

State Column
The state column displays color-coded key words to identify the status of the job.

• Green—In Process. The action is currently executing.

• Blue—Complete. The action completed successfully. 

• Red—Failed. This action has failed or an upstream action failed.

• Black—Ignored. This action was not executed due to Perform On state mismatch.

• Light Gray—Paused or Suspended. An action is paused or suspended.

• Magenta—Stopped by User. An action was stopped by a user.

• Orange—Waiting to Retry. An action failed and is waiting to re-execute the action.

• Purple—Waiting for a Service. No service of the required type is running that can 
execute the action. For example, no Transcode Service is running and the Flip 
action is purple.

• Light Green—Waiting due to a run on rule that must be satisfied. For example, a Flip 
action requires a Lightspeed server, but no Lightspeed servers are present.

• White—The action is waiting to be assigned to a service. Upstream actions have not 
yet completed execution.

• Yellow—Waiting execution, because even thought the action has been accepted by 
a service, there is no slot in which to run the action. Note that when an action is 
waiting to execute, it may be re-assigned to another service which can execute it. 

Note: At any time before an action starts executing, it may be re-assigned (re-
balanced) to another service which can execute it.
Completing without errors does NOT mean that the action performed the task—an 
action may be configured to execute ONLY when a previous action succeeded or 
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when a previous action failed—thus, an action may complete without errors, and 
perform no task at all.

Progress Column
The information displayed in the Progress column depends on the Detailed Job 
Progress setting in the Vantage Management Console.

If Detailed Job Progress is disabled, the Progress column displays the percentage of 
actions that are complete at the moment. For example, if you have a 10 action workflow 
and the 4th action is currently executing, Vantage will report the workflow as 30% 
complete.

If Detailed Job Progress is enabled, the progress column displays a percentage value of 
the current amount of time consumed compared to the total estimated time for the job 
to complete. Using the job’s start time to determine how long the job has been 
executing, you can use the progress percentage to extrapolate the approximate 
completion time, assuming the load on the domain remains relatively constant.

Note: To change the Detailed Job Progress setting in the Vantage Management 
Console, start the console and click on Settings & Options > General Tab to set the 
Detailed Job Progress check box.

Started Column
The Started column displays the time the job started by date and time.

Updated Column
The Updated column displays the last time the job record was updated (typically, when 
the job ended) by date and time.

Expires Column
The Expires column displays the time the job expires, and will be removed from the 
database (along with its binder). To change the expiration period for a workflow, select 
it and click on the title to display its detail panel, where the Expiration period is 
displayed. See Viewing and Specifying Workflow Details.
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Using the Job Status Table’s Toolbar and Context Menu
The toolbar and context menu provide a variety of commands for managing jobs. The 
toolbar is displayed directly above the table.

The context menu has the same set of commands, with the exception of the Jobs Filter 
button (at far right in the toolbar), which is not specific to the selected job. To display 
the context menu, right-click on any job in the table.

• Show in groups —Organizes jobs by group, based on the primary column—the 
one you have selected. Click again to turn grouping off.

• Stop —Halts processing on this job. When you stop a job in process, each action 
for that job is notified to stop its own transaction. When all actions have been 
stopped, the job is considered complete, in a user-stopped state.

• Restart —If a job was stopped or it failed, re-starts and continue processing 
where it was stopped. Actions that fail or are stopped by a user are re-executed. 
When you restart a job, it is started as a first-time job again. This affects the execu-
tion of retry rules.

• Set expiration —Modifies the default expiration time for this job. Workflow 
Designer displays the Set Job Expiration dialog—specify a new expiration date and 
click OK.

• Delete —Deletes the selected job row(s). Or, right-click and select Delete.

• View Binder —Displays the selected job’s binder. Or, right-click an action or the 
job row in the table, and select View Binder. For details, see Viewing Binders.

• View Job Errors —Displays details about errors encountered in the job.

• Job Report —Creates a job report. Select one or more jobs in the table, and click 
on the Job Report button. For details, see Creating Job Reports.

• Jump to Workflow —This button only displays in the Domain Job Status work-
space. To jump directly to the workflow for this job, select a job in the table and 
click the button.

• Jobs Filter —Displays only jobs that contain specific text in the job name. Enter 
the text to begin filtering displayed jobs. Delete the text (or just close the filter by 
clicking the filter button) to display all jobs again.
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Stopping All Jobs in the Domain
If you get in a situation where you need to immediately stop all running and queued 
jobs in the domain, you can use the Emergency Stop button, which is located in the 
bottom right corner of the Domain Job Status workspace.

Note: If possible, Telestream recommend using the Management Console to place 
the services in maintenance mode (or the Windows Services Console to stop the 
services) before using this command. 
After issuing a command to stop all jobs, it may take several minutes to complete. The 
time to completion is dependent on the volume of affected jobs in the database and 
the consequent load on the computers in the domain.

Figure 135. Using the Emergency Stop Button to Stop all Jobs in the Domain

To stop all running and queued jobs in the domain using this button, follow these steps

1. Click the Domain Job Status workspace.

2. Click on the Emergency Stop button in the bottom right corner. 
Workflow Designer displays a warning dialog.

WARNING: The Emergency Stop button stops all active jobs in the domain, and can not 
be reversed. This will lead to a potential loss of work and/or data. You should only utilize 
this command in an emergency. (For example, mistakenly submitting thousands of jobs.) 
Ideally all services should be in maintenance mode before executing this command.

3. Click Yes to Continue.

Workflow Designer issues the Emergency Stop command to the domain database.

After clicking the 
Emergency Stop button 
to stop all of the jobs in 
the domain, Workflow 
Designer displays a 
warning dialog.

Emergency Stop button.
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Creating Job Reports
Workflow Designer creates job reports for the selected job or jobs, as comma-separated 
value (CSV) files. You can open these reports in spreadsheet programs and other 
programs that can display CSV files, or you can use the CSV files in other systems, such 
as databases or media asset management systems. 

Each job report is based on a job report format you select (Managing Job Report 
Formats).

Note: If there are no job report formats, Workflow Designer displays a dialog 
indicating that you need to create one. Click OK to display the Job Report Manager, so 
you can create a job report format (Managing Job Report Formats).

To create a comma-separated values job report, select one or more jobs in the table, 
then click on the Job Report button in the toolbar. Workflow Designer displays the 
Create Job Report dialog.

Figure 136. Create Job Report Dialog

Select a job report format from the list and click OK to continue.

Note: To manage job report formats, click the browse  button to display the Job 
Report Manager dialog. For details, see Managing Job Report Formats. You can also 
manage job reports in the Vantage Management Console.

Vantage displays the File System dialog, which you can use to select the server and 
directory where you want the CSV report file for the selected job or jobs stored, as 
shown in the following figure.
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Figure 137. Selecting a Folder and Naming a Job Report Format File

Optionally, enter a new name for the job report file (or append a date or other 
significant qualifier) and click Save to process the report and save the file with a .csv file 
extension. When the report file has been generated, Vantage displays a dialog to 
indicate where the file was saved. Click OK to close the dialog.
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Managing Job Report Formats
Use the Job Report Manager dialog to create a new job report format, or to edit or 
delete an existing job report format. 

The following sections describe these tasks:

 Displaying the Job Report Manager Dialog

 Creating a New Job Report Format

 Including and Excluding the Header Row

 Choosing the Report Columns

 Duplicating a Job Report

 Deleting a Job Report
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Displaying the Job Report Manager Dialog
To view the Job Report Manager dialog, follow these steps.

1. Display the Job Status or Domain Job Status workspace.

2. Click the Job Report button in the toolbar to display the Job Reports dialog.

3. Click the browse  button to the right of the popup menu.

Workflow Designer displays the Create Job Report Manager dialog, shown below.

Figure 138. Using the Job Report Manager to Configure Templates
Toolbar buttons:
Create | Delete | Save | Duplicate
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Creating a New Job Report Format
You can create job report formats in Workflow Designer.

Note: Vantage domain administrators can also create report formats with the 
Vantage Management Console.

To create a new report format, do the following:

1. Click the Create report button .

Workflow Designer adds a new report to the report list and selects it.

2. Enter a new name in the Name field.

3. Optionally, enter a report description in the Description field.

4. Click the Save button .

Including and Excluding the Header Row
To include or exclude a header row in the job report, select the report and do the 
following:

1. Check the Add Header Row check box to include the header row, or clear the 
checkbox to exclude the header row.

2. Click the Save button .

Choosing the Report Columns
You can configure reports to include or exclude the following columns:

• Job ID

• Job Name

• State

• Progress

• Started

• Updated

• Expires

• Workflow Name

• Additional columns for metadata label parameters

When you choose to display a column for a metadata label, the column displays the 
label value.



Monitoring Workflows and Managing Jobs
Managing Job Report Formats

237
To define which columns appear in a report, select the report, and do the following:

1. Under Columns, check (display) or clear (hide) the check boxes for the columns you 
want to display.

2. To add or delete columns for metadata labels, do the following:

a. Click the Add Column button  to display the Select Label Parameters for 
Columns dialog.

b. In the Labels pane, select a label for which you want to display parameters.
c. In the Parameters pane, check the checkbox for any parameter you want to 

display, and clear the checkbox for any parameter you do not want to display.
To toggle the display of parameter by category, click the Category button . 
One display state displays parameters with category headings; the other displays 
them without category headings.

d. Repeat parameter label selection until all labels are properly selected.
e. Click OK.

3. To change the displayed order of parameter labels, select a label in the list and use 
the green up  and down arrow  buttons to move the label in the list.

The top item in the list appears to the right of the columns listed in the Columns 
row, and to the left of all the other label columns. The last item in the list becomes 
the last column on the right.

4. Click the Save button .
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Duplicating a Job Report
When you duplicate a job report, a new report is created with a modified report name. 
All other configuration settings in the duplicate report match those in the original 
report.

To duplicate a job report, do the following:

1. Select the report to duplicate.

2. Click the Duplicate button .

3. In the Name text box, enter a name for the duplicate report.

4. In the Description text box, optionally enter a description for the duplicate report.

5. Click the Save button .

Deleting a Job Report
To delete a job report, select the report and do the following:

1. Click the Delete button .

2. When the confirmation dialog displays, click OK.
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Viewing Binders
The Binder window displays information about all of the files ingested or generated in a 
job. Or, subsequent jobs for the same media file, when the Register action is configured 
to overwrite binders when a media file of the same name is submitted (Conflict 
Resolution). Assets in the binder are organized by tab: Media Files, Metadata Labels, 
and Attachments.

To view the binder for the selected job, choose:

• Click the binder button  in the toolbar

• Right-click on any action, or job row in the table, and select View Binder. 

• Double-click the job row in the table.

Figure 139. Viewing the Binder and Its Assets

Media Files tab—Displays a list of media files ingested or created in the job, including 
the file’s path, nickname, and filename. To the right is a WMV player control, where you 
can preview the selected file provided that it is playable by Windows Media Player 
(typically, .wmv, .avi, and .asf, depending on your configuration).

Alternatively, you can right-click on any file and select one of two options:

Open Containing Folder—displays the Windows directory where the file is stored.

Open With Default Program—opens the file in the program specified as the default 
program to open these types of files.

Note: When running Workflow Designer on Windows Server 2008, unless the 
Desktop Experience feature is installed, you can’t review media. For details, see 
Windows Server 2008 Requirements in the Vantage Domain Management Guide.
See also Configuring Server 2008 to Solve Display Problems for Vantage Programs.
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Metadata Labels tab—Displays metadata labels in the binder, their parameters and 
values. You cannot edit values in this viewer. You can edit metadata in Workflow Portal 
and Vantage Management Console as necessary.

Attachments tab—Displays a list of attachment files, including each file’s path, 
nickname, and filename.
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Controlling Action Execution in Jobs
These topics describe how you can control actions in your jobs:

 Pausing and Resuming Flip Actions

 Pause for Priority in Flip Actions

 Setting an Action’s Execution Priority

Pausing and Resuming Flip Actions
To pause and resume Flip actions in a job in progress, right-click on the action and 
select Pause from the context menu. To resume a paused action, right-click on the job 
and select Resume from the context menu.

You cannot pause actions in certain states or in certain workflows. For example, you 
cannot pause an action that has failed. Also, you cannot resume an action downstream 
of another failed action, without restarting the first failed action, etc.

Pause for Priority in Flip Actions
Pause for Priority is an automatic feature of Flip actions. If a Transcode Service is 
saturated (that is, it is performing the maximum number of jobs it is set for); then 
Vantage will queue up incoming jobs and wait for a slot to become available. 

For example, a Transcode Service is configured to run 2 simultaneous jobs; it receives 
three jobs (A, B and C); jobs A and B begin execution (the service was idle prior to this) 
and C is queued until either A or B completes, at which point C will execute).

Pause for Priority comes into play if job C has a higher execution priority than job A or B. 
in this case, job A is paused and job C begins processing immediately. When Job C or B 
completes; then A (which was previously paused) returns to processing.

Setting an Action’s Execution Priority
You can modify the execution priority of actions that are in the Wait, Pause, or Running 
states. You cannot set an action priority for a completed action. To change the priority 
of an action that has not completed, do the following:

1. Right-click the action and select Priority to display the Action Priority dialog.

Figure 140. Action Priority Dialog

2. Change the priority value (larger numbers means higher priority), and click OK to 
modify the action’s priority in this job.
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Viewing Action Status
To view details about the status of any action in a job, select the job in the jobs list, 
right-click the target action in the workflow, and select Status.

The Status/History dialog (Figure 141) provides details about each aspect of the action’s 
execution. You can use this information to gather details about its execution, and when 
an action fails, you can use this information to determine why and correct the problem.

Figure 141. Status/History Dialog

Each line in the upper panel of the Status/History dialog provides a summary of some 
aspect of action execution. To display more information related to a line in the upper 
panel, click on the line. The detailed information appears in the lower panel. 

The symbol to the left of the summary lines in the upper panel allow you to hide or 
expose subordinate summary lines. Click a symbol to hide or display subordinate 
summary lines.

Export—Click Export to display a File System dialog, and save the status/history 
information as an XML file. You can send these files to Telestream for support issues, or 
export them for processing in other systems.

Session Log—To display a session log, select a session in the upper panel and click 
Session Log.

Click Done to dismiss the Status/History window.
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Using Workflow
Analytics
Use this chapter to learn how to use Workflow Designer to analyze workflows and job 
history to identify problems and improve overall system performance.

 Understanding Workflow Analytics

 Using the Workflow Analytics Panel

 Performing Bottleneck Analysis

 Performing Execution Analysis

Note: Features in editions for which you do not have a license are disabled, and 
indicate that you need a license to use them.
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Understanding Workflow Analytics
Workflow analytics is an optional, licensed feature in Workflow Designer, and requires a 
Reporting and Analytics license. Workflow analytics enables you to visually analyze 
workflows and job history to identify problems and improve overall system 
performance.

In Workflow Designer, workflow analytics enables you to view jobs (based on the job 
history currently in the database) on a case-by-case basis to:

• Identify performance bottlenecks by action in a workflow

• Analyze workflow execution as a result of decisions in a workflow

• Visualize the progress of multiple jobs submitted to a workflow

• Rank workflows and actions, based on processing time consumption.

Note: Because workflows may be modified over time, jobs run in the selected 
workflow prior to the last change are ignored.

Vantage administrators and personnel responsible for designing and implementing 
workflows can use this information to modify workflow design and improve Vantage 
domain performance and efficiency.

Note: In the Management Console, workflow analytics enables you to analyze 
workflows at the domain level. For details on using workflow analytics in the Vantage 
Management Console, click the Help button in the toolbar to display the Vantage 
Domain Management Guide.

Workflow analytics automatically includes new jobs that are submitted, as appropriate, 
displaying them in the Jobs table and recalculating metrics.
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Using the Workflow Analytics Panel
Click the Workflow Analytics tab (or click File > Workflow Analytics), and select the 
workflow in the Workflows panel to view job history information, which helps you 
identify performance bottlenecks and collect workflow processing statistics.

Figure 142. Workflow Analytics Panel Displays Workflow Execution History

To select a workflow to view, use the Workflows list to the left of the Workflow Analytics 
tab. Open the appropriate workflow category and click on any workflow to select it. You 
can then view all of the job history records for the selected workflow in the Workflow 
Analytics tab.

After making your job selection (see below), click the Run Analysis button to begin near 
real-time display of the analytics data. To stop calculating and updating the data (or to 
change the jobs you want to analyze), click Stop Analysis.

The following topics provide additional information:

 Using the Jobs Table Toolbar

 Using the Jobs Table

Actions display the average execution time, and stack rank time 
relatively by color—green (fastest) through red (slowest).

Jobs Table with toolbar Analysis Options
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Using the Jobs Table Toolbar
The toolbar for the Jobs table displays buttons for the following commands:

Groups—Click to organize the jobs by group, based on the primary column—the one 
you have selected. Click again to turn grouping off.

Filter—Click to display (and thus determine the set) only jobs that contain specific text 
in the job name. Enter the text to begin filtering displayed jobs. Delete the text to 
display all jobs again.

Using the Jobs Table
Click any column in the Jobs table to make it the primary column and sort it in 
ascending or descending order.

When you first select a workflow, no jobs are selected, so all jobs are considered in 
calculating the metrics. Select any job or jobs (shift-click or control-click) to view the 
selected set’s analytic details.

To de-select all jobs and return the table to its original state, select one record, then 
control-click to de-select it.



Using Workflow Analytics
Performing Bottleneck Analysis

247
Performing Bottleneck Analysis
Select Bottleneck Analysis from the popup menu on the far right. Workflow Designer 
displays elapsed time for the selected records in the job history set.

In bottleneck analysis (which is enabled by default), you can identify the longest 
running actions in a workflow, based on color and time values.

Color values are applied to each action from green to red on a sliding scale, based on a 
comparison of the average of all selected job records. The shortest average execution 
time displays the darkest shade of green; the longest displays red. Those in between 
display color values through yellow-green, yellow (average), and orange.

Numeric values on each action display the average execution time of the actions which 
ran, based on the selected job records.

When performing bottleneck analysis, choose:

• Include Waiting Time—Check to add wait time to execution time and display the 
combined total time for each action. Wait time includes time spent in a Waiting 
state and a Paused state. Uncheck to display only execution time.

• Count Non-running Actions—Check to include the execution time (0 seconds) of 
actions that did not run, thus providing a weighted bottleneck analysis based on 
which branches in a workflow executed, based on decision actions. This allows you 
to focus upon the actions which are bottlenecks in real-world operations. 

Uncheck to disregard non-running actions when calculating the execution time. This 
allows you to find the most expensive actions, regardless of whether or not they are 
commonly run.
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Performing Execution Analysis
Select Execution Analysis from the popup menu on the far right. Workflow Designer 
displays percentile and numeric values for the selected records in the job history set.

In execution analysis, you can determine which percentage and number of actions 
executed, based on the selected job history set, based on color and percentile values.

Color values are applied to each action from black to green on a sliding scale. The 
lowest average execution displays the darkest shade of black; the highest displays 
green.

Darker actions are those that have not executed yet (near zero percent). Dark green 
actions are average (near 50 percent), and the highest percentile executing actions are 
bright green (approaching 100 percent). 

For each action, the percent of executions completed is calculated against the total 
number of jobs, based on your selected job criteria.

When using execution analysis, choose your job criteria:

All Jobs | Only Completed Jobs | Only Successful Jobs—Select to include all selected jobs 
regardless of their status, only completed jobs (thus excluding running or partially 
completed jobs), or only successful jobs in the calculations.
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Using Workflow Portal
This chapter describes how to use Vantage Workflow Portal—designed specifically for 
customizable, operator-driven media processing. Workflow Portal configurations allow 
you to control functionality and user interface components, and are created and 
configured in the Vantage Management Console, and loaded in the Workflow Portal 
application when it is launched.

Note: Workflow Portal is an optional, licensed feature in Vantage. For details about 
Workflow portal licenses, see CWP Licensing in the Domain Management Guide. 

Workflow Portal is provided as a Windows program and as a Web application. The 
Windows client provides optimum performance and the full feature set. The Web client 
can be used on any computer with a supported Web browser (see Web Application 
Browser Requirements) and a network or Internet connection to your Vantage domain. 
However, not all configuration types are usable in the Web client.

The following topics introduce and describe Workflow Portal:
 Workflow Portal Overview
 Understanding Catalogs and Binders
 Workflow Design Guidelines
 Starting a Workflow Portal Session
 Changing or Reloading a Configuration
 Using Workflow Portal Configurations
 Performing Key Workflow Portal Tasks
 Selecting Binders
 Previewing Video in the Media Player
 Submitting a Job to Workflows
 Windows Client Menus
 Troubleshooting Workflow Portal

Most topics apply to both clients. When a topic applies to only one client, it is noted.
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Workflow Portal Overview
Video processing workflows frequently require some form of operator intervention 
during media processing. For example, an operator might initiate processing, evaluate 
pre-processing results, scrub and set trim points, add/edit metadata, and submit media 
to a selected workflow for further processing.

Note: For basic information on using Vantage client programs, see Vantage Client 
Programs Overview.
On Windows Server 2008, you may have problems minimizing windows if you 
maximize them by dragging them to the top of the monitor (AeroSnap). To disable 
AeroSnap, go to Control Panel > Ease of Access Center > Change how your mouse works. 
Check Prevent windows from being automatically arranged when moved to the edge of 
the screen.

 Key Applications
 How Workflow Portal Works
 Key Workflow Portal Features
 Workflow Portal Configuration Types
 Implementing Workflow Portal-based Media Processing
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Key Applications
Key applications of Workflow Portal include:

• Highlight Extraction From Archive Files—An operator marks in and out timecodes 
and chooses the timecode for a thumbnail.

• Promo Preparation—An operator marks the voice-over and graphics entry points 
on the timeline. A subsequent workflow reprocesses the promo for multiple mar-
kets, days, and languages, based upon this input.

• VOD Distribution—An operator creates a playlist of clips and enters metadata. A subse-
quent workflow merges (stitches) the clips into a single media file and transforms meta-
data for distribution.

• VOD Digital Ad Insertion—An operator defines ad locations for dynamic ad insertion by 
the cable vendor, and submits jobs for assembly of CableLabs VOD content and pro-
visions it for dynamic ad insertion (DAI).

• TrafficManager—An operator searches catalogs, then reviews and submits commer-
cial inventory for processing to a specific workflow from several available.

• DPP Package Preparation - An operator enters DPP metadata, marks programme seg-
ments, and submits a job to a Vantage workflow. Vantage adds bars, generates slates, 
and encodes to the appropriate MXF format with full DPP metadata to create a DPP 
package.

How Workflow Portal Works
Figure 143 depicts how Workflow Portal is typically used in a Vantage domain.

Figure 143. How Workflow Portal is Implemented

Operator-access to job and media metadata is a powerful feature that enables 
operators to control the operation of the next workflow. For example, operators can 

Workflow designers create 
workflows and Vantage 
administrators create Workflow 
Portal configurations to support 
Workflow Portal operators.

Operators use Vantage Workflow Portal to search 
catalogs, update metadata and trim points, 
perform review and approval, and submit media 
for processing to specific workflows.
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edit metadata labels to add tags to media, control content routing, or select other 
processing options in the next workflow.
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Key Workflow Portal Features
Workflow Portal provides several features for performing operator-intervention of 
media processing workflows. Workflow Portal has a customizable user interface where 
components and features are controlled by a configuration file, created in the 
Management Console, and loaded in Workflow Portal when launched by an operator.

These features allow operators to:

• Browse Vantage catalogs for media (saved in binders) from completed jobs and 
submit them to workflows.

• Browse Windows servers for media and submit it to a workflow (Windows client 
only).

• Create an Edit Decision List (EDL) of clips for stitching with a Flip action workflow 
(Windows client only).

• Create a Composition (CML) file of clips for stitching with a Post Producer Conform 
action workflow (Windows client only).

• Create a DPP-compliant XML metadata file and a CML file to produce the program 
media file (using Post Producer) and transcoding to AS-11 with DPP metadata (Win-
dows client only).

• Review/update metadata labels.

• Preview/scrub media proxies.

• Determine that all required files are present.

• Mark in/out trim points on an asset’s timeline.

• Mark media as approved or rejected.

• Supply run-time values to variables to use in the next workflow.

• Submit media to target workflows for further processing.
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Workflow Portal Configuration Types
Regardless of its configuration details, each configuration is one of the following types, 
as specified in the console:

• Browse Catalogs (copy binder)—Copy Binder

• Browse Catalogs (forward binder)—Forward Binder

• Browse Windows Network (create binder)—Browse Windows Network

• Create EDL from Catalogs (create binder)—Create EDL

• Create CML from Catalogs (create binder)—Create CML

• Create DPP from Catalogs (create binder)—Create DPP

The names on the left in this list match the names a domain administrator sees when 
creating a Workflow Portal configuration in the console. The shortened names that 
appear after the dash are the common names used in this guide.

Note: Copy Binder and Forward Binder configurations can be used in the Workflow 
Portal Web client as well as the Windows client. The other configurations can only be 
used in the Windows client.

The Copy Binder, Forward Binder, as well as the Create EDL, CML, and DPP 
configurations allow operators to browse Vantage catalogs for binders that have been 
registered by a previous job.

The Browse Windows Network configuration only allows operators to browse a 
Windows server (not a Vantage catalog) to select media files. When Workflow Portal 
only displays a file Browse button and workflow selection list, you know that you’re 
working with a Browse Windows Network configuration.

Each type of configuration operates differently, to achieve its intended result. The 
operation of each type is explained in detail in Using Workflow Portal Configurations. 

Implementing Workflow Portal-based Media Processing
Implementing Workflow Portal workflows in a Vantage domain requires planning and 
coordination by your Vantage administrator and workflow designer. To implement a 
Workflow Portal-based media processing workflow, a Vantage domain administrator 
must first use the Vantage Management Console to do the following:

• Enable the utilization of Workflow Portal.

• Configure one or more Workflow Portal configurations, which define the Workflow 
Portal feature set for specific applications, and the components, features and 
resources available to operators. This includes metadata and variables, and must be 
coordinated with the workflow designer to utilize the metadata and variables as 
appropriate for your application.
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Note: Administrators who are responsible for creating Workflow Portal configurations 
should refer to the Vantage Domain Management Guide for details.

Workflow designers use Workflow Designer to create and configure the required 
workflows, including required metadata and variables, and activate them when you 
want to use them in testing or production.

Typically, a given media processing workflow involves at least 2 Vantage workflows:

• An ingest workflow, which transcodes media and registers it in a catalog, and 

• a target workflow, which processes the media the operator has selected and for-
warded to a target workflow.
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Understanding Catalogs and Binders
Catalogs and binders are fundamental to the use and operation of workflows, jobs, and 
Workflow Portal. Catalogs and binders are general concepts that you may already 
understand. In the context of Vantage, catalogs and binders are implemented in 
specific ways to facilitate and simplify media processing applications.

Binders Overview
Each time you submit media to a workflow, it starts a job and Vantage executes it. Files, 
metadata, and variables related to each job are always recorded in a uniquely-named 
binder. Provided that the workflow has a Register action, information related to each 
job is recorded in a user-specified Vantage catalog. (Without a Register action, the 
binder is not easily accessible.)

A binder in the context of Vantage is simply a container, which contains file references 
(URLs or UNC paths) to media that was used or created in the job, and metadata labels 
for the job, variables that were used in the job, as well as other types of files that were 
used or created. Binders do not contain media files or attachments; they only contain 
the paths to those files. The binder also contains the media and attachment nicknames 
that map to each referenced file. 

Here is an example of how to view binders in a Review and Approval catalog. Each of 
these binders was registered in the catalog as a result of an ingest workflow job 
executing when MPEG media files were dropped into a monitored folder.

Figure 144. Workflow Portal Window, Showing Selection of Multiple Binders
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As you can see, each time the workflow ran (a job), it created a thumbnail file, a proxy 
file, and a media file (which is identical to the original file), all referenced in a uniquely-
named binder, so that operators and workflows can access them and use them in other 
workflows. In addition, metadata may be presented and edited, along with variables 
(which are not shown).

Vantage Catalogs Overview
Similar in concept to folders (or directories) in Windows, a Vantage catalog is a 
container that organizes and stores binders. Catalog folders are sub-containers that you 
can use to further organize binders, just as folders can contain other folders. When you 
use Workflow Portal to access a binder, you can browse or search through the available 
catalogs and folders, just as you would browse through folders in Windows, to locate 
the binder you want to process.

As a Vantage operator, you can view only those catalogs that the domain administrator 
permits you to see. The following are some of the controls that determine which 
catalogs and binders you can view:

• Workflow designers and Vantage administrators create catalogs and folders.

• Workflow designers specify which catalog to register the binder in (using the Regis-
ter action) when a workflow is executed.

• Vantage administrators define which Workflow Portal configurations you can 
access and which catalogs you can view.

Thus, Workflow Portal gives you access to only those binders that have been registered 
in a Vantage catalog to which you have access in Workflow Portal.
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Workflow Design Guidelines
This topic is for those who are designing and implementing workflows. It provides 
guidelines for creating workflows intended for use in Workflow Portal applications.

 While you can use a single workflow to produce and distribute media, there are some 
significant advantages to dividing the media processing into multiple workflows. 
Dividing processing into distinct, separate workflows reduces workflow complexity. It 
also implements operator intervention for QA tasks, setting mark-in and mark-out 
points, and for adding/editing metadata prior to job submission for further processing.

For example, an ingest workflow can automatically analyze source media and detect 
media attributes and characteristics such as frame rate, dimensions, letterboxing, and 
macroblocking. You typically use Register actions in the ingest workflow, to create 
binders in Vantage catalogs, where operators will look for files to process. The ingest 
workflow can do this while you are performing other tasks, which improves efficiency. 

Ingest workflows can also produce proxy media that you can view with the Workflow 
Portal media viewer to evaluate quality issues and quickly define timecodes for trim 
points or commercial insertion. Using a single tool—Workflow Portal—for media 
evaluation and submission also improves efficiency.

A target workflow is a workflow designed to process media submitted by Workflow 
Portal operators. Target workflows always start with a Receive action so that operators 
can submit jobs to them (and they must be running). When your application calls for an 
ingest workflow, you use Workflow Portal to evaluate the ingest workflow results, take 
any action required, and then submit the job to a target workflow. Frequently, a given 
application has more than one target workflow. You can also chain target workflows, 
providing operator intervention at more than one point in the process.

If your process does not require an ingest workflow, you might use Workflow Portal (in 
a Browse Windows configuration) to submit jobs to a target workflow, rather than just 
placing media files in a watch file for automated processing. The advantage to operator 
submission is that you can set metadata labels and variables during submission, 
providing more control over target workflow processing.

The following topics provide guidelines for creating workflows for use with Workflow 
Portal:

 Ingest Workflow Guidelines

 Target Workflow Guidelines
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Ingest Workflow Guidelines
When you use an ingest workflow, you must provide a Register action (which can be 
located anywhere in the workflow), to create a binder in a catalog. One binder is 
created for each job that executes. In addition to recording each file referenced or 
created in the workflow, metadata labels which you specify are stored in the binder, 
along with variables. 

You can use the special nicknames Vantage EDL, Vantage Proxy, and Vantage Thumbnail 
in Workflow Portal ingest workflows Flip action for identifying specific-purpose files:

• Vantage EDL—in the Program Stream and Transport Stream encoders

• Vantage Proxy—in the QuickTime and the MP4 encoders

• Vantage Thumbnail—in the Keyframe encoder

When you browse catalogs in Workflow Portal, you can view binders created by each 
job, giving you access to all resources defined in the binder.

When building ingest workflows, consider the following guidelines:

• To make a binder available to Workflow Portal operators, use a Register action to 
save the binder in the appropriate catalog.

• The required proxy format for the Workflow Portal Windows client media viewer is 
H.264/AAC QuickTime encoded in the QuickTime encoder. Configure container set-
tings to generate a timecode track—this supports the Use Clip Start Time feature.

• Use the Flip action to produce proxy media for previewing in the Workflow Portal 
Web client’s HTML5 Media viewer, using these settings:

Encoder: MP4 Encoder

Video Codec: x264

Audio Codec: AAC

Container: MP4 File

Make sure that your encoded proxy file is the same frame rate and timecode nota-
tion as your production media.

• To enable a selected binder’s media file to automatically display in the Workflow 
Portal media viewer, assign the Vantage Proxy file nickname to the media file. 

• To support operator viewing of binders by thumbnail (instead of by name), config-
ure a Flip action with the Keyframes encoder to create a thumbnail that uses the 
Vantage Thumbnail file nickname.

• If you want the workflow to make media information available to operators, config-
ure Identify and Examine actions to collect that information, and use metadata 
labels to store that information in the binder.
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Target Workflow Guidelines
Unlike ingest workflows, target workflows are publishing workflows; they can be 
designed and configured in almost any way you require. There is no limit imposed on 
the design of a target workflow that happens to be used by Workflow Portal.

When you configure target workflows, follow these guidelines:

• The target workflow must start with a Receive action so that an operator can sub-
mit media to it for processing.

• The target workflow must be configured to accept and process any metadata labels 
and variables that an operator enters.

• Add information here about the special nicknames for DPP
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Starting a Workflow Portal Session
The following topics describe how to start sessions with the Workflow Portal clients, 
and how to change configurations:

 Starting a Session with the Windows Client

 Starting a Session with the Web Client

Starting a Session with the Windows Client
To start a session with the Workflow Portal Windows client, do the following:

1. Start the Windows client as described in Starting Workflow Portal.

2. If you are prompted to select a Vantage domain, select a domain as described in 
Selecting the Domain.

If you do not know the Vantage domain name, contact your Vantage domain 
administrator.

3. If you are prompted to enter a Vantage user name, log in as described in Changing 
Vantage Users in Windows Client Programs.

If you do not know your Vantage user log in information, contact your Vantage 
domain administrator.

4. If you are prompted to select a Workflow Portal configuration, select the 
configuration you want to use for this session.

To change the Workflow Portal configuration, see Changing or Reloading a 
Configuration.

Starting a Session with the Web Client
To start a session with the Workflow Portal Web client, do the following:

1. Start the Web client as described in Starting & Stopping Vantage Web Applications.

2. If you are prompted to select a Vantage domain, select a domain as described in 
Logging into or Changing Domains from Web Applications.

If you do not know the Vantage domain name, contact your Vantage domain 
administrator.

3. If you are prompted to enter a Vantage user name, log in as described in Changing 
Vantage Users in Web Applications.

If you do not know your Vantage user log in information, contact your Vantage 
domain administrator.

4. If you are prompted to select a Workflow Portal configuration, select the 
configuration you want to use for this session.

To change the Workflow Portal configuration, see Changing or Reloading a 
Configuration, below.
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Changing or Reloading a Configuration
You can change Workflow Portal configurations while you are running Workflow Portal.

If a Vantage domain administrator updates a Workflow Portal configuration while you 
are using it, the program continues to use the configuration as it was when you 
selected it. To obtain the updated version, reload it when advised by the administrator.

 Changing/Reloading a Configuration in the Windows Client

 Changing/Reloading a Configuration in the Web Client

Changing/Reloading a Configuration in the Windows Client
To change or reload a configuration in the Windows client, do the following:

1. Select File > Change/Reload Application Configuration.

2. When the Select Configuration dialog appears, select a configuration to use and 
click OK.

Changing/Reloading a Configuration in the Web Client
To change or reload a configuration in the Web client, do the following:

1. Select Portals.

2. Select the configuration to which you want to change.

3. When the confirmation dialog appears, click OK.
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Using Workflow Portal Configurations
When you start Workflow Portal, you must select a configuration before you can 
process media. These configurations are defined by the Vantage domain administrator 
in conjunction with a workflow designer, so that the configuration—including catalogs, 
metadata, and variables—performs correctly with the ingest and target workflows’ 
functionality.

Each Workflow Portal configuration is based on a specific type of configuration that 
determines fundamentally how a Workflow Portal session operates—which user 
interface components to display, and what features to enable or disable. 

Note: Once you have selected a configuration, each time you launch Workflow Portal 
it uses the configuration that was last used. (To switch configurations, see Changing or 
Reloading a Configuration.)

A Vantage administrator can make and use as many of each type of configuration as 
necessary, each configured to suit specific media processing application. 

 Using Copy Binder and Forward Binder Configurations

 Using Browse Windows Network Configurations

 Using Create EDL Configurations

 Using Create CML Configurations

 Using Create DPP Configurations
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Using Copy Binder and Forward Binder Configurations
In a Copy Binder configuration, the operator browses a catalog, selects a binder, and 
submits the job—optionally reviewing/editing metadata variables—after clicking the 
Submit button. When the Submit button is clicked, the binder is duplicated—leaving 
the original binder intact in the catalog for future use or re-submittal. (If you may ever 
need to use the copied binder later—in case of an error, for example, you should also 
use a Register action in the target workflow to register the new binder in a catalog).

In contrast to a Copy Binder configuration, in a Forward Binder configuration, the 
operator browses a catalog, selects a binder, optionally reviews/edits metadata and 
variables—before clicking the Submit button. Workflow Portal submits the original 
binder—without making a copy. If you don’t need the binder after processing, you can 
automatically or manually delete it.

Here are the differences between Copy Binder and Forward Binder configurations:

• Copy Binder—you click the Submit button before you edit metadata—because 
you’re using a copy of the original binder, which is created when you click Submit.

• Forward Binder—you can select multiple binders and submit them at the same time 
(Windows client only) and you edit metadata before submitting the job.

Depending on how the configuration has been set up, there will be variations in the 
features that are enabled, and the tasks you can perform. 

Copy Binder Job Submittal Process
In the figure below, media is submitted to an ingest workflow, which registers the 
output media into a specific Vantage binder. The operator, in Workflow Portal, selects 
the binder, clicks Submit and performs tasks as appropriate. 

Figure 145. Copy Binder Configuration Typical Workflow Process
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Next, the operator submits the job to a publishing workflow.

Forward Binder Job Submittal Process
In the figure below, media is submitted to an ingest workflow, which registers the 
output media into a specific Vantage binder. The operator, in Workflow Portal, selects 
the binder, clicks Submit and performs tasks as appropriate. 

Figure 146. Forward Binder Configuration Typical Workflow Process

Next, the operator submits the job to a publishing workflow.

Job Submittal Steps
Whether you are using a Copy Binder or Forward Binder configuration to process 
media, an operator follows this general process to submit a job (for details, click on the 
link.):
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2. Browse catalogs to select a binder (Selecting Binders).
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dialog.

5. Preview media and create mark-in/mark-out edits (Previewing Video in the Media 
Player).

6. In the Media Files tab, check the files to submit (Specifying Media Files).

7. In the Metadata tab, review/edit metadata (Configuring Metadata Labels).
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8. In the Variables tab, enter values for each variable (Specifying Variable Values).

9. In a Forward Binder configuration, click the Submit button to submit the job.
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Using Browse Windows Network Configurations

Note: This configuration can only be used in the Workflow Portal Windows client.

The Browse Windows Network configuration allows you to select one or more media 
files from servers on a Windows network and submit them to target workflows, 
depending on how the configuration is set up. If the configuration permits, you can 
also edit metadata labels and variables to be submitted with the media.

The Browse Windows Network configuration is a Create Binder style configuration. 
Because you are selecting a media file outside of Vantage, when you click the Submit 
button, Workflow Portal creates the binder and displays a workspace which allows you 
to proceed with the task of reviewing media, updating metadata, etc., before 
submitting the job. Browse Windows Network configurations can be set up to submit 
to required workflows or operator-selected workflows.

Figure 147. Browse Network Configuration Typical Workflow Process

Workflow Portal displays a Browse button and a list of selected files—instead of a 
Vantage Catalog list—as shown in Figure 148.
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Figure 148. Browse Windows Network Configuration

1. Click the Browse button.

Workflow Portal displays the Select media file(s) to submit dialog shown in 
Figure 149.

Figure 149. Select Media Files to Submit Dialog

2. Use the Select media file(s) to submit dialog to select file(s).
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3. Click Open.

Each file that you open displays in the Select media file(s) list.

Repeat the Browse process to select and add more files from multiple directories.

If the file list is not correct, you can edit the list manually. For example, you can 
select a given file path and delete it. Or, you can edit a path or filename, copy and 
paste file paths, or add new ones. To delete the list entirely, click Clear.

4. If check boxes are enabled in the Target Workflows list, check any target workflow 
to which you want to submit the media in the list.

If a checked box is not editable, this is a required workflow for this configuration.

5. Click Submit.

If the configuration does not provide any additional configuration options, Work-
flow Portal submits the selected media files to each of the selected Target Work-
flows.

6. If the configuration supports metadata labels or variables, Workflow Portal displays 
the Submit Jobs dialog with tabs for these options. For information on configuring 
these options, refer to Configuring Metadata Labels and Specifying Variable Values.

7. When you are done preparing for submission, click Submit.
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Using Create EDL Configurations

Note: Create EDL configurations can only be used in the Workflow Portal Windows 
client.

The Create EDL configuration enables you to create an Edit Decision List (EDL) which 
you submit to Flip-based workflows that processes the EDL. When creating an EDL, you 
select the clips to submit by browsing and selecting binders created from previously-
completed jobs. You can mark start and end points to clip your input media files, and 
then stitch the selected clips together in the workflow to which you submit the EDL. 

Figure 150. Create EDL Configuration Typical Workflow Process

The Create EDL configuration is a Create Binder style configuration: because a new 
binder must be created in order to submit the job, the operator clicks Submit first (to 
create the binder), then proceeds with the task of reviewing media, updating metadata 
etc., before submitting the job.

Stitching media using an EDL involves three steps:

1. Preparing Media for Stitching

2. Creating the EDL

3. Stitching the Media

After you have prepared all of the media you want to stitch, you open Workflow Portal 
with a Create EDL Configuration to create your EDL and submit it for processing. When 
submitted, the files are clipped to the EDL settings and merged together into a single 
output file by the target Vantage workflow.
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Preparing Media for Stitching
To prepare media for stitching via an EDL, create an ingest workflow to encode it as 
required and register it in a catalog, following these guidelines:

• All media must have the same frame rate, timecode notation, and frame size.

• Use a Flip action to encode your production media using one of these encoders: 

– MPEG-2 Program Stream

– VOD/MPEG-2 Transport Stream

– MXF

The output media must use the nickname Vantage EDL, so that the EDL configura-
tion can identify which media file to use for stitching.

• Use a Flip action to encode your proxy media for previewing/clipping.

– Encoder: QuickTime Encoder

– Video Codec: H.264

– Audio Codec: AAC

– Container: MOV File

 Assign the nickname Vantage Proxy, so that the media player can play it.

Note: Be sure to encode proxies at the same rate and timecode notation as your 
production media. Clips that you mark use the proxy timecode—Workflow Portal 
applies it to the Vantage EDL media.

• Use a Keyframe action to produce keyframes—configured with the Keyframe 
encoder. Assign the nickname Vantage Thumbnail.

• Register the job in your target catalog to make it available in Workflow Portal.

Note: Create EDL configurations expect binders to have media identified as Vantage 
EDL, Vantage Proxy, and Vantage Thumbnail. If you don’t follow these guidelines, the 
binders may not display in the catalog, you won’t be able to view the proxy to set 
mark-in/mark-out points, view keyframes, and your stitch workflow may fail.

Creating the EDL

Note: Microsoft User Account Control, by default, prevents Windows programs (such 
as the Workflow Portal Windows client) from writing files in certain protected folders. 
Workflow Portal writes files in Create EDL, Create CML, and Create DPP configurations.
If you receive an error message that access to a particular Vantage store or folder is 
denied, contact your Vantage administrator. 
Solutions include changing the location of the store/folder or disabling UAC on 
Vantage Windows client computers.

When you are using a Create EDL configuration, the Create EDL Workspace displays:
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Figure 151. Workflow Portal in a Create EDL Configuration

To create an EDL, do the following:

1. Browse the binders in the selected catalog, and add clips to the EDL list.

2. Optionally, set the start and end times for each clip in the list.

The following topics describe how to create the EDL:

 Adding Clips

 Evaluating Clip Content

 Editing Clip Start and End Times

 Deleting Clips

 Reordering Clips

Adding Clips

You can add multiple clips to an EDL, and you can add the same clip multiple times. 

Note: If you do not want to combine clips in one file, you can clip the same file 
multiple times. For example, if you are extracting multiple highlights from a single 
media file, you can mark a highlight, select Submit, and then mark a new highlight 
without affecting the first one.

To add a clip to the EDL, select the catalog, then select clip in the Binder list or the 
Nickname list and click the Add button  below the Create EDL tab.
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Note: An EDL must be comprised of media file clips that have the same frame size 
and frame rate.

When you add the first clip to the EDL, the frame size and rate of the EDL are set to the 
metrics of that clip. Once the frame size and rate are set for an EDL, Workflow Portal 
does not allow you to add an incompatible clip. If you select a binder with a clip that is 
incompatible, the Add button is disabled to indicate that the clip cannot be added.

Evaluating Clip Content

After you select the first clip for an EDL, Workflow Portal displays the clip information in 
the EDL Configuration portion of the window. The EDL configuration information 
includes the frame size and the frame rate, as well as other information about the 
selected clip. The frame rate also appears in the Selected Clip portion of the window.

When multiple clips are present in the EDL, click on any clip to display the clip 
information in the EDL Configuration area.

Editing Clip Start and End Times

The default clip start and end times are the start and end times defined in the source 
media file. To display an entire clip, no change is necessary. To display a portion of a clip, 
edit the start and end times to define the clip you want in your EDL.

To change the clip start time do any of the following:

• Use the media viewer to select the start time and frame, then click the Mark button 
for the Mark In time.

• Click in the Mark In time setting and press CTRL-M.

• Type time or frame values in the Mark In time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark In time setting, click one of the numbers and use the up and down con-
trols to change the value.

To change the clip end time do any of the following:

• Use the media viewer to select the end time and frame, then click the Mark button 
for the Mark Out time.

• Click in the Mark Out time setting and press CTRL-M.

• Type time or frame values in the Mark Out time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark Out time setting, click one of the numbers and use the up and down 
controls to change the value.

• Adjust the duration timecode, which adjusts the mark out point relative to the mark 
in point. This field indicates the duration of the media between the mark in/out 
points of the currently selected clip.
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If you specify a mark in, mark out, or duration timecode that makes one or more of the 
timecodes invalid, the affected timecodes display a red background. For example if you 
select a Mark In timecode that starts after the Mark Out timecode, the Mark In and 
Duration timecodes display red. Also, if the duration timecode moves the mark out 
timecode beyond the end of the clip timeline, both the Duration and Mark Out fields 
display red to indicate the error.

Reordering Clips

To change the order of a clip in an EDL list, click on the clip and click the up  and 
down  buttons to change the clip position.

Deleting Clips

To delete a clip from an EDL, click on the clip and click the Delete button .

Stitching the Media
The Edit decision list (EDL) files created in Workflow Portal are only processed by Flip 
action-based workflows. After creating your EDL, submit it using these steps:

1. Make sure that your stitching workflow is active.

2. Click on the Forward to Workflow tab, which lists all workflows that you are 
permitted to submit this file to for processing.

3. Click Submit. If variables are included in this configuration, Workflow Portal displays 
the Variables window, where you can supply run-time values.

4. Any nickname can be assigned to the TSEDL file to be picked up in the target 
publishing workflow.
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Using Create CML Configurations
The Create CML configuration is designed to allow you to select a Composition (CML) 
file which you submit to Post Producer workflows with a Conform action. The Conform 
action processes the compositions you submit, and renders a single media file as 
output, based on the specifications in the CML.

Workflow Portal also supports EDL processing (using the Flip action), with similar 
functionality. However, the primary difference—and advantage—of using a CML 
workflow is that you can reference clips with mixed essences. The EDL configuration 
requires that all clips have the same frame rate, frame size and video codec; CML does 
not have this restriction. Composition processing also improves VANC and caption 
processing.

Note: Create CML (Composition Markup Language) configurations can only be used 
in the Windows client. For details on using Post Producer and compositions, see the 
Post Producer Developer’s Guide.

The Create CML configuration is a Create Binder style configuration: because a new 
binder must be created in order to submit the job, the operator clicks Submit first (to 
create the binder), then proceeds with the task of reviewing media, updating metadata 
etc., before submitting the job.

Figure 152. Create CML Configuration Typical Workflow Process

To automatically create the CML, you select the clips to submit by browsing and 
selecting binders created from previously-completed jobs. You can mark start and end 
points on your input media files, and then submit the CML to a Conform action 
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Compositions (Composition Markup Language files)—or CMLs for short—should be 
created for stitching media when you want to use a Conform action to encode your 
final media, rather than using a Flip action. Use of the Conform action requires a Post 
Producer license.

Stitching media from a composition involves three steps:

1. Preparing Media for Stitching

2. Creating the Composition

3. Stitching the Media

After you have encoded all of the media you want to use for your composition, you 
open Workflow Portal with the proper Create CML configuration, select each clip and 
optionally mark them, and the submit the CML for processing. When submitted, the 
files are encoded together into a single output file by the target Vantage workflow.

Preparing Media for Stitching
To prepare media for stitching using a composition, create an ingest workflow to 
encode the media as required and register it in a catalog, following these guidelines:

• Assign the output media the nickname Original so that the Create CML configura-
tion can identify which media file to use when it generates the CML file. 

• Since you can’t use the same nickname on input and output media in the same 
action, simply assign the input file a nickname other than Original.

• Use a transcode action (the Flip action, typically) to encode your media into one of 
the supported Post Producer formats (which accepts a much broader set of video, 
audio, and container formats than the Flip action does for EDL processing). See Post 
Producer Developer Guide Formats in the Post Producer Developer’s Guide or the 
Products > Post Producer > Specs page on the Telestream Web site.

• Use a Flip action to encode your proxy media for previewing/clipping.

– Encoder: QuickTime Encoder

– Video Codec: H.264

– Audio Codec: AAC

– Container: MOV File

 Assign the nickname Vantage Proxy, so that the media player can play it.

Note: Make sure that you encode the proxy at the same rate and with the same 
timecode notation as your production media.

• Use a Flip action to create thumbnails.

– Encoder: Keyframe Encoder

– Video Codec: JPEG

– Container: JPEG File

 Assign the nickname Vantage Thumbnail, to display them in Workflow Portal.

http://www.telestream.net/post-producer/tech-specs.htm
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• Register the media in your target catalog to make it available in Workflow Portal.

Note: If you don’t follow these guidelines, the binders may not display in the catalog, 
you may not be able to set mark-in/mark-out points, and your stitch workflow may fail.

Creating the Composition

Note: Microsoft User Account Control by default prevents Windows programs (such 
as the Workflow Portal Windows client) from writing files in certain protected folders. 
Workflow Portal writes files in Create EDL, Create CML, and Create DPP configurations.
If you receive an error message that access to a particular Vantage store or folder is 
denied, contact your Vantage administrator. 
Solutions include changing the location of the store/folder or disabling UAC on 
Vantage Windows client computers.

When you are using a Create CML configuration, the Create CML Workspace displays:

Figure 153. Workflow Portal in a Create CML Configuration

To create a composition, do the following:

1. Browse the binders in the selected catalog, and add clips to the CML playlist.

2. Organize them in order by dragging them into place in the playlist.

3. Optionally, preview the clip and set the start and end times for trimming.
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The following topics describe various tasks involved in creating a CML file:

 Adding Clips

 Evaluating Clip Content

 Editing Clip Start and End Times

 Reordering Clips

 Deleting Clips

Adding Clips

You can add multiple clips to a composition, and you can add the same clip multiple 
times. When submitted, the clip files are trimmed to the CML settings and merged 
together into a single output file by the target Vantage workflow.

Note: If you do not want to combine clips in one file, you can clip the same file 
multiple times. For example, if you are extracting multiple highlights from a single 
media file, you can mark a highlight, select Submit to Workflow, and then mark a new 
highlight without affecting the first one.

To add a clip, select the clip in the Binder list or the Nickname list and click the Add 
button  below the Create CML tab.

Evaluating Clip Content

After you select the first clip for a composition, Workflow Portal displays the clip 
information in the CML Configuration portion of the window. The CML configuration 
information includes the frame size and the frame rate, as well as other information 
about the selected clip. The frame rate also appears in the Selected Clip portion of the 
window.

When multiple clips are present in the composition, click on any clip to display the clip 
information in the CML Configuration area.

Editing Clip Start and End Times

The default clip start and end times are the start and end times defined in the source 
media file. To display an entire clip, no change is necessary. To display a portion of a clip, 
edit the start and end times to define the clip you want in your composition.

To change the clip start time do any of the following:

• Use the media viewer to select the start time and frame, then click the Mark button 
for the Mark In time.

• Click in the Mark In time setting and press CTRL-M.

• Type time or frame values in the Mark In time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark In time setting, click one of the numbers and use the up and down con-
trols to change the value.
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To change the clip end time do any of the following:

• Use the media viewer to select the end time and frame; then click the Mark button 
for the Mark Out time.

• Click in the Mark Out time setting and press CTRL-M.

• Type time or frame values in the Mark Out time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark Out time setting, click one of the numbers and use the up and down 
controls to change the value.

• Adjust the duration timecode, which adjusts the mark out point relative to the mark 
in point. This field indicates the duration of the media between the mark in/out 
points of the currently selected clip.

If you specify a mark in, mark out, or duration timecode that makes one or more of the 
timecodes invalid, the affected timecodes display a red background. For example if you 
select a Mark In timecode that starts after the Mark Out timecode, the Mark In and 
Duration timecodes display red. Also, if the duration timecode moves the mark out 
timecode beyond the end of the clip timeline, both the Duration and Mark Out fields 
display red to indicate the error.

Reordering Clips

To change the order of a clip, click on the clip and click the up  and down  buttons 
to change the clip position.

Deleting Clips

To delete a clip, click on the clip and click the Delete button .

Stitching the Media
Composition (CML) files are processed by Conform-based workflows to generate the 
media, and it requires a Post Producer license. After creating your composition, submit 
it using these steps:

1. Make sure that your stitching workflow is active.

2. Click on the Forward to Workflow tab, which lists all workflows that you are 
permitted to submit this file to for processing.

3. Click Submit. If variables are included in this configuration, Workflow Portal displays 
the Variables window, where you can supply run-time values.

Variables are used to transfer run-time data into a workflow. 
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Using Create DPP Configurations
The purpose of the DDP configuration is to enable operators to assemble and produce 
media files that conform to the current DPP standard, for broadcast in the UK market.

Note: This configuration can only be used in the Workflow Portal Windows client.

You use a Create DPP configuration to view and select binders from completed ingest 
workflows jobs, enter metadata and mark programme parts, then generate DPP-
compliant media which comprises the programme. A Create DPP configuration defines 
each field of DPP metadata in the programme, may be given a default value, and may 
be marked as read-only. In addition, the portal may be configured for either SD or HD.

Figure 154. Create DPP Configuration Typical Workflow Process

The Create DPP portal is designed to allow you to:

• Create a DPP programme containing one or more segments

• Enter DPP metadata to accompany that programme

• Create a DPP XML file and a Composition (CML) file from which to generate the pro-
gramme’s media file (with Post Producer) and transcode to AS-11 with DPP meta-
data (with a Vantage Transcode Pro license).

Note: You can add a DPP Validate action (located in the Analysis group) to your target 
workflow to validate metadata in a DPP package.

The Create DPP configuration is a Create Binder-style configuration: because a new 
binder must be created in order to submit the job, the operator clicks Submit first (to 

Update
Metadata

Set Trim
Points

Broadcast Operator

Vantage Domain

On-Air
Server

DPP Package
Production
Workflow

Media
Ingest

Workflow

Workflow
Portal

Operator: 
Select Media for Package
Set Trim Points
Update Metadata

DPP Catalog

Programme 
Clips

Submit
Files

DPP Job

XMLXML
Metadata
File

XMLXML
CML File

DPP Package

Binder



Using Workflow Portal
Using Workflow Portal Configurations

281
create the binder), then proceeds with the task of reviewing media, updating general 
and DPP metadata and DPP options, before submitting the job.

Creating a DPP-compliant media package involves these steps:

1. Preparing Media for the Package

2. Creating the Composition

3. Stitching the Media

After you have prepared the media you want to include in the package, you open 
Workflow Portal with the proper Create DPP configuration to create your DPP package, 
enter metadata as required, and submit it for processing. The files are submitted to the 
target Vantage workflow for producing the package.

Preparing Media for the Package
To prepare media for stitching with a Composition, create an ingest workflow to 
encode the media as required and register it in a catalog, following these guidelines:

Note: If you don’t follow these guidelines, the binders may not display in the catalog, 
you may not be able to set mark-in/mark-out points, and your stitch workflow may fail.

• All output media must have the same frame rate, timecode notation, and frame 
size.

• Use one of the transcode actions to encode your media into one of the supported 
Post Producer formats for the Conform action, in the frame rate you’ll be encoding 
in the publishing workflow (typically, 50 mbps). See the Post Producer Developer 
Guide Formats chapter or the Products > Post Producer > Specs page on the 
Telestream Web site.

• The encoded media must use the nickname Original.

Encode your production media with these requirements: 

– Frame rate must be 50i (you can cannot use NTSC or film material).

– Audio must be configured correctly for the DPP specification being published. 
For example, you must place Dolby Surround Sound on channels 1-6 if the 
output is audio configuration R123: 16d.

• Audio loudness correction must be applied.

Note: These requirements may be met as part of an ingest workflow or met in some 
other manner external to Vantage, but they must be met prior to including the media 
in a DPP package.

– VOD/MPEG-2 Transport Stream

– MXF

The output media must use the nickname Vantage EDL, so that the EDL configura-
tion can identify which media file to use for stitching.

http://www.telestream.net/post-producer/tech-specs.htm
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• Use a Flip action to encode your proxy media at 25fps, for previewing/clipping.

– Encoder: QuickTime Encoder

– Video Codec: H.264

– Audio Codec: AAC

– Container: MOV File

 Assign the nickname Vantage Proxy, so that the media player can play it.

Note: Make sure that you encode proxies at the same frame rate and timecode 
notation as your high resolution media, typically 25 fps.

• Use a Keyframe action to produce keyframes—configured with the Keyframe 
encoder. Assign the nickname Vantage Thumbnail.

• Register the binder in your target catalog to make it available in Workflow Portal.

Compositions should be created for stitching media when you want to use a Conform 
action to encode your media, rather than using a Flip action.

Creating the Composition

Note: Microsoft User Account Control by default prevents Windows programs (such 
as the Workflow Portal Windows client) from writing files in certain protected folders. 
Workflow Portal writes files in Create EDL, Create CML, and Create DPP configurations.
If you receive an error message that access to a particular Vantage store or folder is 
denied, contact your Vantage administrator. 
Solutions include changing the location of the store/folder or disabling UAC on 
Vantage Windows client computers.

When you are using a Create DPP configuration, the Create DPP Workspace displays:
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Figure 155. Workflow Portal in a Create DPP Configuration

You use the configuration to enter metadata and prepare the package. Each DPP file 
may contain one or more parts, or sections. If there are multiple parts, then the timeline 
will have a slate between each part. Metadata must be entered and validated before 
you can submit a job.

When you submit a job in the DPP Portal configuration, Workflow Portal creates a CML 
file for Post Producer, (nicknamed DPP CML) and an XML file with the DPP metadata, 
(nicknamed DPP XML). The CML file (via the Conform action) assembles the correct 
timeline for a DPP asset including a slate, bars, tone, and breaks between parts.

The XML is used by the AS-11 encoder to insert metadata into the output. The output 
must have a start timecode of 09:59:30:00@25.

Each part starts at one minute boundaries (the first part at 10:00:00:00, the second 
might be 10:06:00:00 or some other one-minute timecode).

To create a composition, do the following:

1. Browse the binders in the selected catalog, and add clips to the CML list to create 
the set of parts the comprise the media.

2. Set the start and end times for each clip in the list, as required.

3. Add/edit metadata for the DPP package.

4. Set your DPP options as required, optionally creating a custom slate

5. Submit the job to the appropriate publishing workflow.
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The following topics describe how to create a CML file:

 Adding Clips to a Composition

 Evaluating Clip Content

 Editing the Clip Start and End Times

 Deleting Clips from the Composition

 Reordering Clips in the Composition

Adding Clips to a Composition

You can add multiple clips to a composition, and you can add the same clip multiple 
times. When submitted, the clip files are trimmed to the CML settings and merged 
together into a single output file by the target Vantage workflow.

Note: If you do not want to combine clips in one file, you can clip the same file 
multiple times. For example, if you are extracting multiple highlights from a single 
media file, you can mark a highlight, select Submit, and then mark a new highlight 
without affecting the first one.

To add a clip, select the clip in the Binder list or the Nickname list and click the Add 
button  below the Create CML tab.

Evaluating Clip Content

After you select the first clip for a composition, Workflow Portal displays the clip 
information in the CML Configuration portion of the window. The CML configuration 
information includes the frame size and the frame rate, as well as other information 
about the selected clip. The frame rate also appears in the Selected Clip portion of the 
window.

When multiple clips are present in the composition, click on any clip to display the clip 
information in the CML Configuration area.

Editing the Clip Start and End Times

The default clip start and end times are the start and end times defined in the source 
media file. To display an entire clip, no change is necessary. To display a portion of a clip, 
edit the start and end times to define the clip you want in your composition.

To change the clip start time do any of the following:

• Use the media viewer to select the start time and frame, then click the Mark button 
for the Mark In time.

• Click in the Mark In time setting and press CTRL-M.

• Type time or frame values in the Mark In time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark In time setting, click one of the numbers and use the up and down con-
trols to change the value.
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To change the clip end time do any of the following:

• Use the media viewer to select the end time and frame; then click the Mark button 
for the Mark Out time.

• Click in the Mark Out time setting and press CTRL-M.

• Type time or frame values in the Mark Out time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark Out time setting, click one of the numbers and use the up and down 
controls to change the value.

• Adjust the duration timecode, which adjusts the mark out point relative to the mark 
in point. This field indicates the duration of the media between the mark in/out 
points of the currently selected clip.

If you specify a mark in, mark out, or duration timecode that makes one or more of the 
timecodes invalid, the affected timecodes display a red background. For example if you 
select a Mark In timecode that starts after the Mark Out timecode, the Mark In and 
Duration timecodes display red. Also, if the duration timecode moves the mark out 
timecode beyond the end of the clip timeline, both the Duration and Mark Out fields 
display red to indicate the error.

Deleting Clips from the Composition

To delete a clip, click on the clip and click the Delete button .

Reordering Clips in the Composition

To change the order of a clip, click on the clip and click the up  and down  buttons 
to change the clip position.

Stitching the Media
Composition (CML) files can only be processed by Conform-based workflows, and 
requires a Post Producer license. After creating your composition, submit it using these 
steps:

1. Make sure that your stitching workflow is active.

2. Click on the Forward to Workflow tab, which lists all workflows that you are 
permitted to submit this file to for processing.

3. Click Submit.
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Performing Key Workflow Portal Tasks
The following topics describe how to use the major components that comprise 
Workflow Portal, to perform these key tasks:

 Selecting Binders

 Previewing Video in the Media Player

 Configuring Metadata Labels

 Specifying Media Files

 Specifying Variable Values

 Submitting a Job to Workflows

 Initiating Binder Submission in the Windows Client

 Initiating Binder Submission in the Web Client
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Selecting Binders
You can browse catalogs and select binders in all configurations except Browse 
Windows Network configurations.

Note: The binder list doesn’t automatically update when binders are added or 
deleted. To update the list, click the Refresh button at the top of the Binder table.

Depending on your configuration, you may be able to perform the following:

• Manually delete binders

• Select specific media in a binder for submission

• Browse and select binders from multiple catalogs

• View the list of media in a selected binder

Selecting a Binder
To select a binder, do the following:

1. If the Catalogs panel (in the top left corner of the window—see Figure 156 for the 
Windows client or Figure 157 for the Web client) displays, select the catalog or 
catalog folder you want to browse.

Note: The catalogs that you can access are specified in the configuration. The catalog 
browser may be hidden, when the configuration only allows access to one catalog, 
with no subfolders.

2. In the Binder table (directly above the tabbed workspace—upper right—displays 
the name of the catalog you are browsing), select the binder that you want to view.

In the Windows client (see below), use the Filter menu, located directly above the 
Binder Details panel, to help you filter binders. Use the Details menu (far right) to 
select Details or Thumbnails view.

The columns that display in this table are controlled by the configuration, and may 
include Binder Name, Created, Expiration, and the Play button and Submit button, 
and others.



Using Workflow Portal
Performing Key Workflow Portal Tasks

288
Figure 156. Windows Client—Catalog and Binder Components

In the Web client (see below), use the Filter menu (directly above the Binder Details 
panel) to help you filter binders. To return to an unfiltered list and display all bind-
ers, click the Filter icon again. Use the Details menu (far right) to select Details or 
Thumbnails view. 

Catalogs Panel Binder or Thumbnail ListBinder Filter
Binder TableDelete BinderRefresh Binder
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Figure 157. Web Client—Catalog and Binder Components

3. Select a binder. When a binder is selected, Workflow Portal display its contents in 
the Binder Details panel directly below the Catalogs panel.



Using Workflow Portal
Performing Key Workflow Portal Tasks

290
Using Binder Table Controls
The Binder table supports the following features:

Filtering

Type text in the Filter field or select a previously-entered string from the menu to filter 
the binders in the currently-selected catalog. Delete the text to display all binders in the 
catalog.

Sorting and Re-arranging Columns

Click on any column heading to sort the binder list, and click repeatedly to toggle the 
sort by ascending or descending order. Drag column headings to re-arrange the order.

Playing/Pausing Video

If enabled in the configuration, you can click the Play/Pause button in a binder row to 
preview the media. Click Repeatedly to play or pause the video.

Submitting a Binder

If enabled in the configuration, you can click the Submit button to display the Submit 
Jobs window.

Details/Thumbnails View

Select Details or Thumbnails from the menu.
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Previewing Video in the Media Player
When you select a binder, Workflow Portal displays the file nicknamed Vantage Proxy in 
the media player. The contents of the binder may or may not display (directly above the 
media player), depending on the configuration. 

The following topics describe how to preview the media:

 Previewing Proxy Media in the Windows Client

 Previewing Proxy Media in the Web Client

 Previewing Non-proxy Media

Previewing Proxy Media in the Windows Client
When you preview proxy files in the Workflow Portal Windows client, you are utilizing 
the QuickTime Player. If you don’t have the QuickTime Player installed, you will have to 
download and install the player before you can preview these MOV files.

Figure 158. Windows Client—Media Player Controls

You should create a QuickTime H.264/AAC MOV file for previewing/clipping in the 
Windows client version of Workflow Portal. Use the QuickTime encoder, and configure 
the container settings to generate a timecode track. Make sure that your encoded 
proxy file is the same frame rate and timecode notation as your production media. 
Assign the nickname Vantage Proxy, so that the media player automatically loads and 
displays your proxy.

Telestream suggests that SD proxies (4:3) be set to a 640 x 480 frame size. For HD 
proxies (16:9), Telestream suggests a 640 x 360 frame size.

When you select a binder, Workflow Portal displays any video file nicknamed Vantage 
Proxy, if present. When media appears in the preview window, you can use the window, 
keyboard, and mouse controls listed in Table 6 to control playback. You can also 
preview other media in the nicknames list, if the QuickTime Player supports the format.
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Workflow Portal Keyboard Controls
The Windows client window, keyboard, and mouse controls are listed in Table 6.

Note: Clicking in the playback controls area, or on the video focuses the preview 
player controls (indicated by the blue focus border). Focusing this area is necessary for 
the “JKL” controls, and also allows you to use the Ctrl hot keys without pressing Ctrl.

Table 6. Player Controls & Keyboard Shortcuts for Windows Client Media Viewer

Function Controls

Play/Pause/Reverse Ctrl+P or Ctrl+Space

J (Reverse play—repeat for -1.5x, -2x, -5x, -8x)

K (Pause)

L (Play—repeat for 1.5x, 2x, 5x, 8x)

JK simultaneously (Reverse play slow motion -1/8x; repeat for -1/4x, -1/2x)

KL simultaneously (Forward play slow motion 1/8x; repeat for 1/4x, 1/2x)

Stop Ctrl+S

Forward Frame Ctrl+F

Ctrl + Mouse Wheel, one frame per wheel click

K held down + L (Forward bump one frame)

L held down with K already pressed (Forward bump repeat 1/4 speed)

Left Arrow (Reverse bump one frame)

Right Arrow (Forward bump one frame)

Forward/Reverse 10 
Frames

Up Arrow (Reverse bump 10 frames)

Right Arrow (Forward bump 10 frames)

Forward/Reverse One 
Second

Mouse Wheel (no modifier keys)—one second per wheel click

Forward/Reverse One 
Minute

Shift + Mouse Wheel—one minute per wheel click

Forward/Reverse One 
Hour

Ctrl + Shift + Mouse Wheel—one hour per wheel click

Reverse Frame Ctrl+B

Ctrl + Mouse Wheel, one frame per wheel click

K held down + J (Reverse bump one frame)

J held down with K already pressed (Reverse bump repeat 1/4 speed)

Mark In Ctrl+I or Ctrl+E
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Mark Out Ctrl+O or Ctrl+R

Go to mark in frame Ctrl+Q

Go to mark out frame Ctrl+W

Go to start Ctrl+Home

Go to end Ctrl+End

Audio Mute (toggle) Ctrl+M 

Adjust Volume Drag volume button right or left to adjust volume.

Scroll media Drag media button right or left to scrub (scroll) media.

Duplicate selected clip Ctrl+T (Selects the new clip and sets its mark in to the original clip’s mark 
out, if appropriate)

Table 6. Player Controls & Keyboard Shortcuts for Windows Client Media Viewer (Continued)

Function Controls
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Previewing Proxy Media in the Web Client
When you view proxy files in the Workflow Portal Web client, you are utilizing the native 
HTML5 Video Player in the Web browser.

Figure 159. Web Client—Typical HTML5 Player Controls

Note: The appearance of captions in the proxy may vary, depending on the browser 
you’re using. Try other supported browsers to find one that best suits your needs.
When playing to the end of a proxy in Chrome, versions 35 and 36, Telestream has 
observed that the media player may display an incorrect duration as a result of a 
round-up error. This anomaly is cosmetic. If you set this frame as a mark-out point, the 
correct timecode is entered by Workflow Portal.

Use the Flip action to produce an MP4 proxy file for previewing in the Workflow Portal 
Web client’s HTML5 Media viewer, using these settings:

• Encoder: MP4 Encoder

• Video Codec: x264

• Audio Codec: AAC

• Container: MP4 File

Make sure that your encoded proxy file is the same frame rate and timecode notation 
as your production media. Always use the Vantage Proxy nickname for the proxy file, so 
that the file automatically displays in the media player when you select a binder.

Telestream suggests that you generate SD proxies (4:3) at 640 x 480 frame size. For HD 
proxies (16:9), generate them at 640 x 360 frame size.

Note: You can right-click on the video to display a context menu with many player 
commands as an alternative to using the player controls or keyboard shortcuts. The 
available controls vary with the browser.

To view a proxy, select a binder and use the controls in Table 7 to control playback. 
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Previewing WebVTT Caption Files in the Web Portal Player
Vantage can process media containing closed captions and produce an output proxy 
file and an accompanying WebVTT caption file. The proxy may then be previewed with 
WebVTT captions in the Web Portal player within the Internet Explorer browser.

To create a proxy with WebVTT captions, follow these requirements:

• Use an Analyze action at ingest set to Ancillary Data Detection > Publish > Generate 
WebVTT Attachment to create a WebVTT file nicknamed Vantage Caption Source. 

• Use a Flip action to transcode the file using the MP4 x264 encoder set for 1080i with 
closed captions enabled. 

• Use a Register action to place the proxy and the WebVTT files in the same catalog. 

• Display the proxy with captions in the Web Portal Player. Be sure to set the player 
caption control in the gear menu to enable Closed Captions. 

• Only Internet Explorer supports this playback feature. 

Web Portal Keyboard Controls
The keyboard controls are dependent on the Web browser. (Most browsers provide fast 
forward, and some (such as Internet Explorer) provide reverse as well. Workflow Portal’s 
playback rates aren’t generally implemented in every step—usually only x2 and x8 are 
supported. 

Table 7. Player Controls & Keyboard shortcuts for HTML5 Video Viewer

Function Controls

Play   (appears in binder list)

Press L x 1—play 1x speed (normal).
Press L x 2—play 2x speed.
Press L x 3—play 3x speed.
Press L x 4—play 5x speed.
Press L x 5—play 8x speed.

(IE only) Click in the video region, then tap the + (plus) 
key to accelerate the clip’s play speed to the next level. 
Press the - (minus) key to decelerate the clip’s play speed 
down the next level. Using + and - keys may cause audio 
to mute.
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Reverse Play  

Press J x—reverse play.
Press J x 2—reverse play 2x speed.
Press J x 3—reverse play 3x speed.
Press J x 4—reverse play 5x speed.
Press J x 5—reverse play 8x speed.

(IE only) Click in the video frame, then press the + (plus) 
key to accelerate the clip’s play speed up to the next level. 
Press the - (minus) key to decelerate the clip’s play speed 
down the next level. Using + and - keys may cause audio 
to mute.

Stop/Pause

Press K—pause.

Press space bar— pause. (This only works when the play/
pause button has focus—that is, you have previously 
clicked it.)

Forward Frames

Press K then L—step forward one frame.

(IE only) Press the Right Arrow key—move forward 10 
frames. (This only works when the video frame has 
focus—that is, you have previously clicked it.)

Reverse Frames  

Tap K then J—move reverse one frame.

(IE only) Press the Left Arrow key to move reverse 10 
frames. (This only works when the video frame has 
focus—that is, you have previously clicked it.)

Go to start

(IE only) When the video frame has focus, press the Home 
key.

Go to end

(IE only) When the video frame has focus, press the End 
key.

Adjust Volume  

(IE only) Click in the video region, then:

Press the down arrow key—reduce volume.

Press the up arrow key—increase volume.

Table 7. Player Controls & Keyboard shortcuts for HTML5 Video Viewer

Function Controls
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Mute audio

(IE only) Press the M key.

Scroll media  

Full screen mode

Press this button to expand to full screen mode.

Zoom mode (IE 11 only) Click in the video frame, then press Z to zoom 
in. Press Z again to zoom back out. 

Video-safe overlay  

Click to display/hide the video safe overlay frame, for SD 
and HD proxies. 

Closed captioning  

Click to display closed captions, when provided by 
browser.

Audio track menu

When multiple audio tracks are present, the Audio menu 
displays. Click to select the track you want to hear. (IE only).

Table 7. Player Controls & Keyboard shortcuts for HTML5 Video Viewer

Function Controls
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Previewing Non-proxy Media

Note: This feature is only supported in the Windows client and only when the binder 
detail display is enabled in the configuration.

Media with a nickname other than Vantage Proxy may be played under certain 
conditions. Select the media in the binder list (directly above the media player) and try 
these methods:

1. For QuickTime (.mov) files, select the file and use the media player controls to play 
the media file.

2. To play a QuickTime file outside the embedded media player, right-click the media 
and select Open With Default Program or click the file icon directly above the 
binder list to play the media file in the default program for MOV files.

3. If you don’t have a default program assigned to handle MOV files, right-click the 
media asset, and select Open Containing Folder or click the folder icon directly 
above the binder list. The Windows folder containing the media opens, so you can 
right-click the file and play it using Open With to select a suitable program.

4. For files other than QuickTime, right-click the media and select Open With Default 
Program or click the file icon directly above the binder list to play the media file in 
the default program for the specified suffix of the file.

5. If you don’t have a default program assigned to play this file type, right-click the 
media asset, and select Open Containing Folder or click the folder icon directly 
above the binder list. The Windows folder containing the media opens, so you can 
right-click the file and play it using Open With to select a suitable program.
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Configuring Metadata Labels
When the configuration permits it, you can view and update the metadata labels 
ingested, produced, updated, or passed through previous workflows in Workflow 
Portal. 

Note: In a Forward Binder configuration, you edit metadata before submitting the 
binder to a publishing workflow. Changes are made in the binder you selected in the 
catalog. In a Copy Binder configuration, you click Submit and then enter metadata for 
the new binder you are creating. Your edits do not affect the original binder you 
selected from the catalog—only the new, copied binder.

When you submit a binder, all metadata labels are included. If the configuration 
supports metadata entry and editing, you can modify metadata labels before you 
submit. All metadata labels are applied to all media files that are being submitted.

The following topics describe how to edit metadata labels:

 Editing Metadata Labels with the Windows Client

 Configuring Metadata Labels with the Web Client

Editing Metadata Labels with the Windows Client
If the configuration supports metadata editing, you can edit them as follows:

1. Initiate submit mode as described in the appropriate one of the following topics:

–  Initiating Binder Submission in the Windows Client

– Initiating Binder Submission in the Windows Client

2. Select the Metadata Labels tab.

Figure 160. Submit Jobs Window, Browse Network Configuration

3. Select the label you want to edit from the Metadata Label list.

4. In the Parameter list to the right, edit the parameter values. 
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5. If the metadata label you want to configure does not appear in the Metadata Label 
list, click the new label button, select a label to add, and click OK.

Note: This option is not available when submitting files in a Browse Network 
configuration.

6. Repeat metadata label selection and parameter configuration until all required 
metadata labels are configured.

Editing Timecode Values with Hot Keys

If hot keys are assigned to input, output, or duration parameters in this configuration, 
you can use them to set these values as you scrub the media in the player. Roll over the 
mark button to display the assigned hot key in the tool tip.

Editing Timecode Values in Trim Groups

If trim groups are defined (a set of input, output, and duration parameters) in this 
configuration, the duration is automatically calculated. If you change the input value or 
output value, duration is automatically updated. If you change the duration value, the 
output value is automatically updated.
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Configuring Metadata Labels with the Web Client
If the configuration supports metadata editing, you can configure them as follows:

1. Initiate submit mode as described in Initiating Binder Submission in the Web Client.

Figure 161. Workflow Portal Window, Metadata Labels in Web Client

2. To add a metadata label to configure, do the following:

a. Click Add Label.
b. Select a label to add from the Add Metadata Labels dialog.
c. Click Add.

3. To edit metadata label parameters, locate the tab for the label, select the tab, and 
configure the label parameters.

4. To remove a metadata label configuration, locate the tab for the label, select the 
tab, and click Remove Label.

5. Repeat metadata label selection and parameter configuration until all required 
metadata labels are configured.

6. If you need to configure variables, see Specifying Variable Values.

7. When you are done preparing for submission, click Submit.
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Specifying Media Files
When enabled in a configuration, you can select specific media to submit to a target 
workflow, to match what the workflow expects to ingest. 

Note: When this feature is disabled, you can only submit a binder to a target 
workflow if the binder contains all of the labels, media, and/or attachments that are 
expected in the target workflow. This requirement must be considered during the 
workflow design phase.

Specify media to submit to the target workflow as follows:

1. On the Forward to Workflows tab, check the workflows to use, if permitted.

2. Click the Submit button to display the Submit Jobs dialog.

3. Display the Variables tab, as shown below:

Figure 162. Variables Tab, Windows Client

4. For each variable displayed, enter or select the run-time value as required.
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Specifying Variable Values
Variables and their values are not forwarded from one workflow to another, but a 
configuration may enable you to add variable values for use in a target workflow before 
you submit the media.

Note: In Copy Binder configurations, you specify values for variables (if any) after you 
click the Submit button.

Specify run-time values for variables as follows:

1. On the Forward to Workflows tab, check the workflows to use, if permitted.

2. Click the Submit button to display the Submit Jobs dialog.

3. Display the Variables tab, as shown below:

Figure 163. Variables Tab, Windows Client

4. For each variable displayed, enter or select the run-time value as required.
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Submitting a Job to Workflows
Depending on how the configuration is set up, you may or may not be able to select 
workflows. If the Forward to Workflows tab is disabled, Workflow Portal does not 
display it. When you click Submit, the media is submitted to a pre-determined 
workflow or set of workflows, based on the configuration.

If the Forward to Workflows tab is displayed, you may be able choose which workflows 
you submit media to, as determined by the administrator.

Figure 164. Forward to Workflows Tab—Windows Client

To select which workflows to submit media to, display the tab and check optional 
workflows as appropriate. For each checked workflow, a job is submitted.
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Initiating Binder Submission in the Windows Client
A configuration may be set up to support submission to one workflow or to multiple 
workflows. And, it may display one or more required workflows, and it may display 
optional workflows. 

If the configuration allows you to view the workflows to which you can submit, it 
displays a Forward to Workflows tab with a Submit button. If it doesn’t, there is a 
Submit button at the bottom of the Workflow Portal window.

To initiate submit mode, do the following:

1. If the Workflow Portal window displays a Forward to Workflows tab, do the 
following:

– Select the Forward to Workflows tab.

– Check or clear each workflow checkbox to specify which target workflows should 
process the job.

– Click Submit to enter submit mode.

2. If Workflow Portal does not display a Forward to Workflows tab, do one of the 
following to initiate submit mode:

– Click the Submit button at the bottom of the window.

– If the binder list is in Details mode, click the Submit button to the right of the 
binder name in the binder list. (This button is not displayed in Thumbnails 
mode.)

3. If the Media Files tab is present, select the media files to submit as follows:

a. Select the Media Files tab.
b. Check or clear the checkbox to the left of each media file name. 

A check mark causes the media to be submitted.

c. In the Change nicknames during submit list, check the box to the left of any media 
file you want to rename.

d. For each media file that you rename, select a new nickname in the dropdown list 
to the right of the media name.

4. If other configuration settings are available, Workflow Portal displays a dialog in 
which you can configure those options. For more information, refer to Configuring 
Metadata Labels and Specifying Variable Values.

5. When you are done, click Submit.
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Initiating Binder Submission in the Web Client
When you initiate the submission of a binder, the Workflow Portal view and mode 
changes from displaying media information to submitting information. In the submit 
mode, the selected configuration might allow you to configure metadata labels, 
configure variables, and select target workflows. Some of these options are limited to a 
particular configuration, and some of them can be disabled. The options that apply to 
your environment are defined by the Vantage domain administrator and the workflow 
designer.

The Workflow Portal configuration you have selected can be configured to support 
submission to one workflow or to multiple workflows. The selected configuration can 
also be configured to specify one or more required workflows, or you might be allowed 
to select one or more workflows from a list of workflows. 

If the selected configuration allows you to view the workflows to which you can submit, 
Workflow Portal displays a Forward to Workflow tab. If the configuration does not 
support operator viewing of the workflow list, Workflow Portal displays a Submit 
button.

To initiate submit mode, do the following:

1. If the Workflow Portal window displays a Forward to Workflows tab, do the 
following:

a. Select the Forward to Workflow tab.
b. Check or clear each workflow checkbox to specify which target workflows should 

process the job.
c. Click Submit to enter submit mode.

2. If Workflow Portal does not display a Forward to Workflows tab, do one of the 
following to initiate submit mode:

– Click the Submit button.

– Click the submit button  to the right of the binder name in the binder list.

If no other configuration options are available, the binder is submitted to the 
selected workflows.

3. If other configuration settings are available, Workflow Portal displays a dialog in 
which you can configure those options. For more information, refer to Configuring 
Metadata Labels and Specifying Variable Values.

4. When you are done preparing for submission, click Submit.
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Windows Client Menus
Table 8 describes the menu selections in the Workflow Portal Windows client.

Table 8. Workflow Portal Windows Client Menus

Menu Selection Description

File Change Vantage Domain See Logging into or Changing Vantage 
Domains in Windows Client Programs.

Change Vantage User See Changing Vantage Users in Windows 
Client Programs.

Change/Reload 
Application Configuration

See Changing or Reloading a Configuration.

Exit Closes the Workflow Portal program.

Options Restore Tips & Warnings Restores the display of Workflow Portal tips 
and warnings after the feature has been 
disabled.

Hide Tips & Warnings Hides Workflow Portal tips and warnings.

Prompt for Login Next 
Time Application is 
Launched

When checked, Workflow Portal requires 
login each time the program is launched, to 
increase security.

Use Clip Start Time Toggle this feature. When a check displays, 
the preview window uses the start time 
defined in the proxy media. If no check 
displays, the start time begins at zero.

Help Contents Display a Windows help version of this 
guide.

Index Display the index of this guide.

Search Search for key words in this guide.

Online Help Display the Vantage guides available on the 
Telestream Web site.

About Display the Workflow Portal version 
information.



Using Workflow Portal
Web Client Menus

308
Web Client Menus
Table 8 describes the menu selections and title bar options in the Web client.

Table 9. Workflow Portal Web Client Menus

Menu Selection Description

Title bar 
options

Change Password See Changing Passwords in Windows Client 
Programs.

Logout Log out the current Vantage user.

Change Domain See Logging into or Changing Vantage 
Domains in Windows Client Programs.

Catalogs 
menu

Refresh Catalog Listings Click to refresh the display of catalogs.

Help 
menu

About Select to display Workflow Portal product 
version information.

Help Documentation Click this entry to toggle the display of the 
submenu.

User Guide Click to display the PDF version of this 
guide in a separate browser window.

Web Help Click to display the HTML version of this 
guide in a separate browser window.
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Troubleshooting Workflow Portal
Use the following topics to help you solve certain problems with Workflow Portal:

Opening Workflow Portal the First Time
When opening Workflow Portal for the first time, depending on the design of your 
network and the location of your client workstation and Vantage domain server, the 
Domain login dialog may not display your Vantage domain. If this is the case, you may 
be able to log in by using the name or IP address of the Vantage domain server. For 
more details, see Logging into or Changing Vantage Domains in Windows Client 
Programs.

Difficulties Changing Configurations
When you change domains or configurations, you may also encounter these problems:

• No Configurations Available...

Workflow Portal displays this error when you log onto a domain where no Workflow 
Portal configurations are defined or where you do not have access to any of the 
defined configurations.

Contact your Vantage domain administrator.

• No session licenses available for this application...

Either the domain is not licensed for running Workflow Portal or all available Work-
flow Portal licenses are in use. Workflow Portal will operate in unlicensed/demo 
mode, but will not allow you to submit jobs or edit metadata labels until a Work-
flow Portal license becomes available.

Contact your Vantage domain administrator.

Note: An administrator can release a license in the Vantage Management Console.

• Problem communicating with database—could not find stored procedure Select-
SessionsByExecution...

This error displays when Workflow Portal is attempting to display a list of configura-
tions from the selected domain, but the version of the domain is not compatible 
with your client. Contact your Vantage domain administrator to upgrade the Work-
flow Portal program on your computer.

• The requested workflows are either not running or no longer exist...

This error displays when you submit an asset or media file to a workflow that has 
been deleted, or is not activated. Contact your Vantage domain administrator, who 
can activate the Vantage workflow or edit the configuration to correct the problem.
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Problems Playing Proxy Files
If you can’t play proxy files in a binder, review these issues:

• In the Web client, the Wait cursor displays forever: 
Your virtual directory may not be implemented in IIS
The location path may not be specified correctly, or it may be using a letter drive 
where a UNC path is required for remote client/service access
The alias to the directory may not be specified in the store
The alias path may be incorrect. For example, you used localhost, but the Web client 
is not running locally—you should supply the server name.

• In Workflow Portal, make sure that you create a QuickTime H.264/AAC proxy for 
previewing/clipping. Use the QuickTime encoder, and configure the container set-
tings to generate a timecode track. Make sure that your encoded proxy file is the 
same frame rate and timecode notation as your production media. Assign the nick-
name Vantage Proxy, so that the media player in Workflow Portal automatically 
loads and displays your proxy. 

• For previewing media in the Workflow Portal Web client’s HTML5 Media viewer, 
make sure the video is encoded using the Flip action (and nicknamed Vantage 
Proxy), with these settings:

Encoder: MP4 Encoder

Video Codec: x264

Audio Codec: AAC

Container: MP4 File

• When using the Workflow Portal Web application on a Windows Server platform, 
you must install the Desktop Experience feature in order to view proxy media in the 
HTML5 Media Player.

• When playing to the end of a proxy in Chrome, versions 35 and 36, Telestream has 
observed that the media player may display an incorrect duration as a result of a 
round-up error. This anomaly is cosmetic. If you set this frame as a mark-out point, 
the correct timecode is entered by Workflow Portal.

Configurations Don’t Display in the Web Client
You’ve created a new configuration, but you can’t select it in the Web portal.

•  Perhaps it is not a Copy Binder or Forward Binder configuration— the other types 
are not designed to function in the Web client, only the WIndows client.

• Perhaps you (your Vantage user) don’t have permission to use it.
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Using the Job Status
Views Web

Application

Job Status Views is a Web application that enables basic Vantage job management via a 
Web browser. You can use Job Status Views to access job information and manage jobs 
in your Vantage domain from anywhere on the LAN, or via the Internet when you 
establish an Internet connection.

Note: For information about Vantage Web application requirements, starting and 
stopping Web applications, and other basic topics, see Vantage Client Programs 
Overview.

This chapter presents the following topics:

 About the Job Status Views Web Application

 Job Status Views Web Application Overview

 Using Public and Private Views

 Displaying/Hiding the Title and View Panels

 Displaying/Hiding the Title and View Panels

 Paging Through Job Tables & Setting Page Size

 Filtering the Job Table

 Highlighting Job States Row by Row

 Managing Jobs

 Troubleshooting

Note: You can also monitor an manage jobs using the Job Status Views Web 
application. See Using the Job Status Views Web Application.
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About the Job Status Views Web Application
You can use the Job Status Views Web application to do the following:

• Display information about submitted jobs

• Sort and filter job entries

• Highlight and identify jobs in different states

• Stop, restart, and delete jobs

• Troubleshoot job processing issues.

The views that you see in Job Status Views are defined by Vantage administrators, who 
control which job information displays and which job control functions (such as the 
ability to delete a job) are allowed. Views may be public or private. Public views are 
available to everyone, and private views are for use by specified Vantage users.
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Job Status Views Web Application Overview
After logging in, the Job Status Views Web application displays the jobs table, as shown 
in Figure 165. 

Figure 165. Job Status Views Job List

The Job Status Views display is presented in three panels:

• Title panel—Displays the home button, Vantage domain and user name, and con-
trols to manage the user password, change domains, and to log out of the domain.

• View panel—Displays views, which define which jobs are listed in the job list. This 
panel also includes controls to display product version information and this guide.

• Job list panel—Displays the job list in table format, along with the program’s tool-
bar, which contains command buttons and menus.

Note: If you do not log in with a Vantage user name, private views display None 
Available.

Title 
panel

Views 
panel

Job list 
table

User & domain infoHome menu button

Page buttons and page size

Currently selected view

Toolbar
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The following sections describe how to use the Web application:

 Displaying/Hiding the Title and View Panels

 Using Public and Private Views

 Displaying/Hiding the Title and View Panels

 Paging Through Job Tables & Setting Page Size

 Filtering the Job Table

 Highlighting Job States Row by Row
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Using Public and Private Views
All views are defined either as public or private, and are created and configured in the 
Management Console. Click on the view to select it, and display jobs for this workflow. 
Only private views that are enabled for your Vantage user name are listed.

The default view is the All Workflows public view, which displays jobs for all workflows. 
The information that All Workflows displays depends on how it is configured in the 
Management Console, and whether it is enabled or not. If no private views have been 
defined, or if you log in as Public, the Private Views list displays None Available. 

The following topics provide more information on views:

 About Public and Private Views

 About View Definitions

About Public and Private Views
Public views are views that the Vantage administrator has made available to all Vantage 
users. Anyone who connects to the Vantage domain can display public views in the Job 
Status Views Web application.

Private views are views that are available only to those Vantage users for which the 
Vantage administrator has enabled access. The administrator might configure custom 
views for different departments, users by role, or customers, and limit access to those 
views to the appropriate users.

About View Definitions
All views that you create are based on a specific workflow. In addition to being public or 
private, views limit the information that is displayed and specify which job control 
features (if any) the user has to use. If no controls are enabled, the view is considered a 
read-only view. You cannot create or configure views directly in Job Status Views; views 
are created by the Vantage administrator, via the Vantage Management Console, and 
specified as public or private; enforced by which user logs in.

There are many options for views, and displaying all options usually provides too much 
information for most applications. For example, it might be more convenient to display 
fewer columns. This view might only display active jobs, and it might disable controls 
that allow jobs to be restarted, stopped, or deleted.

The following topics provide information on what can be customized (and thus, may or 
may not be present) in views

 Displaying Items in Views

 Controls in Views

Note: Administrators should refer to the Vantage Domain Management Guide for 
information on how to set up custom views.
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Displaying Items in Views
Two items of information are always displayed as columns in a view:

• Job—The name of the file submitted to start the job, and the type of submission: 
Manual Submit, for example.

• State—The current state of the job, which can be:

The state column displays color-coded key words to identify the status of the job.

• Green—In Process. The action is currently executing.

• Blue—Complete. The action completed successfully. 

• Red—Failed. This action has failed or an upstream action failed.

• Black—Ignored. This action was not executed due to Perform On state mismatch.

• Light Gray—Paused or Suspended. An action is paused or suspended.

• Magenta—Stopped by User. An action was stopped by a user.

• Orange—Waiting to Retry. An action failed and is waiting to re-execute the action.

• Purple—Waiting for a Service. No service of the required type is running that can 
execute the action. For example, no Transcode Service is running and the Flip 
action is purple.

• Light Green—Waiting due to a run on rule that must be satisfied. For example, a Flip 
action requires a Lightspeed server, but no Lightspeed servers are present.

• White—The action is waiting to be processed by a service. Upstream actions have 
not yet completed execution.

• Yellow—Waiting execution, because even though the action has been accepted by 
a service, there is no slot in which to run the action.

These optional columns can be added to a view:

• Total Progress—The progress of the job (in percent) if still running.

• Started—The date and time the job was started.

• Updated—The date and time the job was last updated.

• Workflow—The name of the workflow that started the job.

• Expires—The date and time when the job expires and both the job entry and its 
binder will be deleted.

Controls in Views
An administrator can configure the following controls in a view:

• Enable—Enables or disables use of the view.

• Show Only In Process Jobs—Displays only jobs that are currently running.

• Stop | Start | Delete—Enables or displays the ability of the operator to manage 
jobs—stopping, restarting, and deleting them.
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Displaying/Hiding the Title and View Panels
To display or hide the title or view panels, click the show/hide controls, as shown in 
Figure 165.



Using the Job Status Views Web Application
Sorting Jobs by Column

318
Sorting Jobs by Column
To sort the displayed job list according to the entries in any column, click that column 
label. Each time you click the column label, the sort changes in the following sequence: 
ascending order, descending order, and default sort order.



Using the Job Status Views Web Application
Paging Through Job Tables & Setting Page Size

319
Paging Through Job Tables & Setting Page Size
A job table may span multiple pages. Use the page size control at the bottom center of 
the job list to specify the number of jobs to display on a page.

The page controls on the bottom left allow you to change pages and jump to the first 
or last page of a job list. Figure 166 shows where the page controls appear in the job 
panel.

Figure 166. Job List, Showing Page Controls

Page controls Page size
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Filtering the Job Table
Job filters allow you dynamically control which jobs display in the job table. The default 
configuration displays all jobs specified in the view for the workflow. However, during 
troubleshooting, you might want to display only those jobs that are in a failure state. 
Other times, you might want to display only those jobs that are in progress.

To display the Job List filters, click Show Filters in the toolbar. The filters are displayed 
directly below the column titles in the job list table, as shown in Figure 167.

Figure 167. Job List, Showing Job Filters

To hide filters, click Show Filters again.

Which jobs display in the job list is determined by all the filters working together to 
filter the list. If multiple filters are configured, the job list includes all jobs that meet the 
criteria of all configured filters.

 Setting the Job Name Filter

 Setting the Job State Filter

 Setting the Total Progress Filter

 Setting the Date and Time Filters
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Setting the Job Name Filter
You can use the job name filter to limit the job list display to only those jobs with a 
name that meet criteria you specify. The following sections describe how to set and 
clear the job name filter:

 Specifying a Job Name Filter

 Clearing the Job Name Filter

Specifying a Job Name Filter
To specify a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box above the job names, enter text that is part of job names that you 
want to include or exclude from the list.

3. Click the control to the right of the filter text box and select one of the following 
filters:

– Contains—Displays all jobs that have a name that contains the text you specified.

– DoesNotContain—Displays all jobs except those that have a name that contains 
the text you specified.

– EqualTo—Displays only those jobs that have names that exactly match the text 
you specified.

– NotEqualTo—Displays all jobs except those that have a name that exactly 
matches the text you specified.

Clearing the Job Name Filter
To clear a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter text box and select No Filter.
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Setting the Job State Filter
The job state filter allows you to selectively exclude jobs from the job list based on the 
job state. The default configuration displays jobs for all of the following job states:

• Complete

• Failed

• In Process

• Stopped By User

• Waiting

• Waiting to Retry

When the job state filter is set to display jobs in all states, the filter name for the State 
column is All States. When the job state filters disable the display for jobs in one or more 
states, the filter name for the State column changes to Custom.

To specify a state filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control below the State column head and check and clear the checkboxes 
to define the states for which you want to display jobs.
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Setting the Total Progress Filter
You can use the total progress filter to limit the job list display to only those jobs that 
meet progress criteria that you specify. The following topics describe how to set and 
clear the total progress filter:

 Specifying a Total Progress Filter

 Clearing the Total Progress Filter

Specifying a Total Progress Filter
To specify a total progress filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box below the Total Progress column name, enter the progress level you 
want to include or exclude from the list. The range is 0% to 100%. 

3. Click the control to the right of the total progress text box and select one of the 
following filters:

– Contains. Displays all jobs for which the total progress includes the value you 
specified.

– DoesNotContain. Displays all jobs except those for which the total progress 
includes the value you specified.

– EqualTo. Displays only those jobs for which the total progress matches the value 
you specified.

– NotEqualTo. Displays all jobs except those for which the total progress matches 
the value you specified.

Clearing the Total Progress Filter
To clear a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the Total Progress text box and select NoFilter.
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Setting the Date and Time Filters
The date and time filters allow you to limit the job display list to jobs that started, 
updated, or expire within a specified time period. There are three separate date and 
time filters for:

• Started

• Updated

• Expires

The following topics describe how to set and clear the date and time filters:

 Specifying a Date and Time Filter

 Clearing a Date and Time Filter

Specifying a Date and Time Filter
To set any of the date and time filters, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter label box in the appropriate column.

If the filter label box is empty, no filter is defined. If a filter is defined, the filter label 
box displays Custom.

3. In the panel that appears, click on the calendar and clock buttons to set the date 
and time for the period start and period end.

If you omit the period From date and time, the program displays all jobs up to the 
To date and time. If you omit the period To date and time, the program displays all 
jobs after the From date and time.

4. When the period is defined, click Apply.

Clearing a Date and Time Filter
To clear a date and time filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter label box.

3. Click Clear.
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Highlighting Job States Row by Row
Job state highlighting allows you to use colors to make the different job states more 
visible. Or, you can use the same color for all job states to draw less attention to the job 
states.

To toggle job state highlighting, click the Highlight State Rows button in the toolbar. 
Each time you click the button, the job state highlighting changes from the current 
state to the opposite state.
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Managing Jobs
Job management, when enabled in a view, enables you to stop, restart, and delete jobs.

The following topics describe how to stop, restart, and delete jobs:

 Stopping Jobs

 Restarting Jobs

 Deleting Jobs

Stopping Jobs
You might want to stop a job to make Vantage resources available for another job, or 
you might stop a job in preparation for system maintenance. 

To stop a job, do one of the following:

• Right-click on a job in the job list, and select Stop.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Stop.

Restarting Jobs
Jobs can be stopped by service or network interruptions, or an operator might stop a 
job to give another job priority. To restart a job, do one of the following:

• Right-click on a job in the job list, and select Restart.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Restart.

Deleting Jobs
You might want to delete a job because the job has failed, or because the output file is 
no longer needed, for example.

To delete a job, do either of the following:

• Right-click on a job in the job list and select Delete.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Delete.
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Troubleshooting
Job Status Views enables troubleshooting and correction at the job level. For more 
comprehensive troubleshooting, use the Vantage Web.

The first step in Vantage troubleshooting with Job Status Views is to identify the jobs 
that are having problems. There are several ways to do this:

• Enable Highlight State Rows to indicate job status with colors. Failed jobs are high-
lighted in red, and other states have distinct colors. (See Highlighting Job States Row 
by Row for more information.)

• Click the State column head to sort the jobs by the current state, then locate the 
group of jobs you want to investigate.

• Use filters to display only the jobs in the state you are investigating. (See Filtering 
the Job Table for more information.)

After you locate the jobs with issues, look for common traits among those jobs. The 
following are some possible issues and suggestions for resolution:

• All jobs are failed or waiting. Look for network, database, or service issues. If all jobs 
within a certain time period had problems, there might have been a temporary 
issue that has since been corrected. Restart failed jobs as described in Restarting 
Jobs.

• All jobs for a specific workflow have failed or are waiting. Look for issues with the 
workflow. Has the workflow ever worked? Are all resources used by that workflow 
available?

• All jobs for a particular watch folder or destination have failed or are waiting. If you 
know that all the troubled jobs use the same watch folder or destination, it could 
be that the location is not available. 

After you resolve a problem, some jobs might restart on their own, and others might 
require further action from you. If your view is so enabled, you can take the following 
actions on jobs in the job list:

• Restart—Restart stopped jobs as described in Restarting Jobs.

• Delete—Delete jobs as described in Deleting Jobs.

• Stop—If a job seems unlikely to complete or stop, you can stop the job as described 
in Stopping Jobs. Once a job is stopped, you can try to restart the job or delete it.
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Using Vantage
Transcode
Vantage Transcode, a browser-based Web application, allows Transcode and Transcode 
Pro customers to quickly and easily build transcoding workflows, using only a Web 
browser interface. Workflows created in Vantage Transcode can include these features:

 One or more hot folders to watch for incoming media

 One or more output formats

 Delivery to one or more destinations.

You can also review the status of jobs directly in Transcode, where jobs can be stopped, 
restarted, and deleted.

Note: For information about Vantage Web application requirements, starting and 
stopping Web applications, and other basic topics, see Vantage Client Programs 
Overview.

This chapter presents the following topics:

 About Vantage Transcode

 Vantage Transcode Overview

 Managing Vantage Transcode Workflows

 Configuring Workflows

 Managing Job Status

 Troubleshooting

 Accessing Help
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About Vantage Transcode
Vantage Transcode is a Web-based, template-driven Vantage workflow editor that 
allows you to perform the following types of tasks: 

• Create and configure watch-transcode-deliver workflows from a template

• Submit media for processing through a workflow

• Activate and deactivate workflows

• View domain job status.

Note: Workflows you create in Transcode are automatically listed in Workflow 
Designer. You can view workflows created in Transcode in Workflow Designer, but if 
you edit them in Workflow Designer, you can’t use them in Transcode again. 
Workflows in Vantage are tagged based on the client application that created or 
edited them. Because Transcode can only utilize basic transcoding workflows, it does 
not attempt to open workflows tagged as edited by Workflow Designer.

For designing complex, branching workflows with no restrictions, use the Vantage 
Workflow Designer. For basic, single-branch workflows, the Transcode Web application 
offers you a quick fixed-template workflow design alternative.
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Vantage Transcode Overview
After you log in, the Vantage Transcode Web application displays the workflow design 
window shown in Figure 168.

Figure 168. Vantage Transcode Window

The Vantage Transcode window consists of these parts:

• Details Panels

– Displays the workflow template when Workflows is selected in the menu. 

– Displays a jobs list when Job Status is selected in the menu.

– A Menu Bar shows menus applicable to what is being displayed

– A Title indicates whether you’re viewing a workflow or job status

• Menu Items

– Workflows lets you view categories and select workflows

– Status lets you select and view Job Status

– About lets you select and view Vantage version information, or Help 
Documentation consisting of the User Guide or online Web Help

• The Home button takes you back to the Vantage Web Applications page

• User and domain information; click Change Domain to select a Vantage domain

Selected 
workflow name

Vantage Web 
Application Home 
button

Menus for 
viewing 
workflows, 
job status, 
and help

User and 
domain info

Menu Bar

Display Panel, showing Workflow Template

Workflow creation 
and editing menu
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Managing Vantage Transcode Workflows
Vantage Transcode presents a fixed workflow design template in which you can create 
and save workflows that include these three actions:

• Watch specifies a folder to watch for media to transcode.

• Flip transcodes watched media into another selectable format.

• Deliver deploys transcoded media to a selectable device or output folder.

With these features, you can quickly create and manage simple but powerful workflows 
using a web browser instead of the full-featured but more complex Workflow Designer.

These topics explain how to manage Vantage Transcode workflows:

 Creating a New Workflow

 Saving a Workflow

 Activating a Workflow and Submitting Files

 Deactivating a Workflow

 Editing a Workflow

 Duplicating a Workflow

 Deleting a Workflow
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Creating a New Workflow
To create a new workflow, click the Workflow menu at the top of the Workflow panel, 
and select New. Vantage Transcode displays the Create New Workflow dialog:

Figure 169. Create New Workflow Dialog

Select a Category—Select the category for this workflow from the list.

Enter a Name—Enter a name for the workflow you want to create.

Enter a Description—Enter a description of the workflow.

Expire after—Specify in hours (and days) how much time elapses before Vantage 
automatically deletes job records from the database for this workflow, and deletes the 
associated binder. The time for expiration is based on the last updated time in the job 
record, not the job submission time. 

OK | Cancel—Click OK to create the new workflow. Vantage Transcode creates the 
workflow in the database, adds it to the specified category, and displays it in the 
Vantage Transcode panel in edit mode—that is, deactivated and editable.

After the workflow is created, you need to configure its Watch, Flip, and Deliver actions 
as explained in Configuring Workflows.

Saving a Workflow
To save a workflow, click the Disk icon in the toolbar at the top of the Workflow panel, or 
click Save in the Workflow menu.

Select the category where you want to 
save the workflow.

Enter a name for the new workflow.

Enter a description of the new workflow.

Enter an expiration time.

Click OK to create the workflow.
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Activating a Workflow and Submitting Files
To activate a workflow, right-click it in the Workflows panel on the left and click the 
Activate button in the menu bar (Figure 170). When activated, the workflow displays a 
green arrow, and it can process jobs. 

Figure 170. Activate a Workflow

When a workflow is activated, it monitors the selected Watch folder for new files to 
transcode. You can also manually submit a file for immediate transcoding. 

To submit a file:

1. Click Submit in the menu bar above the workflow (Figure 171).

2. Select the File System to use for locating the file. 

3. Browse for the file, and click OK. 

Vantage Transcode immediately submits a job to transcode the file.

Figure 171. Submitting a File
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Deactivating a Workflow
To deactivate an active workflow, right-click it in the Workflows panel on the left, and 
select Deactivate. When a workflow is deactivated, you can edit it, but you cannot 
process jobs with it.
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Editing a Workflow
To make a workflow editable, click the Edit button in the menu bar. Alternatively, you 
can first deactivate it, and then click on it in the left panel. A dialog announces that it is 
read-only and asks if you want to make it editable. Click OK (or Cancel). Workflows can 
be edited only when they are not activated. 

To edit workflow details, click the pencil icon at the top of the workflow panel, or click 
the Workflow menu, and select the Edit icon (Figure 172). The Edit Workflow dialog 
opens, allowing you to change the name, the description, or the expiration—just click 
the item, make a new entry, and click OK. 

Figure 172. Edit a Workflow

Editing Workflow Actions
To edit actions, just click on the action—Watch, Flip, or Deliver. The window for that 
action opens, allowing you to make changes.
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Duplicating a Workflow
Workflows can be duplicated only when they are not activated. 

To duplicate a workflow:

1. Click the workflow name in the left panel to highlight it.

2. Click the Workflow menu, and select Duplicate. 

3. Select a category and enter a new name in the Duplicate Workflow dialog.

4. Click OK to create the new workflow. 

Figure 173. Duplicate a Workflow

Deleting a Workflow
Workflows can be deleted only when they are not activated and editable. To deactivate 
the workflow, right click it in the Workflows left panel and select Deactivate. Then click 
it again. A dialog announces that it is read-only and asks if you want to make it editable. 
Click OK (or Cancel). 

To delete a workflow, right-click the workflow name in the Workflows panel and select 
Delete or click the Workflow menu and select Delete. Vantage Transcode displays a 
warning that you are about to delete the workflow and all job history for this workflow. 
Click OK to delete the workflow and its history.

CAUTION: This action deletes the workflow and its job history from the database. 
Once deleted, a workflow cannot be recovered.
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Configuring Workflows
After creating a new workflow, you will need to configure the three actions built into 
the workflow template: Watch, Flip, and Deliver.

The following topics provide more information on configuring your workflow:

 Configuring the Watch Action

 Configuring the Flip Action

 Configuring the Deliver Action

Figure 174. Actions Ready for Configuration



Using Vantage Transcode
Configuring Workflows

339
Configuring the Watch Action
The Watch action monitors a folder you specify, and when a media file is placed in the 
folder, the Watch action detects the file and sends it through the workflow as a job. 

To configure or edit the Watch action for a workflow, click the green plus (+) symbol at 
the right end of the Watch row (next to the question mark). A New Watch dialog opens 
and presents a series of dialogs. Click Next/Previous to move through the dialog 
screens (or Cancel to exit the configure dialog) and select from the following fields:

Watch Description—Enter a Watch Description.

Select what you want to watch—Select the type of files you want to watch for. 

Select the File System—Click a file system. Several systems are available, including 
Windows at the bottom of the list if you want to watch a Windows folder. Click Next.

File System Parameters—Enter parameters to allow Vantage Transcode to find and 
access the host system where the watch folder resides. Required parameters vary 
depending on the type of file system you selected. 

Configure settings for this file system detector—Make selections and entries to describe 
how and when to detect and submit files to the workflow:

Cycle—Select the number of seconds between checks of the watch folder.

Count—Select the number of cycles a file must remain unchanged in size before it 
is submitted as a job. (This ensures files are done being written to the folder before 
they are processed.)

Submit Immediately—Check to submit jobs as soon as detected without waiting to 
verify that the file is done being written.

Look in Subfolders—Check to drill down to lower level folders to detect media.

Send Offline Notification Emails—Check to send email to the administrator when a 
job fails because the system is offline. 

Process Existing Files—Select which existing files in the folder to process, if any. 
Selecting All processes all existing files. Selecting Limit to Last processes all files 
placed in the folder within the specified number of days. Selecting Since Last Work-
flow Deactivation processes all files placed in the folder since the workflow was last 
deactivated, which helps ensure no files are missed between activations.

File Match Pattern—Enter any file naming pattern to explicitly accept or reject. For 
example, if you want to accept only MOV files, enter *.mov in the Accept field. If you 
want to accept all files except TXT files, leave Accept blank and enter *.txt in the 
Reject field. 

Cancel/Previous/Finish—Click Finish to create the Watch action (or Previous to go 
back to previous screen, or Cancel to cancel your entries).



Using Vantage Transcode
Configuring Workflows

340
Configuring the Flip Action
The Flip action transcodes files directed to it from the watch folder by the Watch action. 
To configure or edit the Flip action for a workflow, click the green plus (+) symbol at the 
right end of the Flip row (next to the question mark) to open the Flip configuration 
dialog. Click Next/Previous to move through the dialog screens (or Cancel to exit the 
configure dialog) and select from the following fields:

The Create New Encode dialog:

Encoder—Select an encoder from the menu. 

Description—Enter a description in the text field.

OK/Cancel—Click OK to create the Flip action (or Cancel to cancel your entries).

The Flip: Performs a single file transcode dialog configures the transcode. Detailed 
selections in this dialog vary with the selected format, but may be similar to these: 

Encoder—Click Encoder and select an encoder from the menu. You can use this to 
change the encoder without going back to the previous dialog.

Output Location: Path—Browse to select a folder for the transcoded output. You can 
also select (Collision Resolution) whether to create a new name for each file, over-
write existing files, or do nothing if the same file name exists and set the job to the 
failure state. 

Container—Select the container for packaging the transcoded file.

Movie Filters—Select the options such as captions, timecode, and media length

Video Stream—Select the processor to use for the video stream.

Codecs—Select a codec, bit rate (Video Settings), and so on.

(Video) Filters—Expand and select the video filter functions you want to apply.

Audio Stream—Enable the audio stream, select a codec, and so on.

(Audio) Filters—Expand and select the audio filter functions you want to apply. 

OK/Cancel—Click OK to create the Flip action (or Cancel to cancel your entries).
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Configuring the Deliver Action
The Deliver action delivers files supplied to it by the Flip action. To configure or edit the 
Deliver action for a workflow, click the green plus (+) symbol at the right end of the 
Deliver row (next to the question mark) to open the Deliver configuration dialog. Click 
Next/Previous to move through the dialog screens (or Cancel to exit the configure 
dialog) and select from the following fields:

The New Delivery dialog:

Delivery Description—Enter a description of the delivery.

Select the files to deliver—Select to deploy files when received or a single transcode.

Collision Resolution—Decide what to do if the output file name is the same as a file 
from a previous job. Select Create Unique Name to add a version number at the end 
of the name, or Overwrite the existing file, or Set Failure State to cause the job to fail.

Select the File System—Click a file system to receive the output. Several systems are 
available, including Windows at the bottom of the list. 

Cancel/Next—Click Next to go to the next screen (or Cancel to cancel your entries).

The File System Parameters dialog opens:

Delivery Folder Path—Enter the path to the delivery folder.

Cancel/Previous/Finish—Click Finish to create the Deliver action (or Previous to go 
back to previous screen, or Cancel to cancel your entries).

Managing Job Status
When you click Job Status in the left panel Status section, a Job Status page opens. The 
Domain Job Status page provides a real time view of Vantage workflow jobs, and it 
provides controls that you can use to manage job processing. The Domain Job Status 
page displays two lists: the Job Status list and the Actions list.

The Job Status list presents workflow jobs, the state of each job (complete, failed, 
stopped), and timestamps for job events. Whenever a job is selected, the actions 
associated with that job are listed in the Actions list at the bottom of the window. The 
Actions list presents status information for each action and controls for managing the 
actions. 

The following topics describe status management:

 Monitoring Jobs

 Sorting Jobs

 Filtering Jobs

 Stopping Jobs

 Restarting Jobs

 Deleting Jobs
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Monitoring Jobs
You can monitor and manage jobs created by your workflows right in the Vantage 
Transcode window. Click the Status menu in the left panel to reveal the Job Status 
selection, and click Job Status. This opens a Job Status and Actions panel (Figure 175).

Figure 175. Job Status and Actions Panels

The Job Status View offers these job monitoring options:

Column Headings—Sort the jobs list by clicking the column headings: Job, State, Total 
Progress, Started, Updated, or Expires.

Options—Control jobs by clicking the job and selecting Stop, Restart, or Delete.

Highlight State Rows—Click to turn row status coloring on or off for all rows. When on, 
status colors are applied to entire rows. When off, only the State column is colored.

Show Error Details—Click to open a window showing information and error messages 
about a selected failed job.

Show Filters—Click to show multiple tools for controlling which jobs you see in the list.

? Help—Opens the User’s Guide to the appropriate manual page for the topic.

Page selections (bottom)—Click the forward and back buttons to view multiple pages of 
job lists. Click the Page size menu to set how many jobs are shown on a page.

Actions panel—Click a job to see the list of its actions in this panel. Details about the 
Actions panel are described in Viewing Actions later in this section.

Job Status panel

Actions panel
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Displaying Items in Views
Two items of information are always displayed as columns in a view:

• Job—The name of the file submitted to start the job, and the type of submission: 
Manual Submit, for example.

• State—The current state of the job, which can be:

The state column displays color-coded key words to identify the status of the job.

• Green—In Process. The action is currently executing.

• Blue—Complete. The action completed successfully. 

• Red—Failed. This action has failed or an upstream action failed.

• Black—Ignored. This action was not executed due to Perform On state mismatch.

• Light Gray—Paused or Suspended. An action is paused or suspended.

• Magenta—Stopped by User. An action was stopped by a user.

• Orange—Waiting to Retry. An action failed and is waiting to re-execute the action.

• Purple—Waiting for a Service. No service of the required type is running that can 
execute the action. For example, no Transcode Service is running and the Flip 
action is purple.

• Light Green—Waiting due to a run on rule that must be satisfied. For example, a Flip 
action requires a Lightspeed server, but no Lightspeed servers are present.

• White—The action is waiting to be processed by a service. Upstream actions have 
not yet completed execution.

• Yellow—Waiting execution, because even thought the action has been accepted by 
a service, there is no slot in which to run the action.

These optional details can be added as columns in a view:

• Total Progress—The progress of the job (in percent) if still running.

• Started—The date and time the job was started.

• Updated—The date and time the job was last updated.

• Workflow—The name of the workflow that started the job.

• Expires—The date and time when the job expires and both the job entry and its 
binder will be deleted.
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Sorting Jobs
To sort the displayed job list according to the entries in any column, click the column 
label. Each time you click the column label, the sort changes in the following sequence: 
ascending order, descending order, and default sort order.

• Job sorts in alphanumeric order by job number.

• Workflow sorts by workflow name

• Category sorts by category

• State sorts by state

• Total Progress sorts by the percentage of job progress.

• Started sorts by the job start date and time.

• Updated sorts by the date and time jobs were last updated.

• Expires sorts by the date and time the jobs expired.
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Filtering Jobs
Show Filters lets you filter which jobs appear in the jobs list. You can filter on a single 
field or multiple fields. Click Show Filters to reveal six filter fields associated with the 
column headings above them:

• Job filters on job titles based on the characters you enter and the logic function you 
select. Click the funnel icon next to the field to select from these logic functions: 
NoFilter, Contains, DoesNotContain, EqualTo, or NotEqualTo.

• Workflow filters workflow names by the characters you enter plus the Contains, 
DoesNotContain, EqualTo, NotEqualTo, or NoFilter function.

• Category filters categories by the characters you enter plus the Contains, DoesNot-
Contain, EqualTo, NotEqualTo, or NoFilter function.

• State filters by the specific state. Click the menu and click the state you want to use: 
Complete, Failed, In Process, Paused, Stopped by User, Waiting, or Waiting to Retry.

• Total Progress filters by the percentage of job progress you enter and the logic func-
tion you select. Click the funnel icon next to the field to select from these logic 
functions: NoFilter, Contains, DoesNotContain, EqualTo, or NotEqualTo.

• Started filters by job start date and time within a range you specify. Click the menu 
and make entries to show all jobs started between the dates and times you specify.

• Updated filters updates by the date and time jobs were updated within the range 
you specify. Click the menu and make entries to show all jobs updated between the 
dates and times you specify.

• Expires filters expiration dates by the date and time the jobs expired within the 
range you specify. Click the menu and make entries to show all jobs started 
between the dates and times you specify.

Stopping Jobs
You might want to stop a job to make Vantage resources available for another job, or 
you might stop a job in preparation for system maintenance. 

To stop a job, do one of the following:

• Right-click on a job in the job list, and select Stop.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Stop.

Restarting Jobs
Jobs can be stopped by service or network interruptions, or an operator might stop a 
job to give another job priority. To restart a job, do one of the following:

• Right-click on a job in the job list, and select Restart.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Restart.
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Deleting Jobs
You might want to delete a job because the job has failed, or because the output file is 
no longer needed, for example.

To delete a job, do the following:

• Right-click on a job in the job list and select Delete.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Delete.
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Viewing Actions
When you click on a job in the Job Status panel, the job’s actions appear in the Actions 
panel. The Actions panel enables you to gather information about the performance of 
the job, such as how much time each action took to execute, which action, if any, may 
have failed and how much progress it made before failing.

The Actions panel includes these selections:

Column Headings—Sorts the actions list by clicking the column headings: Action, State, 
Total Progress, Started, Updated, or Expires. 

Options—Controls a selected action by selecting Change Priority or Restart. Change 
Priority opens a window allowing you to set the action processing priority. Higher 
numerical values are processed first. Restart resumes processing of the selected action, 
enabling you to step through a job one action at a time.

Highlight State Rows—Turns row status coloring on or off for all rows. When on, status 
colors are applied to entire rows. When off, only the State column is colored.

Show Error Details—Opens a window showing information and error messages about a 
selected failed job. 

Show Filters—Shows multiple tools for controlling which actions you see in the list.

? Help—Opens the User’s Guide to the appropriate manual page for the topic.

Troubleshooting
Job Status Views enables you to troubleshoot and correct workflow design and 
configuration errors at the job level.

The first step in Vantage troubleshooting with Job Status Views is to identify the jobs 
that are having problems. There are several ways to do this:

• Enable Highlight State Rows to indicate job status with colors. Failed jobs are high-
lighted in red, and other states have distinct colors. (See Highlighting Job States Row 
by Row for more information.)

• Click the State column head to sort the jobs by the current state, then locate the 
group of jobs you want to investigate.

• Use filters to display only the jobs in the state you are investigating. (See Filtering 
Jobs for more information.)

After you locate the jobs with issues, look for common traits among those jobs. The 
following are some possible issues and suggestions for resolution:

• All jobs are failed or waiting. Look for network, database, or service issues. If all jobs 
within a certain time period had problems, there might have been a temporary 
issue that has since been corrected. Restart failed jobs as described in Restarting 
Jobs.
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• All jobs for a specific workflow have failed or are waiting. Look for issues with the 
workflow. Has the workflow ever worked? Are all resources used by that workflow 
available?

• All jobs for a particular watch folder or destination have failed or are waiting. If you 
know that all the troubled jobs use the same watch folder or destination, it could 
be that the location is not available. 

After you resolve a problem, some jobs might restart on their own, and others might 
require further action from you. If your view is so enabled, you can take the following 
actions on jobs in the job list:

• Restart—Restart stopped jobs as described in Restarting Jobs.

• Delete—Delete jobs as described in Deleting Jobs.

• Stop—If a job seems unlikely to complete or stop, you can stop the job as 
described in Stopping Jobs. Once a job is stopped, you can try to restart the job or 
delete it.

Accessing Help
The Help section at the bottom of the left panel includes these features:

• About shows what version of Vantage you are using.

• User Guide is organized into chapters and leads you systematically through the pro-
cess of learning to use Vantage.

• Web Help is organized into searchable topics you can access when you need a quick 
explanation of how to use a particular Vantage function.
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action

An action is the smallest unit of work that can be specified in a Vantage workflow. 
Actions are connected together in a workflow to perform a useful task. Each action 
must be configured to perform its task in the context of the workflow, using an action 
Inspector. Action inspectors are specific to each type of action.

Actions are grouped by functional categories: communication, transcoding, file 
operations, metadata processing, etc. Each action is defined by the specific task it 
performs. For example, an email action, or a metadata label/file transformation action.

Actions have limited interdependency, and so, are very flexible. You may impose 
limitations on actions in a workflow. For example, you might require action B to depend 
on action A in a Vantage workflow.

During execution, actions operate on files, binders, variables, and states, and they 
generate an action state when they complete. Actions are executed by Vantage 
services, which perform the requirements of the action.

action state

The action state describes the condition of an action execution in process and after 
completion.

During execution, an action may be Queued | Paused | In Process | Waiting. After 
execution, an action's final state may be Success | Ignore | Fail. Certain actions (Decide/
Examine/Compare/Identify, for example) allow the use to specify the post-execution 
state, including Ignore. For all other actions, the post-execution state is set by the 
service, and is either Success or Fail. These states display in the Vantage Workflow 
Designer Job Status tab.

Action states are always passed to subsequent actions. The incoming state is tested by 
the next actions to determine whether or not following actions should execute.

Some actions allow you to specify that an action should execute on a specific state 
(right-click the action, and select Perform On > Success | Fail | Ignore | Any).

If an action fails, then the next action will inherit the Fail state and (in most cases) will 
not execute. If one action fails, the entire job fails.

Similarly, if you specify an action to set the Ignore state, the next action will inherit the 
Ignore state and will also likely not execute. Certain special actions, such as Message, 
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can be configured to perform on any state (Fail, for example)—this allows workflows to 
send an email if they detect a failure.

Action states have precedence when an action receives states from multiple incoming 
actions (a merge of multiple branches):

• If at least one incoming state is Fail, regardless of other incoming states, the action 
will inherit the Fail state. Fail has precedence over all action states.

• If there is no Fail state, but at least one Success state, then the action will inherit the 
Success state. Success has precedence over Ignore states.

• If all incoming states are Ignore, the action will inherit the Ignore state. Ignore has 
lowest precedence of the three states. If an action receives an Ignore state and does 
not explicitly fail, then it emits a Success state. Otherwise, it emits a Fail state unless 
it is an action which can emit Ignore, and you have configured it to do so.

Agility Service

The Agility Service is the Vantage component which executes the actions relating to 
Agility job submission and interaction with Agility via the Job Profile action, Job XML 
action, and Process MMF action. Agility features are enabled by the Vantage Agility ECS 
license.

All-in-one domain

An all-in-one (or single-node or single-server) Vantage domain is one in which all server 
components of Vantage—the Microsoft SQL Server database, all Vantage services, and 
the optional Vantage Web Applications—are installed and operate on a single 
computer.

See also Vantage array. 

Analyze action

An Analyze action, which is executed by the Analysis Service, enables you to perform 
analysis on media using a variety of analysis tools, as well as variables, with the result of 
the analysis, for use in downstream actions.

Analysis Service

The Analysis Service is the Vantage component which executes the actions relating to 
the analysis of content: Examine action, Compare action, Identify action, Analyze 
action, Report action, QC action, and MediaInfo action.

Archive action

An Archive action, which is executed by the Staging Service, uses the selected archiver 
(TAR, for example) to convert the selected input file to another format, usually in 
preparation for copying, moving, or deploying a file to a given system that has special 
file format requirements.

array

Another term for Vantage array. 
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Aspera Service

An Aspera Service implements the Aspera software for Vantage, and provides two-way 
communication between workflows (and the Faspex Delivery action) utilizing the 
Aspera software itself.

Associate action

An Associate action uses the Monitor Service to continually (and at regular periods) poll 
a target location (a directory, for example) on a device or file system (FTP, network 
folder, etc.) to discover new files, based on some permutation of the name of the file 
being processed.

Associate actions can be executed on any action state.

Generally, the Associate action uses the file name of an existing media file or 
attachment as the basis for discovering new files. For example, if media file 
Vantage.mpg is currently in the workflow, then the Associate action may look for 
Vantage.scc. This behavior can be configured in the Associate action's Inspector.

Associate actions begin executing when a job is submitted, and execute until a new file 
is discovered—subsequent actions do not execute until the file is found. When the new 
file is discovered, the Associate action makes the file available to the other actions in 
the workflow.

Configuration is accomplished in the inspector, and is based on the target device/file 
system being monitored and other requirements.

attachment

An attachment is a non-media file that is associated with media during execution of a 
workflow. For example, an attachment may be an XML file that contains metadata, an 
SCC caption file, or an STL or PAC subtitle file. An attachment may also be a PDF file, 
Excel spreadsheet, or Word document, for example. Attachments are identified and 
processed using nicknames for simplicity. Processing is optional—attachments may be 
simply passed through a workflow for storage with the processed media and registered 
in a Vantage catalog.

attachment nickname

An attachment nickname is an alias or alternate name that is assigned to an attachment 
file during Vantage workflow execution. When an attachment file is submitted to a 
workflow, the actual file name and location is stored in a Vantage binder along with a 
nickname as defined in the workflow. Within the workflow, all references to a file are by 
nickname. However, when Vantage needs to access a file, Vantage uses the actual file 
name and location stored in the binder.

See media nickname and nickname.

Aurora action

An Aurora action is an optional, licensed feature in Vantage. It uses the Aurora Service to 
enable Vantage workflows to utilize and interact with various QC tests provided by the 
Digimetrics Aurora software. The tests provide the ability to determine whether a 
particular input media (specified by nickname) either passes or fails a particular QC 
check. Each test also generates a report file that may be utilized during later stages of 
the workflow.
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Aurora Service

The Aurora Service implements the Digimetrics Aurora software for Vantage, and 
provides two-way communication between workflows (and the Aurora action) utilizing 
Aurora and the Aurora software itself.

Baton action

A Baton action is an optional, licensed feature in Vantage. It uses the Baton Service to 
enable Vantage workflows to utilize and interact with various QC tests provided by the 
Baton software. The tests provide the ability to determine whether a particular input 
media (specified by nickname) either passes or fails a particular QC check. Each test also 
generates a report file that may be utilized during later stages of the workflow.

Baton Service

The Baton Service implements the Baton software for Vantage, and provides two-way 
communication between workflows (and the Baton action) utilizing the Baton software 
itself.

binder

A binder is a collection of file and metadata information, created for each job that 
Vantage executes. A binder contains media and attachment file references and 
metadata labels that were ingested or created during the job. While a binder is created 
for every job, many binders are never used. Therefore, only media processing scenarios 
which require operator intervention should use the Register action in ingest workflows 
to create binders in a user-accessible Vantage catalog.

You use the Register action to automatically create binders during a job, and you use 
Exist to determine if a binder of a certain name has already been created. Binders are 
most often named by some permutation of the name of the file that started the job. 
Binders that are not explicitly registered are accessible to users only in Workflow 
Designer, in the Job Status tabs. 

Vantage catalogs and their binders are accessible in Workflow Portal. Binders are saved 
in the Vantage domain database until deleted manually or by job expiration policies. 
You can also view binders in the Vantage Management Console, and manually create 
them there—or delete them. 

Binders are not file folders and are not part of the Windows file system—they are 
records in the Vantage database. Thus, binders do not contain the files themselves; they 
only have the paths to those files. 

catalog

Similar in concept to the folders in a file system, a Vantage catalog is a container that 
stores binders. Catalog folders are sub-containers that organize binders. To access a 
binder, Workflow Portal operators search through the visible catalogs and folders, just 
as they might sort through folders in a file system.

Catalog Service

The Catalog Service is the Vantage component that executes the Register action and 
Exist action.
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Catch action

A Catch action is an origin action; it is a specialized origin action for ingesting 
commercials and syndicated media assets (including metadata) from catch servers in 
TrafficManager applications. It uses the Traffic Service to regularly poll the catch server 
to discover new files.

When a new file is discovered, the Catch action exposes all relevant metadata and 
submits a job to the workflow for processing. Typically, the workflow is an ingest 
workflow which localizes the media, populates a metadata label, creates proxies and 
thumbnails, and registers the asset in a Vantage catalog. For more details, see the 
TrafficManager User’s Guide.

Chronicle action

The Chronicle action, along with Colocate, Compose, and Conform actions, are part of 
the optional, licensed Post Producer feature in Vantage. The Chronicle action uses the 
Edit Service to convert post-rendered Composition XML files into formats for use in 
other systems—ad-insertion systems, for example.

Colocate action

The Colocate action, along with Chronicle, Compose, and Conform actions, are part of 
the optional, licensed Post Producer feature in Vantage. The Colocate action uses the 
Edit Service to ingest Composition XML files with references to non-file-based URLS (for 
example, Amazon S3), localize the files, and convert the media references in a copy of 
the CML into paths to the localized files.

common action

Common actions are actions that are implemented in every Vantage Service; they are 
not restricted execution by a single service. See Receive action, Forward action, Decide 
action, Compute action, Construct action, Synchronize action.

Communicate Service

The Communicate Service is the Vantage component that executes the actions relating 
to electronic messaging: Message action, and Notify action.

Compare action

A Compare action uses the Analysis Service to compare media files based on certain 
metrics (for example, PSNR). These metrics can generally be published as variables or as 
metadata labels.

Compose action

A Compose action, along with Chronicle, Colocate, and Conform actions, are part of the 
optional, licensed Post Producer feature in Vantage. The Compose action uses the Edit 
Service to convert various media descriptor file formats (Anystream AN2, Final Cut 
Interchange XML, Simplified Avid AAF, QuickTime Reference, Adobe FC7XML, and 
Telestream TSEDL) into a Composition XML file so that it can be used by the Conform 
action to compose media) into a Composition XML file so that it can be used by the 
Conform action to compose media.
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Composition (CML) file

A Composition file is an XML schema that provides the vocabulary to describe media 
elements and their temporal and spatial relationships on a video timeline. Composition 
files (or Composition XML objects in a computer program) are submitted to a Conform 
action in a workflow to render the media file from the description.

Compute action

A Compute action, which is implemented in every service, performs various arithmetic 
and string manipulation functions, permitting you to create and modify values in 
variables, for use in downstream actions.

Conform action

A Conform action, along with Colocate, Compose, and Chronicle actions, are part of the 
optional, licensed Post Producer feature in Vantage. The Compose action uses the Edit 
Service to assemble and optionally transcode multiple video and still image files into a 
single output file, applying filters as specified by you. The input files and related 
specifications for the output file are all defined in a Composition XML file.

Construct action

A Construct action, which is implemented in every service, enables you to construct 
complex strings, paths, and math expressions from literals, variables, and tokens, for 
use in downstream actions.

Copy action

A Copy action is executed by the Transport Service and is used to replicate a file from a 
source target (file system/device and directory) to a destination target (file system/
device and directory). It typically performs this task by copying the file to the 
destination.

Copy actions can be executed on any action state.

database

The term database is the common term used to refer to the Vantage domain database, 
where all specifications for the domain are stored, along with workflows and job 
history.

Decide action

A Decide action, which is implemented in every service, is an action which allows you to 
explicitly set the action state based upon analysis of variable values at runtime. It is 
most commonly used to determine whether or not subsequent actions (or actions in a 
given branch) in a workflow should execute.

When the Decide action is used, the state set by the Decide action is passed to the next 
action. Typically, more than one Decide action is required to support decision branches. 
For example, if one branch is for HD media, it will start with a Decide action that will set 
the state to Success for HD content, or set it to Ignore otherwise; if another branch is for 
all other media, it will start with a Decide action that performs the opposite behavior.

See variable, action state.
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Delete action

A Delete action is executed by the Transport Service, and is used to permanently 
remove a file from a source target (file system/device and directory). Delete actions can 
be executed on any action state.

Deploy action

A Deploy action is executed by the Transport Service, and is used to save the specified 
files to a destination outside the Vantage domain. Unlike Delete, Move, or Copy actions, 
Deploy actions allow multiple files to be operated on simultaneously, and do not 
maintain a reference to those files in the binder after completion.

distributed domain

Another term for Vantage array. 

domain

See Vantage domain.

DPP Validate Action

A DPP Validate action is executed by the Analysis service. You can use the DPP Validate 
action to confirm compliance of a DPP metadata XML file. If the XML file passes 
validation, TRUE is generated; otherwise FALSE is generated. You can test the results of 
the action downstream to change the workflow’s actions based on the validation 
results. Optionally, you can also generate a report.

Dublist action

A Dublist action is a specialized origin action for ingesting dublist files from a specified 
server and directory in TrafficManager applications. It uses the Monitor Service to 
regularly poll the server to discover new files.

When a new dublist file is discovered, it is parsed by the specified scheme and new 
entries are added to the master dublist maintained by Vantage. The Dublist action 
simultaneously polls the selected Vantage catalog for any media files which match 
entries in the master list; when found, it submits a job to a TrafficManager application 
workflow for processing. The Dublist action uses the binder name as the unique 
identifier for the commercial, so it should be set to the Ad ID.

Typically, the workflow is an on-air processing workflow which transcodes the media, 
optionally trims the clip and alters audio for compliance. Then, it delivers the media to 
an on-air server and notifies an automation system. For more details, see the 
TrafficManager User’s Guide.

Dublist Portal

Dublist Portal is a client Windows program provided as part of a TrafficManager license. 
Dublist Portal enables customers who are performing advertisement processing to 
define, manage, and process dublists as part of their automated TrafficManager 
workflows.

Edit Decision List

A Vantage edit decision list (EDL) is a list of clips that will be merged together in a target 
clip. The list entries specify the start and stop of the clip, and Vantage supports list 
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entries from multiple media files. Vantage operators use the Workflow Portal program 
to create EDLs.

Edit Service

The Edit Service executes the Playlist actions: Colocate action, Conform action, 
Chronicle action, and Compose action.

Examine action

An Examine action uses the Analysis Service to evaluate the video and audio of a media 
file to measure certain characteristics, such as audio loudness, or to detect 
characteristics, such as the presence and size of curtains. You can configure it to publish 
metadata or variables containing the results of analysis.

Exist action

An Exist action uses the Catalog Service, and allows you to determine if a binder of a 
given name (or name fragment) is present in a specified catalog.

Faspex Delivery action

A Faspex Delivery action, which is executed by the Aspera Service, is used to deliver files 
to Aspera Faspex servers. Upon delivery, recipients are notified and can download the 
package.

FileCatalyst action

The FileCatalyst action is an optional, licensed feature, which enables Vantage 
workflows to access and deliver files to FileCatalyst servers via integrated FileCatalyst 
client software.

FileCatalyst Service

The FileCatalyst Service implements the FileCatalyst action for Vantage.

Flip action

A Flip action is executed by the Transcode Service, and implements the specified codec, 
which is used to transcode decoded digital baseband media into another media 
encoding format. The Telestream Media Transcode and Analysis Engine performs the 
transcode on behalf of Vantage. The Flip action has an Export command, which allows 
you to save the configured Flip action as an XML file, for use in SDK applications.

Forward action

A Forward action, which is implemented in every service, forwards a binder and all 
current variables to another workflow, starting a new job with the target workflow. A 
Forward action may be added to the end of a workflow, and requires that the target 
workflow have a Receive action as its first action.

Typically, workflows are created with a Receive action when they are intended for 
execution by another workflow that immediately precedes this one. This ability to chain 
workflows enables you to create comprehensive, intelligent run-time switching 
workflows consisting of smaller workflows used as building blocks.

See Receive action.
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Gather action

A Gather action is implemented by the Staging Service, and collects one or more files 
from a specified server and directory (and optionally, its subfolders), and brings them 
into the workflow as attachments. Use of a file matching pattern allows you to select 
only certain types of files.

hot folder

A hot folder is a directory on a server that has been identified as a directory for storing 
media to be processed by a workflow in Vantage. When the workflow monitor identifies 
new media in this folder, it is submitted for processing.

Identify action

An Identify action uses the Analysis Service to determine certain properties of a media 
file, such as codec type, video bit rate, or file size. This information can then be 
published as a metadata labels or variables.

Inspector

An inspector is a series of one or more panels in Vantage Workflow Designer that 
facilitate the setup and configuration of a given action. Inspectors are unique to each 
action—for example, configuring a Watch action is very different than configuring a 
Flip action.

IPTV Flip action

The IPTV Flip action is included with the Cable / IPTV version of TrafficManager. IPTV Flip 
actions are executed by the IPTV VOD Service which can optionally run on a Lightspeed 
Server for GPU-enhanced x264/x265 encoding and video processing. The IPTV Flip 
action and IPTV VOD Service supports the features required to handle varying IPTV, set-
top box and cable encoding requirements, and ancillary metadata specific to cable ad 
splicing and cable/IPTV set-top box environments.

IPTV VOD Service

The IPTV VOD Service is the Vantage component that executes the IPTV Flip action. This 
service (which can optionally run on a Lightspeed Server for H264 and HEVC encoding 
and video processing), supports the features required to handle varying IPTV, set-top 
box and cable encoding requirements, and ancillary metadata specific to cable ad 
splicing and cable/IPTV set-top box environments.

job

A job is each execution of a Vantage workflow. Jobs have a state (separate from action 
states), and jobs are comprised of actions that are executing. Jobs, like actions, may be 
in-process or they may be complete.

As a job executes, each action may be performed by any service (on any computer) in 
the Vantage domain that is capable of performing it. The capability of a service to 
perform a specific job depends on its current operating state, its workload, and its 
suitability, defined by a qualification rule.

Jobs for a given workflow can be viewed in the Vantage Workflow Designer by 
selecting the workflow in the Workflow Designer panel and displaying the Job Status 
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tab. Alternatively, all in-process and failed jobs within a Vantage Domain may be 
viewed in the Status details panel of the Management Console.

Job Profile action

Use the Job Profile action (which is executed by the Agility Service) to submit jobs to 
Agility for processing; definition of the job is provided directly in Vantage by 
configuring the action.

Job XML action

Use the Job XML action (which is executed by the Agility Service) to submit jobs to 
Agility for processing; definition of the job is provided in an XML file.

job routing

See qualification rule and run on rules.

job state

A job state is the current condition of a job. Keyword values are Start | Pause | Success | 
Fail | In Process.

Job Status Views Web Application

The Vantage Job Status Views Web Application is installed on a Vantage Web server and 
enables you to view real-time information about jobs in the domain from anywhere on 
your network with a Web browser.

label

A label or metadata label defines a set of metadata by use of name/value pairs 
associated with content. For example, a spot label may contain Agency, Author, or Ad-
ID and other metadata values; this set of metadata is collectively called a Spot 
metadata label. Metadata labels can be stored in binders with the associated media 
and attachment files.

Vantage supplies a set of default metadata labels for use in workflows. In addition, you 
can create and modify labels for your use using the Management Console (Workflow 
Design Items > Metadata Labels).

license

A Vantage license is stored in the Vantage domain database and enables one or more 
Vantage features within a Vantage domain. Licenses are delivered as XML files and 
imported into the database and activated via the Vantage Management Console.

Lightspeed Server

A Vantage Lightspeed Server is a 1RU, GPU-enabled, multi-core CPU server used to host 
Vantage services and accelerate video processing and x264/x265 transcoding. 
Lightspeed Server accelerates compute-intensive image processing, including scaling, 
deinterlacing, frame rate conversion, motion vector calculation, and other tasks that 
require computation and analysis to modify or create new video frames. 

Management Console

The Management Console enables Vantage system administrators to effectively 
configure Vantage domains, and scale domains across multiple servers to meet their 
operating requirements and perform effectively in their environment.
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MediaInfo action

The MediaInfo action, which is executed by the Analysis Service, performs 2 tasks, based 
on its analysis of the media file and its streams:

- Creates variables from properties, using the MediaInfo API

- Creates a report of the properties and their values.

In each category, you can produce variables of selected metrics with the results the 
analysis.

media nickname

A media nickname is an alias or alternate name that is assigned to a media file during 
Vantage workflow execution. When a media file is submitted to a workflow, the actual 
file name and location is stored in a Vantage binder along with a media nickname as 
defined in the workflow. Within the workflow, all references to a file are by media 
nickname. However, when Vantage needs to access a file, Vantage uses the actual file 
name and location stored in the binder.

See attachment nickname and nickname.

MediaMate action

A MediaMate action uses the MediaMate Service to enable Vantage workflows to utilize 
and interact with the Subtitling capabilities of Screen MediaMate. Each subtitling 
option provides different capabilities that relate to the subtitle process.

Note: The MediaMate action is only supported on 64-bit Windows Server 2008.

MediaMate Service

The MediaMate Service implements the MediaMate Screen software for Vantage, and 
provides two-way communication between workflows (and the MediaMate action) 
utilizing the MediaMate Screen software itself.

Message action

A Message action is implemented in the Communicate Service and enables you to 
generate and transmit an electronic Message—an email, for example. A Vantage 
administrator must configure Vantage to use an SMTP server (Vantage Management 
Console: Settings & Options > Email) before email can be utilized.

Metadata Service

The Metadata Service is the Vantage component that executes the actions relating to 
the transformation of metadata between labels, variables, and XML files: Populate 
action, and Transform action.

Monitor Service

The Monitor Service is the Vantage component that executes Watch actions and 
Associate actions, both relating to the discovery of files and starting jobs.

Move action

A Move action is executed by the Transport Service, and is used to move a file from a 
source target (file system/device and directory) to a destination target (file system/
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device and directory). It typically performs this task by copying the file to the 
destination, then deleting the source.

Move actions can be executed on any action state.

Multiscreen Flip action

Multiscreen Flip actions are an optional, licensed feature. Multiscreen Flip actions are 
executed by the Multiscreen Service, which is used to perform adaptive bit-rate 
encoding and simultaneous packaging of decoded digital baseband media into 
multiple bit-rate variants of H.264/HEVC video and containers in adaptive rate 
streaming formats, including Adobe HDS, Apple HLS, Microsoft HSS, and players the 
support MPEG DASH. Transcoding is performed by the Telestream Media Transcode 
and Analysis Engine on behalf of Vantage. You can configure the Multiscreen action to 
perform transcoding on a standard Vantage server or on a Lightspeed Server. 

Multiscreen Service

The Multiscreen Service is the Vantage component that executes the Multiscreen Flip 
action. This service (which can optionally run on a Lightspeed Server for H264 and 
HEVC encoding and video processing), supports the features required to handle 
varying adaptive bit-rate encoding and packaging requirements.

Nexidia Action

The Nexidia action is an optional, licensed feature in Vantage. It uses the Vantage 
Nexidia Service to interact with Nexidia QC servers running Nexidia QC software. The 
specified input files are passed to the Nexidia QC software where they are analyzed 
using the test profile selected.

nickname

A nickname is an alias or alternate name that is assigned to a media or attachment file 
during Vantage workflow execution. When a media or attachment file is submitted to a 
workflow, the actual file name and location is stored in a Vantage binder along with a 
nickname as defined in the workflow. Within the workflow, all references to a file are by 
nickname. However, when Vantage needs to access a file, Vantage uses the actual file 
name and location stored in the binder.

Nicknames may refer to either media files or attachment files. Certain actions only allow 
the use of certain nickname types. For example, a Flip action only allows media file 
nicknames to be used as the inputs and outputs. However, other actions (such as the 
Move and Copy actions) operate on any type of file and allow the use of any nickname.

See attachment nickname and media nickname.

Notify action

A Notify action is implemented in the Communicate Service, and is an action which 
saves job information to a file to interface with an external system. You can configure a 
Notify action to produce an XML file, and you can also use it to invoke a Web Service.

TrafficManager-centric extensions are presented here for backward compatibility. 

origin action

An origin action is a specific type of action, which must be used to start a workflow. A 
workflow without an origin action as its first action is not properly designed, and 
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cannot be activated. The origin actions include the Watch action and Receive action, as 
well as the Catch action and Dublist action, (optional TrafficManager actions).

Original nickname

The media nickname Original is a reserved nickname that is typically assigned to media 
files in a workflow by the origin action.

See media nickname.

Pipeline

Pipeline is a network-based video capture and playout device for moving SD & HD SDI 
video & audio in and out of MacOS X and Windows file-based workflows, with a wide 
variety of industry-standard encoders.

Populate action

A Populate action uses the Metadata Service to read and write metadata labels. During 
ingest, metadata labels can be added to ingested media and generally include trim 
information, audio levels, file properties, and commercial metadata. The metadata 
labels can then be reviewed and modified by operators using Workflow Portal. At any 
stage of a workflow, Vantage can extract information from labels using the Populate 
action, allowing Vantage for example to use trim points during a transcode, or audio 
level information when creating the final broadcast asset.

Process MMF action

A Process MMF action (which is executed by the Agility Service) processes an 
attachment as an MMF file and generates variables from it.

Pulsar Action

The Pulsar action is an optional, licensed feature which enables broadcasters to 
integrate the Pulsar suite of content verification components directly in Vantage 
workflows.

Pulsar Service

The Pulsar service implements the Pulsar action for Vantage.

QC action

A QC action, which is executed by the Analysis Service, enables you to perform analysis 
on media using a variety of analysis tools, and optionally, produce a report of the 
analysis. The QC action is similar to the Analyze action, with additional features in 
addition to generating variables for each property.

In each tool, you can test various properties for True/False, min/max values, allowable 
values, or ranges, and then set pass/fail and other variables based on the results of the 
analysis. You can use these variables in downstream actions.

qualification rule

A qualification rule influences or controls the routing and execution of actions among 
Vantage services of the same type in a distributed Vantage domain. Qualification rules 
can be used to ensure that jobs are routed to services that are best suited for the task. 
Vantage uses values contained in variables to determine the suitability of a given 
service to execute the action.
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Qualification rules are exclusively based on variables; they are not based on any actual 
machine analysis. As a result, it is up to the system administrator to correctly set up 
variables and qualification rules, and apply variables to the appropriate actions to 
ensure that jobs are routed correctly.

Qualification rules are created and managed in the Vantage Management Console: 
Services.

See also run on rules.

Receive action

A Receive action is an origin action which is implemented in every service. Receive 
actions are designed to receive files from other systems: workflows, SDK-based 
applications, and Workflow Portal, for example. Files can also be automatically 
submitted to a workflow starting with a Receive action from another workflow using 
the Forward action.

See Forward action.

Register action

A Register action uses the Catalog Service to add the binder created by each job to a 
Vantage catalog. Register actions can be executed on any action state.

See also Vantage catalog.

Report action

A Report action, which is executed by the Analysis Service, generates a list of variables 
and their values and saves them in a file format specified by you.

resource cost

A resource cost is an integer value, implemented in the Vantage Management Console 
on each action type to specify a relative computer resource consumption value in 
relation to all other action types. This value enables Vantage to maximize resources and 
optimize transactions, so that you can tune your Vantage system for the highest 
possible throughput on your particular hardware.

retry rules

Retry rules are rules that you can specify on certain actions, to re-execute actions that 
fail primarily due to platform access and network latency problems. The retry rules you 
set on a given action override the default retry rules established in the Management 
Console.

run on rules

Run on rules are rules that you specify on a given action, to qualify which services have 
the characteristics that enable them to execute this action. Rules are set up by 
specifying variables which have been bound to a given Vantage service and values set. 
After configuration, the action can test each rule by comparing its run time value to the 
value in the service’s copy and determine if there is a match before attempting to 
execute it. 

See also qualification rule.



Glossary 363
SDK Service

The SDK Service is the Vantage component which enables integration with third-party 
or custom-developed client programs, for submitting jobs, tracking status, etc.

Signiant Delivery action

A Signiant Delivery action, which is executed by the Signiant Service, is used to deliver 
files to servers controlled by Signiant file transfer products.

Signiant Service

The Signiant Service is the Vantage component which enables integration with third-
party or custom-developed client programs, for submitting jobs, tracking status, etc.

The Signiant Service implements the Signiant file transfer product for Vantage, and 
provides two-way communication between workflows (and the Signiant Delivery 
action) utilizing the Signiant software itself.

Staging Service

The Staging Service is the Vantage component which executes Archive actions and 
Gather actions.

service

See Vantage services.

Synchronize action

A Synchronize action is a connector action, for the sole purpose of uncluttering 
workflow connectors. In workflows where there is a many-to-many relationship (for 
example, 6 Flip actions connecting to 6 Deploy actions, which connect to 6 Deletes), 
instead of drawing connection between them all, you simply connect them to a 
common Synchronize action. There is no Inspector for the Synchronize action, because 
no configuration is required.

Traffic Service

The Traffic Service is the Vantage component which executes the Catch action and 
Dublist action.

TrafficManager

TrafficManager is an optional, licensed feature which enables automated advertisement 
and syndicated media processing from catch server to automation systems and on-air 
servers, serving both the broadcast and cable industry. It includes the Catch action for 
catch servers and the Dublist action for dublist management. 

transcode

Transcode means the process of decoding media in one format (MPEG2, for example) 
down to digital baseband and then encoding it in another media format (MPEG4, for 
example). 

Transcode Service

The Transcode Service is the Vantage component that executes the Flip action—
transforming media from one format to another. Transcoding for the Flip action is 
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performed by the Telestream Media Transcode and Analysis Engine on behalf of 
Vantage.

Transform action

A Transform action uses the Metadata Service to transform metadata between XML files 
(attachments) and labels. XSL style sheets are used to perform these transformations; 
style sheets can be managed in the Vantage Management Console: Workflow Design 
Items > Style Sheets.

Transport Service

The Transport Service is the Vantage component that executes the actions relating to 
file operations: Move action, Delete action, Copy action, and Deploy action.

Vantage array

A Vantage array is a domain whose software components are distributed among 
multiple computers for durability and scalability, instead of installed and operating on 
a single computer (often referred to as a distributed domain). A typical array has the 
Vantage domain database installed on a dedicated server, and all Vantage services 
installed on another computer, and additional Transcode services each installed on 
other computers for high-performance, parallel transcoding.

Vantage catalog

Formal name for catalog. Similar in concept to the folders in a file system, a Vantage 
catalog is a container that stores binders. Catalog folders are sub-containers that 
organize binders. To access a binder, Workflow Portal operators search through the 
visible catalogs and folders, just as they might sort through folders in a file system.

Vantage Cloud Manager

The Vantage Cloud Manager enables Vantage system administrators to effectively 
configure cloud service provider accounts, start, stop, and configure domains, and 
monitor domain status.

Vantage domain database

A Vantage domain database is a Microsoft SQL Server database which contains all 
workflows, actions, jobs, binders, licenses, and configuration information for a Vantage 
domain.

Vantage domain

A Vantage domain is a collection of computers, Vantage workflows, actions, Vantage 
services, jobs, binders, and configuration settings, all known to and interacting with 
each other, stored in a database. This collection constitutes a Vantage domain. Vantage 
domains may exist on a single computer or they may be distributed across many 
computers for durability and scalability.

The name of a Vantage domain is the same as the name of the server that hosts the 
Vantage domain database.

Multiple Vantage domains may exist on a network, but they are independent entities 
that do not communicate with each other. They are not bound together and do not 
share resources or work. The purpose of storing an entire domain in a database is to 
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provide an easy way to create and manage the domain and to provide access to all the 
details about each resource in the domain to any other resource that needs it.

Vantage EDL nickname

The nickname Vantage EDL is a reserved nickname that is typically assigned to media 
files that are created in catalog ingest workflows, to identify the ingest files of an Edit 
Decision List in Workflow Portal, during Stitch and Trim operations.

See media nickname.

Vantage folder address

A Vantage folder address is an alias to a local or remote file folder. You can create and 
manage Vantage folder addresses in the Vantage Folder Address Book dialog, in Copy 
and Move actions in Vantage Workflow Designer, and in the Vantage Management 
Console.

After you create a Vantage folder address, you can specify the destination directory in 
any workflow simply by selecting the Vantage folder address. Changes to a Vantage 
folder address—such as updating an IP address or a password—immediately affect all 
workflows that use that Vantage folder.

Unlike Vantage stores, temporary files that are created during workflow execution are 
not automatically deleted from Vantage folders according to job expiration settings. 

Vantage Proxy nickname

The media nickname Vantage Proxy is a reserved nickname that may be assigned to 
media files encoded using the QuickTime encoder in H.264/AAC as QuickTime movies 
or MP4 files with H.264/AAC, which enables previewing with the media viewers 
provided in Vantage programs such as Workflow Designer, Workflow Portal, and the 
Vantage Management Console.

See media nickname.

Vantage services

The term Vantage services refers to the collection of Windows services in a Vantage 
domain, which are responsible for executing all of the actions in a workflow as it 
executes.

Vantage store

A Vantage store is a directory on a Windows file system that stores temporary files. 
Stores are managed by the Vantage domain for the purpose of centralizing large 
directories for reading and writing files. Unlike a Vantage folder, temporary files placed 
in a Vantage store are deleted when the binder is deleted. Vantage stores are generally 
used to hold temporary files for the duration that a job is executing.

Vantage stores are managed in the Vantage Management Console: Storage. Services 
that create temporary files, such as the Transcode Service, can be configured to use 
specific stores.

Vantage Thumbnail nickname

The media nickname Vantage Thumbnail is a reserved nickname that is typically 
assigned to output media files that are created to display thumbnail images instead of 
binder names in Vantage programs such as Workflow Portal.
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See media nickname.

Vantage Transcode Web application

Vantage Transcode Web application—a Web application which allows users to quickly 
and easily build transcoding workflows, based on a Watch > Transcode > Deliver 
template. The Vantage Transcode Web application runs under Microsoft IIS.

variable

In Vantage, a variable is a container for temporary job information—a symbolic name 
(or identifier) which contains some known or unknown quantity or element of 
information; a value. You use the variable name to reference the current value; this 
separation of name and content allows the name to be used independently of the 
exact information it represents. The variable can be bound to a value (that is, you can 
set a variable to a given value) during run time, and the value of the variable may 
change during the course of workflow execution. 

A variable identifies temporary job metadata. Variables have a name (such as Number of 
Audio Channels), a type (such as Integer Number) and a default value (such as 50). 
Variables values can be set inside a job in a variety of ways: through analysis, through 
metadata population, in the Watch and Associate actions, as a property of an action, or 
by a service as it executes an action.

Variables are used by Vantage services and actions to control workflow execution. The 
majority of parameters in Vantage can be bound (or attached) to variables, allowing the 
workflow to dynamically update on a job-by-job basis. 

For example, a variable may be assigned a value by an Analysis action to determine 
how many lines of black are at the top of a video frame; a crop filter later in the 
workflow can bind to that variable, ensuring that every crop in every job is appropriate 
to the workflow requirements.

Variables in services may be also be used for job routing. For example, an action with a 
FibreRequired=TRUE variable must pass this condition to a service which evaluates the 
condition to determine if it can successfully perform the action.

Variables can be created in Vantage Management Console (Workflow Design Items > 
Variables) or in Vantage Workflow Designer, and assigned for use in workflows and 
services.

VidChecker action

A VidChecker action is an optional, licensed feature in Vantage. It uses the VidChecker 
Service to enable Vantage workflows to utilize and interact with various QC tests 
provided by the VidChecker software.

VidChecker Service

The VidChecker Service implements the VidChecker QC software for Vantage, and 
provides two-way communication between workflows (and the VidChecker action 
actions) utilizing the VidChecker software itself.
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Watch action

A Watch action is an origin action; it uses the Monitor Service to regularly poll a target 
location (a directory, for example) on a device or file system (FTP, Windows network 
folder, etc.) to discover new files.

When a new file is discovered, the Watch action submits a job for the workflow which it 
is part of, for processing the file—typically, a media file.

Upload Portal Web App

The Upload Portal is a Web application that runs in most popular browsers and presents 
a simple interface to allow remote users to quickly and easily upload media and other 
files and metadata to your Vantage system via the Internet.

Web Dashboard

The Web Dashboard is an optional, licensed Web app which displays important domain 
information from anywhere on your network in a Web browser. The Web Dashboard is 
installed on the IIS server on your Vantage domain database server. 

workflow

A workflow in Vantage is a set of actions designed to perform an automated process. 
Vantage workflows are created using the Vantage Workflow Designer by adding and 
configuring actions and connecting them together. Workflows are stored in the 
Vantage domain database, and executed by Vantage services.

Workflow Designer

Vantage Workflow Designer is a client program that enables you to create and edit 
workflows, activate and deactivate workflows, monitor job status, and review and 
delete jobs that have completed.

Workflow Portal

Workflow Portal is a client program that features a customizable set of functionality to 
support various operator-related tasks: selecting media and submitting jobs, updating 
variables and metadata, forwarding jobs, creating EDL-based jobs, etc.

Customization is implemented in the Vantage Management Console, when Vantage 
administrators construct the user interface and functionality they want for a given task, 
then save it. When operators launch Workflow Portal, they select the configuration 
appropriate to the task at hand, and Workflow Portal dynamically display the user 
interface components specified in the configuration file.

Workflow Portal Web App

The Workflow Portal Web app is a limited implementation of Workflow Portal, for use in 
a Web browser over a network or Internet connection.

Workorder action

A Workorder action is an origin action; it uses the Monitor Service to regularly poll a 
target Windows directory for new workorder files to process. The Workorder action 
provides a simple and highly effective method of submitting multiple similar jobs 
without using the SDK. 
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A Workorder file is a comma-separated value (CSV) text file containing one or more 
work orders, or job descriptions. Each row in the CSV file specifies a job, and each 
column specifies either an input file or variable value. Workorder file configurations are 
specified in the Domain Management Console. At least one workorder scheme must be 
created in order to use a Workorder action.

When a new CSV file is discovered, the Workorder action submits one job for each row 
in the CSV file.
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Index
Symbols
$Console, see Management Console 31

A
action 349
action state 349
actions

adding to a workflow 155
binding settings to a variable 169
changing description of 178
configuring other settings 161
configuring, generally 161
connecting together 157
copying and pasting 155
deleting 160
invalid connections 157
re-ordering 160
setting conditional execution 164
setting fallback rules for 173
setting run on rules 171
specifying resource cost for 176
state colors on Job Status tab 228, 

316, 343
states of 164
templates 155
templates for, creating 179
toolbar display options 140
uncrossing connection lines 160
using variables with 166
viewing status 242

Active Directory, prevents password 
changing 52

Active Scripting, enable in IE for Web 
applications 57

Adobe FC7XML 199, 353
AeroSnap, disabling on Windows Server 

2008 45
Agility actions 188
Agility Service 350
all-in-one domain 350

generally 28
on Lightspeed server 36
sample files for 71
using path forms in 68

Analysis actions 189
Analysis license 23
Analysis Service 350
Analyze action 189, 350
Anystream AN2 199, 353
Archive action 210, 350
array 350

drive letter paths don’t work in 182
using UNC paths recommended 182

array domain
generally 28

Aspera actions, see Faspex Delivery action
Aspera Service 351
assets

previewing 291
stitching 270, 275

Associate action 204, 351
attachment 351
attachment nickname 351
Aurora action 192, 351
Aurora Service 352
auto-arrange, disabling temporarily 139
Automation Systems 198
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auto-validation, disabling 
temporarily 140

Avid Interplay 198

B
batch operations, performing on 

workflows 152
Baton action 352
Baton Service 352
binder 352
binders, overview of 256
binders, viewing 239
binding settings to variables 169
bottleneck analysis, performing 247
Browse Catalogs (Copy Binder) configura-

tions, overview 264
Browse Catalogs (Forward Binder) config-

urations, overview 264
Browse Windows Network configuration, 

overview 267
Browsing Windows Assets mode 267
BXF Files 198

C
caption files, playing in Web Portal 295
Catalog actions 194
Catalog Service 352
catalogs

browsing 287
overview of 256
selecting 287

Catch action 211, 353
category

creating new 145
deleting 145
renaming 145

Chrome, supported browser for Web ap-
plications (MacOS X and 
Windows) 57

Chronicle action 199, 353
Civolution NexGuard 198
Clip Start Time feature 259
CML

creating in Workflow Portal 275
Colocate action 199, 353
color of jobs 228, 316, 343

Common actions 195, 353
Communicate Service 353
Communicate service actions 198
communicating with external 

systems 198
Compare action 189
Compose action 199, 353, 354
Compute action 195, 354
conditional execution of actions, 

setting 164
configuration files for Workflow 

Portal 263
configuration, reloading or changing in 

Workflow Portal 262
Conform action 199, 354
connecting to a Vantage domain

client applications 46, 60
unlisted domains 47, 61
using Workflow Designer 73

connection lines, uncrossing 160
Construct action 354
context menu, for Action toolbar 140
cookies, must be enabled for Web 

applications 57
Copy action 213, 354
Copy Binder configurations, overview 264
copyright notice 3
CSV file job reports 232

D
Dashboard

URL for 59
Dashboard Web Application

introduction 34
database instance, changing 47, 61
database version, determining 45
Decide action 195, 354
default password 63
default user name 63
Delete action 213, 355
Deliver action, configuring in Vantage 

Transcode 341
Deploy action 213, 355
Distributed domain 355
Dolby DP600 198
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domain
stopping all jobs in 231

domain configurations, generally 28
domain database instance, changing 47, 

61
Domain Job Status tab, in Workflow De-

signer, generally 225
Domain Monitor Status tab 222
DPP Validate action 189, 355
DPP, creating in Workflow Portal 280
Drive-letter paths, limits on use in 

Vantage 68
Dublist action 211, 355
Dublist Portal 355

introduction 35
launching first time 43
requires license 43

Dump XML Files 198

E
Edit (Post Producer) actions 199
edit decision list 355
Edit Service 356
EDL

adding assets to 272, 278, 284
creating in Workflow Portal 270

Emergency Stop button 231
Enhanced Security Configuration, dis-

abling under certain 
circumstances 57

errors
troubleshooting Workflow 

Designer 185
troubleshooting Workflow Portal 309

Examine action 189, 356
execution analysis, performing 248
Exist action 194, 356
exporting

job reports 232
workflows 148

External Command Shell 198

F
fallback rules, implementing 173
Faspex Delivery action 191, 356
file, submitting in Vantage Transcode 334

FileCatalyst action 200, 356
filename pattern editor, using 163
filters, showing in Vantage Transcode 345
Final Cut Interchange XML 199, 353
Firefox, supported browser for Web appli-

cations (MacOS X and Windows) 57
Flip action 212, 356

configuring in Vantage Transcode 340
exporting for use in SDK 180
pause for priority 241
pausing and resuming 241
upgrading 152

Folder Address Book 182
Forward action 196, 356
Forward Binder configurations, 

overview 264

G
Gather action 210, 357
grid lines, showing/hiding 136

H
hot folder 357
hot keys, updating timecode metadata 

values with 300

I
Identify action 190, 357
importing workflows 150
ingest workflow, overview 258
inspector 357
inspector, displaying 162
Inspector, displaying and using, 

generally 162
inspectors, using, generally 161
Internet Explorer 9, supported for Web 

applications 57
IPTV Flip action 201, 357
IPTV VOD actions 201
IPTV VOD edition, generally 23
IPTV VOD Transcode Service 357
italic text, in action title, indicating update 

availability 153

J
JavaScript, must be enabled for Web 
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applications 57
job 357
Job list, sorting in Vantage Transcode 344
Job Profile action 188, 358
job reports

creating 232
exporting 232
generally 232

job state 358
job state, colors to indicate 228, 316, 343
Job Status

managing in Vantage Transcode 341
tab, in Workflow Designer 225
URL for 58

Job Status Views
logging in 58
starting 58
URL for 59
version info 66

Job Status Views Web Application
introduction 34

Job XML action 188, 358
jobs

checking status of 225
deleting in Vantage Transcode 346
restarting in Vantage Transcode 345
submitting, manually 216
topping in Vantage Transcode 345

K
keyboard controls, Web Portal 295

L
label 358
license

generally 22
required for Dublist Portal 43
required for Workflow Portal 42

Lightspeed Server 358
Lightspeed Server, using in Vantage 36
live feed processing 37
logging in to a Vantage Domain in Work-

flow Designer 46
logging in to Job Status 58

M
Mac OS X

Safari on, supported for Web 
applications 57

Management Console 358
introduction 31

manual jobs
submission 216

manually connecting to a domain 46, 47, 
60, 61, 73

mark in/mark out points, setting 273, 278, 
284

media
playing in Workflow Portal 298
previewing 291

media nickname 359
MediaInfo action 190, 359
MediaMate action 202, 359
MediaMate Service 359
menus in Workflow Portal 307
Message action 198, 359
Metadata actions 203
metadata label 358
Metadata Service 359
modes in Workflow Portal 263
Monitor actions 204
Monitor Service 359
Monitor Status tab, generally 222
monitoring jobs 222
Move action 213, 359
MP4 x264/AAC, required for Workflow 

Portal Web app preview 259, 294, 
310

MPEG disclaimers 5
Multiscreen Flip action 206, 360
Multiscreen Service 360

N
Nexidia action 207, 360
nickname 360
nickname view 135
notices, legal, generally 3
Notify action 198, 360
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O
Open Containing Folder, context-menu in 

Binder View Media Files tab 239
Open With Default Program, context 

menu in Binder View Media Files 
tab 239

opening binders from a Vantage 
catalog 287

origin action 360
Original, nickname 361
Overview, Vantage Transcode 331

P
password

default 63
password, changing in Workflow 

Designer 52
pause for priority, in Flip actions 241
pausing Flip actions 241
Pipeline 361
Pipeline, using in Vantage 37
Populate action 203, 361
Post Producer (Edit) actions 199
Post Producer edition, generally 22
preview, MP4 x264/AAC required for Web 

app 259, 294, 310
preview, QuickTime H.264 required 

for 259
previewing assets 291
printing workflows 151
Process MMF action 188, 361
programs, in Vantage, generally 29
public and private views 315
Pulsar action 208, 361
Pulsar Service 361

Q
QC action 190, 361
qualification rule 361
QuickTime H.264, required for Workflow 

Portal preview 259
QuickTime Reference 199, 353

R
Receive action 196, 362

Register action 194, 362
using to create binders in catalogs 256

Report action 190, 362
resource cost 362
resource costs, specifying 176
resuming Flip actions 241
Retry rules 362
Run on rules 362
run on rules, configuring 171

S
Safari, supported browser 57
SDK Service 363
SeaChange MVL 198
settings, binding to variable 169
Signiant Delivery action 209, 363
Signiant Service 363
Simplified Avid AAF 199, 353
software version, determining 45
specifying resource costs 176
Staging Service 363
Staging service actions 210
starting and stopping Workflow 

Designer 42
starting Job Status 58
stitching assets

creating a CML 275
creating an EDL 270
mode 270

stopping all jobs in the domain 231
support, obtaining 19
Synchronize action 197, 363

T
tape feed processing 37
target workflow, overview 258
tech support, obtaining 19
Telestream

contacting 7, 19
information about 19
International 19
mailing address 19
sales and marketing 19
technical support 19
Web site 19

Telestream TSEDL 199, 353
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Text/CSV Files 198
thumbnails, use Vantage Thumbnail nick-

name for 259
tips, controlling 45
trademark notices 3
Traffic actions 211
Traffic Service 363
Traffic service actions 211
TrafficManager 363
TrafficManager edition, generally 22
Transcode 363
Transcode actions 212
Transcode Multiscreen edition, 

generally 22
Transcode Pro Connect 23
Transcode Service 363
Transform action 203, 364
Transport Service 364
Transport service actions 213
trial license

adding in Workflow Designer 40
trim groups, auto-calculating timecode 

metadata values 300
troubleshooting Vantage Transcode 347

U
UNC paths, using in Vantage 68
uncrossing connection lines 160
upgrading Flip actions 152
upgrading workflows with obsolete Flip 

actions 152
Upload Portal Web app 367
URL

for Job Status Web app 58
for Web Dashboard application 59
for Workflow Portal Web 

application 59
URL for Job Status Web app 59
user access

default user name 63
entering user name and password 73
Vantage domains 46

V
validating workflows 140

Vantage
account 73
folder address book 182
user password, changing in Web 

applications 65
user password, changing in Workflow 

Designer
user password, changing in 

Workflow Designer 52
user, changing in Workflow 

Designer 46
Web site for 19
Windows programs, starting and 

stopping 42
Workflow Portal Web application. See 

Workflow Portal
Vantage Analysis license 23
Vantage array 364
Vantage catalog 352, 364
Vantage Cloud Manager 364

introduction 32
Vantage Dashboard

generally 34
Vantage domain 364

changing 46
connection settings 47, 62
manually connecting 46, 47, 60, 61, 

73
select using computer name or IP 

address 47, 61
selecting, in Workflow Designer 46

Vantage domain database 364
Vantage domain database version, 

determining 45
Vantage editions 22
Vantage editions, generally 22
Vantage EDL, nickname 365
Vantage folder address 365
Vantage instance, changing 47, 61
Vantage Job Status Views Web 

Application 358
Vantage Management Console

introduction 31
Vantage programs, generally 29
Vantage Proxy, nickname 365
Vantage services, generally 365
Vantage Storage, understand path 
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requirements 68
Vantage store 365
Vantage Thumbnail nickname, for 

thumbnails in Workflow Portal 259
Vantage Thumbnail, nickname 365
Vantage Transcode 35, 366

About 348
Actions panel 347
activating workflow in 334
configuring Deliver action in 341
Creating new workflows in 333
deactivating a workflow 335
delete a workflow 337
deleting a job 346
documentation 348
duplicating a workflow 337
editing workflows in 336
Flip action, configuring 340
Help, accessing 348
managing Job Status in 341
Manuals, user 348
Overview 331
panels identified 331
restarting a job 345
saving workflows in 333
Show Filters in 345
Sort job list 344
stopping a job 345
submitting a file 334
troubleshooting 347
User Guide 348
viewing workflows in Workflow 

Designer 330
Web app, about 330
workflow, configure 338
workflows, managing in 332

Vantage Transcode Pro Connect 23
Vantage Transcode Web application

introduction 35
Vantage Transcode, configuring Watch 

action in 339
Vantage Web Upload Portal

generally 35
Vantage Workflow Designer 367
variable 366

variables
adding to a workflow 166
binding to settings 169
generally 166
using for decision making 181
view 135

variables, adding to a workflow 167
variables, creating 168
version information 66
version, of software, determining 45
VidChecker action 214, 366
VidChecker Service 366
views, public and private 315

W
warnings, controlling 45
warranty 6
Warranty and Disclaimers 6
Watch action 204, 367
Watch action, configuring in Vantage 

Transcode 339
Web

Vantage Web site 19
Workflow Portal application. See Work-

flow Portal
Web applications

cookies, must be enabled 57
enabling Active Scripting 57
JavaScript, must be enabled 57
Safari on Mac OS X supported 57
supported browsers for 57

Web browsers
Chrome, supported for Web applica-

tions (MacOS X and Windows) 57
Firefox, supported for Web applica-

tions (MacOS X and Windows) 57
Internet Explorer 9, supported for Web 

applications 57
Safari, supported 57
supported for Web applications 57

Web Dashboard 367
URL for 59

Web Services notification, general 
purpose 198

Web Upload Portal
introduction 35

WebVTT files, playing in Web Portal 295
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Windows 7 Basic, setting on Windows 
Server 2008 45

Windows configuration, overview 267
Windows Server 2008

disabling AeroSnap 45
setting Windows 7 Basic 45

workflow 367
activating 142
activating in Vantage Transcode 334
adding actions 155
batch operations 152
category. See category
centering 137
centering in workspace 136
configuring in Vantage Transcode 338
creating in Vantage Transcode 333
creating new 147
deactivating 142
deactivating in Vantage 

Transcode 335
deleting 148
deleting in Vantage Transcode 337
design techniques, generally 130
details panel, using 133
duplicating 148
duplicating in Vantage Transcode 337
editing 142
editing in Vantage Transcode 336
exporting 148
importing 150
moving in workspace 136
moving to another category 148
printing 151
releasing 142
renaming 147
saving in Vantage Transcode 333
status buttons 142
zooming in and out 136, 138

workflow analytics
configuration panel 244
generally 244
performing bottleneck analysis 

with 247
performing execution analysis 

with 248

Workflow Designer
adding trial licenses in 40
introduction 31
logging in to a domain 46
starting and stopping 42
submitting jobs manually 216
troubleshooting 185

Workflow Designer, viewing Vantage 
Transcode workflows in 330

Workflow Portal 367
configuration, reloading or 

changing 262
configurations 263
creating CML in 275
creating DPP in 280
creating EDL in 270
described, generally
desktop shortcut 43
introduction 33
launching first time 42, 43
menus in 307
modes of 263
overview of 251
playing media in 298
requires license 42
selecting configuration in 53
session, starting 261
troubleshooting 309
workflow design guidelines 258

Workflow Portal Web app 367
URL for 59

workflows
Vantage Transcode, viewing in Work-

flow Designer 330
workflows, managing in Vantage 

Transcode 332
Workorder action 205
writing job information files 198

Z
zooming a workflow 136
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